
 

 
 

 

Realnex CRM 
User’s Guide 



CRMLNEX / CRM 

Realnex CRM User’s 
Guide 

 RealNex 
6336 Greenwich Drive • Suite F 

Phone 858.729.0154 • Fax 858.729.0157 

Page ii 



 

Copyright 
Copyright 1984-2015 (manuals and software) RealNex 
All Rights Reserved. VIII 
Information in this document is subject to change without 
notices.  Companies, names, and data used in examples herein 
are fictitious.  No part of this document may be reproduced or 
transmitted in any form or by any means, electronic, or 
mechanical, for any purpose, without the express written 
permission of RealNex/CRM. 
 
Software License Notice 
Your license agreement with RealNex/CRM, which is included 
with the product, specifies the permitted and prohibited uses of 
the product.  Any unauthorized duplication or use of CRM in 
whole or in part, in print, or in any other storage and retrieval 
system is forbidden.  The owner of an CRM program is allowed 
to install CRM on their office PC, their laptop, their home PC 
etc., this is legal.  If a single user copy of CRM is being used at 
more than one location at the same time this is a violation of 
CRM's copyright.  The network version of CRM is sold on a site 
license; this means it can only be installed at one location. 
 
Licenses and Trademarks 
RealNex/CRM has made every effort to supply trademark 
information about company names, products, and services 
mentioned in this book.  Trademarks indicated below were 
derived from various sources.  CRM cannot attest to the 
accuracy of this information. 
Avery is a registered trademark of Avery Dennison Corp. 
Hewlett-Packard, HP, and LaserJet are trademarks of Hewlett-
Packard Company. 
Windows, MS Outlook, MS Excel and MS Word are registered 
trademarks of Microsoft Corporation. 
ZIP Code is a registered trademark of the United States Postal 
Service. 
All other trademarks are the property of their respective 
holders and are hereby acknowledged. 

Page iii 



TABLE OF CONTENTS 

CRM CONCEPTS ........................................................ 19 

Overview ............................................................................................. 19 
Projects ............................................................................................... 19 
Properties............................................................................................ 20 
Companies .......................................................................................... 20 

PROJECTS.................................................................. 21 

Overview ............................................................................................. 21 
The Project Screen ............................................................................. 22 

Setting up a Project Type ................................................................. 23 
Project Panel ...................................................................................... 25 
Client Tab ........................................................................................... 26 
Listing Tab ......................................................................................... 27 
Products Tab ...................................................................................... 27 

Result set.......................................................................................... 28 
RealNex Tab ............................................ Error! Bookmark not defined. 
Project info panel ............................................................................... 29 

Leads Tab......................................................................................... 29 
Commissions Tab ............................................................................ 32 

Project Lists Panel ............................................................................. 33 
Events Tab ....................................................................................... 35 
History Tab ...................................................................................... 36 
Links Tab ......................................................................................... 37 
Attachments ..................................................................................... 37 
Notes ................................................................................................ 38 

Creating a Project .............................................................................. 40 
Creating a Lead.................................................................................. 40 
Viewing a Project List ....................................................................... 40 
Viewing a Lead List ........................................................................... 41 
Adding a record as a Lead ................................................................ 41 

From an Individual Lead Record ..................................................... 41 
From a Project record ...................................................................... 41 

Creating a history for a Lead ............................................................ 42 
From a Project Record ..................................................................... 42 

Page iv 



 

From an Individual Lead Record ..................................................... 42 
Scheduling an event for a Lead......................................................... 42 

From a Project Record ..................................................................... 42 
From an Individual Lead Record ..................................................... 43 

Go to a project from a Lead .............................................................. 43 
Removing a Lead from a project ...................................................... 43 

From a Project Record ..................................................................... 43 
From a Lead Record ........................................................................ 43 

Viewing a Leads Projects .................................................................. 44 
Viewing the Projects a Record is the Client for .............................. 45 
Viewing Leads for a property ........................................................... 46 
Viewing Leads for a Tenant / Buyer................................................. 47 

COMPANIES ............................................................... 49 

Overview ............................................................................................. 49 
3 Scenarios to consider ...................................................................... 49 

Advantages of CRM’s Companies System ...................................... 50 
Companies Company Panel .............................................................. 55 

Working with the Org Chart Tab ..................................................... 55 
Hiding the Company Panel .............................................................. 57 

Adding a Company ............................................................................ 57 
Adding to an Existing Organization ................................................. 59 
Changing the Company Information ............................................... 59 
Company Info Panel .......................................................................... 60 

Company Contact List ..................................................................... 60 
Properties ......................................................................................... 61 
Spaces .............................................................................................. 62 
User Fields / Logical Fields ............................................................. 63 

Companies Lists Panel....................................................................... 64 
Company Links List......................................................................... 64 
Attachments ..................................................................................... 66 
Notes Tab ......................................................................................... 67 
Sorting Companies........................................................................... 68 
Querying Companies ....................................................................... 68 
Listing Companies {F5} .................................................................. 68 

CONTACTS ................................................................. 69 

Page v 



Overview ............................................................................................. 69 
Contact Screen Breakdown............................................................... 70 
Contact Address Panel ...................................................................... 72 
Contact Info Panel ............................................................................. 73 
User Fields / Logical Fields ............................................................... 73 
Investors ............................................................................................. 74 

Product 1 / Product 2 ....................................................................... 74 
Buyer Info Tab ................................................................................. 75 

Tenants ............................................................................................... 76 
Tenant Space Tab............................................................................. 76 
Tenant Lease Tab ............................................................................. 78 
Tenant Business Tab ........................................................................ 78 
Tenant Requirements Tab ................................................................ 79 

Agents ................................................................................................. 80 
Agent General Tab ........................................................................... 80 

Vendor ................................................................................................ 81 
Vendor General Tab......................................................................... 81 

Personal .............................................................................................. 81 
Personal General Tab ....................................................................... 82 

Prospects ............................................................................................. 82 
Managing Contacts ............................................................................ 82 

Adding a single contact and new company ...................................... 83 
Adding a contact to an existing company ........................................ 84 
Adding multiple contacts ................................................................. 85 
Alternate contact information .......................................................... 86 
Mailing Address............................................................................... 88 
Primary Address .............................................................................. 88 
Adding an alternate address ............................................................. 88 
Removing an alternate address ........................................................ 88 
Adding alternate phone numbers/emails .......................................... 88 
Deleting alternate phone numbers/emails ........................................ 89 
Editing alternate phone numbers/emails .......................................... 89 

Editing a contact ................................................................................ 89 
Address Standardization ................................................................... 90 

PROPERTIES .............................................................. 93 

Overview ............................................................................................. 93 
Property Screen Breakdown ............................................................. 94 

Page vi 



 

Address ............................................................................................... 97 
Amenities, Site, Owner & Agent tab ............................................... 97 
Adding amenities ............................................................................. 97 
Deleting amenities ........................................................................... 97 
Editing amenities ............................................................................. 98 
Site Contact | Owner | Agent Tabs ................................................... 98 

Property info panel ............................................................................ 99 
General Tab ................................................................................... 100 
Details Tab ..................................................................................... 100 
Units Tab ....................................................................................... 100 
Spaces Tab ..................................................................................... 101 
Listing Tab ..................................................................................... 101 
Lists Panel...................................................................................... 103 

Creating a Property Record ............................................................ 106 
Finishing the Property Record Entry............................................. 108 
Deleting a Property .......................................................................... 109 
Units .................................................................................................. 109 
Spaces ................................................................................................ 110 
Sorting Properties ............................................................................ 112 
Creating a New Order ..................................................................... 112 

COMPARABLES ....................................................... 113 

Overview ........................................................................................... 113 
Sales Comps Overview .................................................................... 113 
Sale Comps Screen Breakdown ...................................................... 114 
Address ............................................................................................. 117 

Site window ................................................................................... 117 
Adding amenities ........................................................................... 118 
Deleting amenities ......................................................................... 118 
Editing amenities ........................................................................... 119 

Property info panel .......................................................................... 119 
Lists Panel...................................................................................... 122 
Creating a Sale Comp Record ........................................................ 123 

Lease Comps Table .......................................................................... 128 
Adding a Lease Comp.................................................................... 128 

Space info panel ............................................................................... 132 
Lists Panel...................................................................................... 134 

Page vii 



TAGS ........................................................................ 137 

Overview ........................................................................................... 137 
Tagging Records ............................................................................ 137 
Viewing Tagged Records............................................................... 140 
Clearing Tagged Records............................................................... 141 
Reusing Saved Tags ....................................................................... 143 

POP-UP TABLES ...................................................... 145 

Overview ........................................................................................... 145 
Updating a single entry character field .......................................... 145 
Updating a multi entry character field ........................................... 146 
Updating a numeric field ............................................................... 148 
Updating a numeric field with a calculation .................................. 149 
Updating a date field ...................................................................... 150 
Adding Pop-ups to character fields ................................................ 151 
Changing Pop-ups .......................................................................... 152 
Deleting Pop-ups ........................................................................... 152 

Pop-up Table Review ....................................................................... 153 
Selecting Pop-ups .......................................................................... 153 
Alt Enter ........................................................................................ 153 

LINKS ........................................................................ 155 

Overview ........................................................................................... 155 
Creating a Link ................................................................................ 155 
Changing a Link .............................................................................. 156 
Deleting a Link ................................................................................. 157 
Attachments...................................................................................... 157 

DASHBOARD ............................................................ 159 

Overview ........................................................................................... 159 
Filtering Dashboard ....................................................................... 160 
User defined Queries ..................................................................... 160 
Sorting from Dashboard................................................................. 161 
Columns ......................................................................................... 161 
Events ............................................................................................ 161 
Sorting by the linked records ......................................................... 162 
Viewing Events .............................................................................. 162 
Calendar ......................................................................................... 162 

Page viii 



 

Database Record ............................................................................ 162 
Event Types ................................................................................... 165 
Alarm Dialog ................................................................................. 166 
Managing Events ........................................................................... 167 
Record Menu and Right-Click Menu ............................................. 167 
Schedule Menu .............................................................................. 167 

History .............................................................................................. 168 
Sorting and Viewing History ......................................................... 168 
Filtering the History List................................................................ 168 
Creating History............................................................................. 169 
Creating a History: ......................................................................... 169 
Managing History .......................................................................... 171 
Record Menu and Right-Click Menu ............................................. 171 

Calendar ........................................................................................... 171 
Calendar Settings ........................................................................... 172 
Calendar Tool Bar.......................................................................... 175 
Filtering Events .............................................................................. 176 

Daily Calendar ................................................................................. 176 
Opening the Daily Calendar........................................................... 177 
Selecting Dates .............................................................................. 177 
Adding an Event ............................................................................ 177 
Deleting an Event .......................................................................... 177 
Editing an Event ............................................................................ 177 
Recurring Event ............................................................................. 177 
Recurrence Range .......................................................................... 178 
Finishing an Event ......................................................................... 178 
Go To a linked Contact or Property ............................................... 178 

Weekly Calendar ............................................................................. 179 
Opening the Weekly Calendar ....................................................... 179 
Print / Print Preview....................................................................... 179 
Adding an Event ............................................................................ 180 
Deleting an Event .......................................................................... 180 
Editing an Event ............................................................................ 180 
Finishing an Event ......................................................................... 180 
Go To a linked Contact or Property ............................................... 180 
Refresh Calendar ........................................................................... 180 
Go To a Specific Date    ................................................................. 181 
Changing the Calendar View ......................................................... 181 
Filtering Events .............................................................................. 181 
Viewing Multiple Events Side by Side .......................................... 181 

Page ix 



Monthly Calendar ............................................................................ 182 
Opening the Monthly Calendar ...................................................... 182 
Adding an Event ............................................................................ 182 
Deleting an Event .......................................................................... 182 
Editing an Event ............................................................................ 182 
Finishing an Event ......................................................................... 183 
Go To a linked Contact or Property ............................................... 183 
Viewing Multiple Days Side by Side............................................. 183 

Call Timer......................................................................................... 183 
The Call Timer Window ................................................................ 184 

Projects ............................................................................................. 185 
Leads ................................................................................................. 186 

TIMELINES ................................................................ 187 

Overview ........................................................................................... 187 
Managing Timeline Templates ....................................................... 188 
Timeline Template Properties ........................................................ 189 
Edit the Timeline Template............................................................. 190 
Adding Phases and Events to Timelines ........................................ 191 
Managing Timelines ........................................................................ 192 

FINDING RECORDS .................................................. 201 

Overview ........................................................................................... 201 
Finding Records ............................................................................... 201 

Contact Search ............................................................................... 201 
Company Search ............................................................................ 204 
Property Search .............................................................................. 206 
Sale Comp Search .......................................................................... 207 
Lease Comp Search ....................................................................... 208 
Space Search .................................................................................. 209 

Sort Order Changes ......................................................................... 211 
Queries .............................................................................................. 211 

Simple Queries............................................................................... 212 
Field Conditions for Queries.......................................................... 213 

Simple Query Options ..................................................................... 214 
Replace current query .................................................................... 215 
Drill down within current query .................................................... 215 

Page x 



 

Add to current query ...................................................................... 215 
Table Access to Query dialog .......................................................... 216 
Advanced Queries ............................................................................ 216 

Advanced query dialog: ................................................................. 218 
Order of Operations and CRM Queries ......................................... 219 
Precedence of AND / OR explained .............................................. 220 
How AND Works with Multiple OR Clauses ................................ 221 
The Common Sense Test ............................................................... 221 

Working with Session queries ......................................................... 222 
Editing a Query in same Session..................................................... 222 

To edit a session query: ................................................................. 222 
Saving Queries ............................................................................... 223 
Executing a Saved Query ............................................................... 224 
Editing a Query .............................................................................. 225 
To replace an Existing Query: ....................................................... 225 
Releasing a Query .......................................................................... 225 
Deleting a Saved Query ................................................................. 226 
Changing the Properties of a Saved Query .................................... 226 

Custom Views ................................................................................... 226 
Dynamic Effect ................................................................................. 227 

Creating a Custom View ................................................................ 227 
Activating a Custom View ............................................................. 229 
Editing a Custom View .................................................................. 229 
Changing Custom View Properties ................................................ 229 
Deleting a Custom View ................................................................ 230 

Lookups ............................................................................................ 230 
Sorting............................................................................................... 232 

Creating a Sort Order ..................................................................... 232 
Selecting Sorts run since loading CRM ......................................... 234 
Editing Sorts run since loading CRM ............................................ 234 

Working with Session sorts ............................................................. 234 
Editing a Sort in the same Session .................................................. 235 

To edit a session sort:..................................................................... 235 
Saving Sorts ................................................................................... 235 
Executing a Saved Sort .................................................................. 236 
Editing a Sort ................................................................................. 237 
To replace an Existing Query: ....................................................... 237 
Deleting a Saved Sort .................................................................... 238 
Changing the Properties of a Saved Query .................................... 238 

Page xi 



Groups .............................................................................................. 238 
Groups cross tables ........................................................................ 239 
Adding a Group ............................................................................. 239 
Adding Records to the Group ........................................................ 240 
To add a single record to a group: ................................................. 240 
To add multiple records to a group: ............................................... 241 
Editing a Group.............................................................................. 241 
Deleting a Group............................................................................ 242 
Querying a Group .......................................................................... 242 
Validate Query ............................................................................... 242 
Some examples of potential users: ................................................. 243 
To create a validation query:.......................................................... 243 

LISTS ........................................................................ 245 

Overview ........................................................................................... 245 
Opening the List Window ............................................................... 246 
Sorting the List ................................................................................. 246 

Single Column Sort........................................................................ 246 
Multi Column Sort ......................................................................... 246 

Creating a Field List ........................................................................ 247 
Rearranging columns in the list ..................................................... 247 

Saving a New Field List ....................................................... 249 
Replacing an Existing Field List ...................................... 250 
Deleting an Existing Field List ......................................... 250 
Synching the List with a Record View ........................................... 250 
Checking for Duplicate Records ..................................................... 252 

Creating a duplicate list ................................................................. 252 
Saving a Duplicate List .................................................................. 254 
Renaming an Existing Duplicate List ............................................ 254 
Using an Existing Duplicate List ................................................... 255 

Merging Duplicate Records ............................................................ 255 

MS OFFICE INTEGRATION ....................................... 259 

Overview ........................................................................................... 259 
Outlook ............................................................................................. 259 

User Driven Contact and Events Synchronization ......................... 259 
Setting up Outlook to work with CRM .......................................... 260 
Performing an Email Sync to Outlook ........................................... 263 

Page xii 



 

Syncing Contacts and Calendar ..................................................... 265 
Creating a Sync Group ................................................................... 265 
Configuring CRM with Outlook .................................................... 267 
Configuration ................................................................................. 269 
Conflict Resolution ........................................................................ 270 
Action ............................................................................................ 271 
Configuration ................................................................................. 272 
Conflict Resolution ........................................................................ 274 
Performing the Contacts and Event Sync ...................................... 274 
Viewing Synchronize Conflicts ..................................................... 277 

Mail Merge ....................................................................................... 278 
About Document Templates .......................................................... 278 
Creating a Template ....................................................................... 279 

Performing a Mail Merge................................................................ 282 
Quick Email ...................................................................................... 287 

Sending an Email with Attachment ............................................... 288 
Quick Mail Merge.......................................................................... 288 
Merging a template from the Write menu. ..................................... 289 
Performing an Email Merge........................................................... 291 

Microsoft Excel ................................................................................ 291 
Exporting to Excel ......................................................................... 291 
Attaching a Spreadsheet to CRM ................................................... 292 
Viewing a Saved Spreadsheet from an CRM History Record ....... 294 

Microsoft Word ................................................................................ 295 
Exporting to Word ......................................................................... 295 
Attaching a Document to CRM ..................................................... 296 
Viewing an Attached Document from an CRM History Record ... 297 

REPORTS ................................................................. 299 

Overview ........................................................................................... 299 
Printing Reports............................................................................... 300 

Printing a report for a single record ............................................... 300 
Printing a report for a group of records.......................................... 300 

Creating a new report...................................................................... 300 
Modifying an Existing Report......................................................... 303 
Using Sub-reports ............................................................................ 304 

Inserting an Existing Sub-report .................................................... 304 
Creating a New Sub-report ............................................................ 304 

Page xiii 



Saving Sub-reports for Use in Other Reports ................................ 305 
Marketing Report ............................................................................ 306 

Output ............................................................................................ 307 
Saved Settings ................................................................................ 307 

IMPORT/EXPORT ...................................................... 308 

Overview ........................................................................................... 308 
Importing from flat files ................................................................ 308 
Importing Excel files ..................................................................... 309 
Importing a Flat File ...................................................................... 309 
Import file/database dialog ............................................................ 311 
Edit Import Map Dialog ................................................................. 314 
Destination and Source field grids ................................................. 315 
Mapping fields ............................................................................... 316 
Import Duplicate Rules .................................................................. 319 
Import Expressions ........................................................................ 320 
Import File Options........................................................................ 349 
Associating a contact with a property ............................................ 350 
Importing from CRM 8 .................................................................. 350 

Exporting .......................................................................................... 357 
Overview ........................................................................................... 357 

Synchronizing with Microsoft Outlook ......................................... 358 

OPTIONS AND TOOLS .............................................. 361 

Overview ........................................................................................... 361 
General Tab ...................................................................................... 361 

Show Dashboard on startup ........................................................... 362 
Edit records without pressing the Edit button .............................. 362 
Save changes without pressing Save.............................................. 362 
Default country .............................................................................. 362 
Default team................................................................................... 362 
Stamp notes.................................................................................... 363 
Notes font....................................................................................... 363 
Default greeting ............................................................................. 363 
Map symbol ................................................................................... 363 
Reset .............................................................................................. 363 

Events/History .................................................................................. 364 
Day starts at ................................................................................... 364 
Day ends at .................................................................................... 364 

Page xiv 



 

Time slot size ................................................................................. 365 
Pop up alarm window on top of other windows ............................ 365 
Color .............................................................................................. 365 
Event participants .......................................................................... 365 
History type ................................................................................... 365 
Update project/lead from new history records ............................... 366 
History for quick letters / emails .................................................... 366 

Phone................................................................................................. 366 
User Information ............................................................................. 367 
Advanced .......................................................................................... 368 

Splash screen ................................................................................. 368 
Always Use Advance Query Dialog .............................................. 368 
Set a Query When Following a Link ............................................. 368 
Retain cached data ......................................................................... 369 

User Management ............................................................................ 369 
Adding Users ................................................................................. 370 

Teams ................................................................................................ 371 
Adding Users to a Team ................................................................ 371 

User and Team Permissions ............................................................ 374 
User Permissions ........................................................................... 374 
Team Permissions .......................................................................... 376 

Database Manager ........................................................................... 377 
Backup ........................................................................................... 378 
Restore ........................................................................................... 379 
Upgrade Tables .............................................................................. 380 
Registration .................................................................................... 381 
User Accounts ................................................................................ 382 
User Logins.................................................................................... 382 
Postal Codes................................................................................... 383 
Distribute Updates ......................................................................... 383 
Shared Folder ................................................................................. 384 
Optimizing Reports ........................................................................ 385 
Organize Files ................................................................................ 385 
Admin Password ............................................................................ 386 
SQL Console .................................................................................. 386 

MAPPING .................................................................. 387 

Mapping ............................................................................................ 387 
Mapping Using the Internet ........................................................... 387 

Page xv 



Map links .......................................................................................... 388 
Microsoft MapPoint ......................................................................... 388 

Map symbol ................................................................................... 388 
Mapping a Single Record .............................................................. 389 
Mapping Multiple Records ............................................................ 389 
Address Resolution ........................................................................ 390 
Plotting Records from a Shape ...................................................... 391 
Creating a Route ............................................................................ 393 
Creating a Tour .............................................................................. 394 
Get Directions ................................................................................ 395 
Clear Pushpins ............................................................................... 395 

OTHER FEATURES ................................................... 397 

Instant CRM..................................................................................... 397 
Loading Instant CRM .................................................................... 397 
Today View ................................................................................... 398 
Calendar View ............................................................................... 399 
Working with Events ..................................................................... 399 
Using Auto Sync ............................................................................ 399 

Attachments...................................................................................... 400 
Attaching Photos ............................................................................ 400 
Attaching a picture (using the clipboard) ....................................... 401 
Attaching a picture (from your hard drive) .................................... 402 
Attaching a picture (from and email) ............................................. 402 
Setting the Default Photo ............................................................... 402 
Adding an Attachment ................................................................... 403 
Viewing / Editing Attachments ...................................................... 404 
Deleting an Attachment or Photo ................................................... 404 

Smart Meetings ................................................................................ 405 
Smart Web Links ............................................................................. 407 

Adding a Web Link........................................................................ 407 
Deleting a Web Link ...................................................................... 409 
Editing a Web Link ........................................................................ 410 
Web Link Manager ........................................................................ 410 
Generic Web Links ........................................................................ 410 
Web Link Groups .......................................................................... 411 

CRM Help Menu.............................................................................. 416 
Contents Menu ............................................................................... 416 
Index .............................................................................................. 416 

Page xvi 



 

Context-Sensitive Help {F1} ......................................................... 417 
Global Replace ................................................................................. 417 

Selecting Records for Global Replace ........................................... 417 
Clear a Field ................................................................................... 418 
Value Replace ................................................................................ 420 
Attach Multiple Contacts to a Single Address/Company............... 421 
Advanced Replace ......................................................................... 423 

Calculator ......................................................................................... 424 
Amortize ........................................................................................ 424 
Net Present Value .......................................................................... 426 
Present Value Calculator ............................................................... 428 
Future Value Calculator ................................................................. 430 
Lease Analysis Calculator ............................................................. 431 
Proforma Income Analysis ............................................................ 437 
Phone Dialer .................................................................................. 441 
Dialer Setup ................................................................................... 441 
Phone Dialer .................................................................................. 442 

Constant Contact Integration ......................................................... 443 
Setup .............................................................................................. 443 
Uploading to Constant Contact ...................................................... 445 

Field Properties ................................................................................ 446 
Numeric Formats ........................................................................... 448 
Special Keys .................................................................................. 449 

Field Keys ......................................................................................... 452 
Numeric Fields ................................................................................. 452 
Date Fields ........................................................................................ 452 
 

 

 

Page xvii 





 

 

CRM Concepts 
Overview 

RM tracks projects, properties, contacts and companies 
as well as the relationships between the them. The 
program was designed by commercial real estate 

professionals for commercial real estate professionals. The 
software gives you the ability to track all aspects of commercial 
real estate. 

Projects track your deals. They work for all aspects of 
commercial real estate. Tenant Rep, purchase, for lease, buyer 
rep and consulting. The system is completely configurable. 

Integration with Microsoft Office is also built in to CRM so you 
can use your favorite products to produce spreadsheets, letters 
and emails. 

You can automatically upload all your information to the cloud 
giving you access to all your information from anywhere 
anytime. 

Projects 
The project table tracks anything in your pipeline. It can track all 
the leads for a deal as well as your commissions. Depending on 

Chapter 
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what you’re tracking a lead could be a company, contact, 
property or space. You can also track commissions for multiple 
brokers or companies giving you a report to show your past, 
current and future revenue stream. It even lets you get a 
weighted report based on your suggested probability for a 
potential deal.  

Properties 
The property table tracks any type of property and detailed 
information. You can also breakdown the spaces and unit mix 
for each property including the occupants. 

A property can automatically create a linked sales comparable 
so you have a historical record of each buyer, seller, procuring 
broker and listing broker as well as the deal information every 
time a property sells. 

Companies 
Initially when CRM was written we thought of contacts as the 
core element. As we progressed we realized that companies 
were very often the core element in a deal. It also became clear 
that it was common to deal with two or more contacts at each 
company. Hind sight is 20/20, and as we looked at the initial 
idea it became clear that there should be a company table 
separate from contacts. That way you could create one 
company record and add as many contacts to the company as 
you wanted. There was no downside to having a company 
record, only upside. For example if you were working with a 
company that had 10 employees you could just add the 
employee’s names and be done. If the company moved you 
would change the company address and all 10 employees would 
automatically move. Initially this is a perplexing idea to people 
but as you use the system you’ll be surprised how much better 
it is. 

Personal: Your friends and acquaintances. 
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Projects 
Overview 
The project table tracks all of your deals, both potential and 
actual.  

Each deal you are working on should have a separate project 
record and every lead associated with that deal should be linked 
to it. 

A lead is anything that fulfills your goal. For example if you are 
selling a property, leads would be companies or contacts. If you 
were representing a tenant your leads would be properties or 
spaces. 

As you work through each lead in a project you can update the 
current status of that lead along with the result. 

You can also create and attach histories to each lead. For 
example if you had a meeting with a lead you can create a 
history referencing the date, time and result of the meeting. 
You can also attach events to a lead. For example if you looked 
at a site you could update that site/lead with the potential 
space or building. 

You can also document and track the commissions for this deal. 

Chapter 
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The Project Screen 
The project table contains one record for each project you are 
working on. The screen is laid out in four sections. The status 
panel, project panel, project info panel and the lists panel. 

 

Status Panel 
For detailed information on the status panel please see Chapter 
two explaining the shared screens in CRM. 

Project Panel 
There are five tabs in the project panel. You can click the tabs 
with your mouse to see the information contained in them. 

Details tab 
This tab contains the basic information about the project. 

Project field 
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This is the name of this project. You can enter anything you like 
in this field. This field is included in a search when you are trying 
to find a specific project and it is also used as the header in 
project reports. 

Type field 
Projects were designed to track any deal no matter what your 
focus is. Declaring the type for a project sets the steps you 
follow to reach your goal. 

CRM ships with a few pre-defined project types and you can add 
more. The type field is directly linked to the status field. It is 
important to understand how these two fields work before you 
use projects. 

Setting up a Project Type 
The easiest way to understand the 
project type field is to look at a few 
pre-designed types. 

 

Click the Tools menu, then System 
Tables and finally Project Set-up 
(like the example to the right). 

 

In the project set-up windows you’ll see two sections.  
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On the left are the names of the project types. CRM ships with 
six project types, Default, For Sale, For Lease, Buyer Rep, Tenant 
Rep and Opportunity. 

The right side of the dialog displays the status or stages a lead 
would move through for that project type. 

In the example you can see a project set-up for sales. We have 
designed the stages a client moves through starting with 
Suspect and moving to Due Diligence. You can change those to 
fit your own milestones. You can create as many project types 
as you like and then apply those to a deal. 

As you work on a deal you create leads. Depending on the type 
of deal a lead might be a space, property, contact or company. 
The term lead in a project means the opportunity you find to 
close the deal. So for buyer rep you might find 6 properties that 
would fit the requirement to close. Those 6 properties would be 
considered leads and you would assign each of the 6 properties 
a status telling you and your client where that particular 
property was in the process. 
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If you were working on leasing a space the leads would be 
contacts or companies. As you worked with each entity you 
would assign their status and move them through your stages. 

The projects and status defined in this table are available for 
every project, lead and history record. 

Project Panel 

 

There are 6 tabs on the project panel. The first tab defines the 
project and contains 14 different fields. 

Project: Name of this project or deal. 

Type: Select a project type you defined in the section above 
that matches this deal type. The project type selected 
here will populate the Status field dropdown with the 
stages you defined. This will let you track your leads as 
they move through the deal. 

Date opened: Date you start working on the deal. 

Client: Only contacts and company records can be clients for a 
project. Depending on the project type the client has 
different meanings. If you are working on a sale or lease 
the client would be the owner of the property and the 
listing would be either the property or the space you 
are selling or leasing. 

If you are working with a tenant to find them a property 
or space, or you are working with a buyer to find a 
property, the client would be the tenant or buyer you 
are representing and there would not be a listing. 
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Listing: This field is only used if you are leasing a building or 
space or if you are selling a property. If you are working 
with a tenant or buyer this field would be blank. 

Size: Numeric field is used to track acres, sq.ft, units; 
whatever is appropriate for the deal. 

Expected close: The date you guestimate this deal will close. 

Date closed: Date the deal closed. 

Status: Stages from the project definition. 

Result: Pre-defined values to define the state of a project. The 
values in this field are Active, Inactive, Won, Lost, and 
Dropped. Select the value that best describes the 
current state of this project.  

Reason: Describes the result field i.e.: when a deal is lost, 
tenant moved into a cheaper space. 

Investment: Deal is an investment. 

In-house listing: Self-explanatory 

In-house representation: Self-explanatory 

Client Tab 

 

The client is the customer you represent on a deal or the person 
you would like to represent. The client can be a company or a 
contact in CRM. To select the client click the drop-down arrow 
at the bottom right of the window. From the drop-down you 
can select an existing client or add a new one. You can click the 
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linked information to jump to a client, dial the phone, send an 
email or visit their webpage. 

Listing Tab 

 

If a property or space is involved in the deal such as a property 
you are trying to sell or a space you are trying to lease you can 
attach it on the listing tab. If this is Tenant Rep or Buyer Rep the 
properties and spaces would be leads and there would not be a 
listing entry. To attach a record click the pull down arrow at the 
bottom right.  

Products Tab 

 

CRM is seamlessly integrated with PropertyLine.com Using this 
tab you can search for properties or that fit your project. To use 
the search capability you must be a registered member of 
Property Line. There are two account types available. A free 
membership which allows you to search for properties but you 
are limited in CRM to the first 20 and you cannot automatically 
add those properties to your CRM database. The other account 
type is a paid membership. If you are a paid member of 
Property Line you can see all the results from a search and add 
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the properties to CRM automatically. For more information go 
to www.PropertyLine.com . 

CRM will search Property Line for listings that match your 
criteria and return a list of available listings. From the list you 
can select records that match your needs and automatically add 
them to CRM. 

Performing a Search 
1. Select the product type that matches your project 

needs 

2. Fill in any other fields.  
Equal to or greater than fill in the starting value only. 
Less than or equal to fill in the ending value only. 
 

3. You can select the sort order the properties will be 
downloaded in, making it easier to jump to the front or 
back if there are a lot of listings.  

4. Click the Search button to find matching properties. 

Result set 
CRM will return the result set in a grid. 

If there are photos available you’ll see a view button in the 
image column. You can click the view button to see the 
property.  

The matching properties are listed 20 at a time. If you are a 
paid subscriber of Property Line you can click the Next Page 
button to see the next 20 properties or you can click the 
Last Page button to load all the properties. This may take 
some time as CRM downloads all the matching properties. 

If you are a paid Property Line subscriber you can check the 
tag column to tell CRM you want to import that property. 
You can check up to 20 properties at a time. 

The matching records will be added to the property table.  
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Each tagged record will also be linked to the project as a 
lead. If the property was previously downloaded into CRM it 
will be updated with the current information. 

 

 

Project info panel 

 

Leads Tab 
The Leads tab displays all the leads for this deal. 

You can toggle the window to show only active leads by 
checking or unchecking the Active checkbox at the bottom left. 

The lead screen contains a subset of the project fields but this 
information is specific to the leads requirements. 
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You must have a lead for every Lead Detail you create. The lead 
will change depending on what you are tracking. 

For example if you are leasing space the lead will most likely be 
a company or contact but if you are working as a tenant rep 
your leads will most likely be properties or spaces. CRM doesn’t 
care what record you link the lead to but you must have a lead 
and that record must be in CRM. 

To attach a lead, click the down arrow to the left of the Lead 
combo box. 

Select the appropriate choice from the list and then locate the 
lead record in your CRM database.  

If the lead you are tracking is not in CRM 
you can add them right from the lead drop-
down combo box. When you drop down the 
list at the bottom you’ll see options for new 
contact, company, property and space. Select one of those to 
add a brand new lead to CRM.  

The Opened field tracks the date you started working with this 
lead. 
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Size is a generic field tracking the size the lead is looking for. 
You will need to adjust this to work within the frame work of 
the deals you are working on. 

Amount is also meant to be very generic. Enter the amount of 
the deal as it pertains to what you are working on. 

Commission can be either an amount or a percentage as you 
choose. We found the total commission field to be the most 
useful in our testing but the field is not restricted. 

Probability is an arbitrary value you place on the potential this 
deal has to close. This is a guestimate you make and will 
constantly change as the deal evolves. 

The Status field selections are predefined by the project type. 
For more information on defining the statuses see the section 
above on creating projects and statuses. This field should be 
used as a barometer of where this lead currently is in this deal. 
You should be constantly changing the status of each lead as 
you move through the deal. 

Estimated close is the date you guestimate that the deal will 
close.  This also will be a constantly moving target. CRM uses 
these fields in report to give you an idea of where you are on a 
project. 

Closed should be entered when a lead is finished. This field goes 
hand in hand with the Result field and is usually blank until a 
lead has made a final decision or the deal closes. 

Result is limited to one of 5 values. Active, Won, Lost, Inactive 
or Dropped. You set this value as the lead moves through your 
pipeline. 

Reason is used for an explanation when a lead drops, becomes 
inactive or you lose the lead. 

The Notes field is a free form text box. The field has an 
unlimited length but for reporting purposes you want to keep 
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this short and to the point. It should describe in a sentence or 
two the current state of this lead. 

Commissions Tab 

 

Using the commissions tab you can track the total amount of 
the deal and the total commission. You can also track splits for 
each entity participating in the deal. 

Field Definitions 
Amount: Total amount of the deal 

Comm Pct: Commission percent 

Flat Fee: If there is a flat fee associated with this deal 
enter the amount here 

Commission: Calculated field ((comm pct * amount) + flat fee) 

Prob. Probability that the deal will close 

Weighted Calculated field (prob. * commission) 

Tracking commission splits 
You can add any contact or company to the commission detail 
and enter their split on the deal as well as any flat fee they get. 

To add someone to the deal click in the first row where you see 
the * in the Agent column. Click on the drop-down arrow and 
select an existing record or add a new one to your database. 

Enter the Comm % in the next column. This is the percentage of 
the total commission the entry gets. So if the total commission 
for the deal was 4% and you entered 50% for this entry they 
would be getting 2% of the entire deal or ½ of the 4% 
commission. 
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You cannot enter more than a total of 100% in the split window. 

If a flat fee is involved you can split up the fee between the 
agents but you cannot allocate more than the total amount 
entered in the Flat Fee field for the project. 

The commission column displays the total amount each entry 
would receive if the deal closed. 

The weighted column displays the commission amount based 
on the probability of the deal closing. 

Project Lists Panel 
Most of the tabs in the lists panel contain a grid like the one 
below in events.  

Choosing the columns to display 

You can show or hide the columns by right clicking on the grid 
and choosing columns. You can also sort by most columns. 

Sorting the grid 

To sort the grid double click on the heading of the column you 
want to sort by. In some cases you can also reverse the sort by 
double-clicking the heading again. 

Re-sizing the grid 

You can change the width of the columns by placing your mouse 
cursor in between two columns in the header section. When 
you are in the correct location your mouse cursor will change to 
a cross. When you see the cross hold down your left mouse 
button and drag the column edge to the desired width then let 
go of the mouse button when you have reached the correct 
width. 

Changing column locations 
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You can change the column locations by clicking on the heading 
of a column and while holding down the left mouse button 
dragging the heading to a new location in the grid. 

Right click menu 

In most of the grids you can right click to see a menu of options. 
Each grid has different options depending on the data 
displayed. 

Using the Print Link 

Many of the grids have a print link in the bottom left section. 
Clicking that link will give you the dialog below. 

 
Title: Enter a title for the report 

Report Style: Select the style that you like 

Column Settings: Check the columns you want to see in the 
report and uncheck the ones you don’t want printed. 

Layout: 

 Span across pages: prints extra columns on the next 
page. 
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 Fit to page: Resize to fit columns on one page. 

Output Settings: Select the device to send the print out to. 

Print Button: Print the report 

Preview: Display the report before you print it 

Export: as a PDF, HTML page, JPEG or TIFF file. 

 

Events Tab 

 

Under the events tab you can track upcoming activities such as 
meetings, phone calls or things to do. Schedule anything you 
want to relate to this project from the events tab by right 
clicking in the window and clicking schedule. For more 
information on events see the chapter on scheduling in this 
manual. 

Filtering for specific event types 

You can limit the records in the events tab by 
clicking the link on the bottom left that says 
Events.  

Check event types you want to see and un-
check event types you don’t want to see. 

Click All to set or clear all the check marks. 

This setting will apply to all the records in the 
table you are in until you reset it. 
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Filtering for specific dates 

You can set the event table to show specific 
date ranges. Click the Dates link on the 
bottom left to pop-up the window. 

Select All to set past, present and/or future 
events visible in the grid. 

Select Range to set a date range.  

The setting you use will cover all the record 
in the table you are in until you rest it. 

 

History Tab 

 

The history tab will show everything that has been finished and 
is attached to the project. You can manipulate history by right 
clicking in the window. For more information see the chapter in 
the manual on history. 

Filtering for specific history types 

You can limit the records in the events tab by 
clicking the link on the bottom left that says 
Events.  

Check event types you want to see and un-
check event types you don’t want to see. 

Click All to set or clear all the check marks. 

This setting will apply to all the records in the 
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table you are in until you reset it. 

 

Filtering for specific dates 

Click the date link to filter out histories on a specific date. 

Select all history to see everything. 

Select previous days to see history back 
to a certain number of days.  

The setting you use will cover all the 
record in the table you are in until you rest it. 

 

Links Tab 

 

The links tab lets you attach people that are involved in this 
deal. When you link someone you should fill in their role in the 
deal under the description tab. When you view the links it is 
very helpful to have a description of why that person is linked to 
the deal in the window.  

Attachments 

 

Any documents, packages, photos, analysis or other 
attachments you want to review for this project should be 
attached in this window.   
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You can also click the attachments link on the bottom left to 
filter out specific attachments. Check the types you want to see 
in the list and uncheck the ones you don’t want to see. 

Clicking all will toggle on and off all the check marks. 

This setting will remain in effect for all the records in the table 
you are in.  

Notes 

 

The notes are a free form field. Feel free to enter any useful 
information about the project in this field. The field includes the 
following features 

Date / Time Stamp 

 Click the date time toolbar button to insert the current 
date, time and user information into the note. You can set 
the information that gets pasted under the Tools|Options 
menu in CRM. 

Paste Clipboard 

 Click the paste icon to paste the text in the windows 
clipboard into the notes as unformatted text. You can 
click the down arrow next to the paste button and select 

Paste as text 

Paste formatted to keep the formatting of the text 

Convert to Text which will convert the entire note to plain 
text. 
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Spell Check 

 Click the spell check toolbar button to spell check the 
entire note. Click the down arrow on the spell check 
button to turn on or off auto check. When auto check is 
on, CRM will underline words that are misspelled as you 
type them and in some cases automatically fix the spelling 
of words it recognizes. 

B, I, U 

 Set Bold, Italic or Underline on for the highlighted word(s) 

Font Style and Size 

 Click the drop-down font to choose a different font for 
the highlighted text and you can change the size as well. 

Font color 

 Click the font color button to change the color of text and 
click the drop-down arrow to select the default color to 
use. 

Bullet list 

 Click the bullet list button to create a simple bullet list of 
items in the note. 

Justification 

 Click the Left, Center or Right justify buttons to align the 
highlighted text. 

Undo – Redo 

 Click the undo button to undo changes made in the notes 
section and click the Redo button to add back changes 
you undid. 

Magnify 

Page 39 



 

 Click the magnify button to open the notes in a separate 
window so you can expand the screen and see more 
notes in one screen. 

Creating a Project 
1. Click the New button 

2. Click Project 
3. Enter the project information 

4. Click the Save icon 

Creating a Lead 
1. Click the Leads tab in the project info 

panel  
2. Right click in the leads window and click 

New 
3. Click the down arrow for the lead and 

select or create your lead 
4. Enter the information about this lead 
5. Click OK 

You can enter events, history, links, attachments and notes on 
the Project List Panel. For more information on these functions 
look at the related chapters in this manual. 

Viewing a Project List 
You can view all your projects from the Dashboard screen. To 
view Dashboard press the F2 key on your keyboard or click the 
Dashboard Icon or from the View menu chose Dashboard. 

From this window you can sort, query, edit and export your 
projects to Excel. For more information on using the Dashboard 
Screen see the chapter in this manual on Dashboard. 
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Viewing a Lead List 
You can view all leads from the Dashboard screen. To view 
Dashboard press the F2 key on your keyboard or click the 
Dashboard Icon or from the View menu choose Dashboard. 

From this window you can sort, query, edit and export your 
leads to Excel. For more information on using the Dashboard 
Screen see the chapter in this manual on Dashboard. 

Adding a record as a Lead 
From an Individual Lead Record 
You can add any record as a lead to a project using the project 
tab under the Lists panel. 

For example if you were talking to a contact and they expressed 
interest in a project you had you could: 

1. Click the project tab under 
the Lists Panel on their 
record 

2. Right click in the window and 
choose Add to Project… 

3. Choose the project they are 
interested in and click OK 

4. Fill in the requirements for the lead and click OK 

From a Project record 
You can add a lead from a project record. 

1. Open the Project you want to 
create a lead for 

2. Click the Leads tab under the 
Project Info  

3. Click New 

4. Fill in the requirements for the 
lead and click OK 
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Creating a history for a Lead 
From a Project Record 

1. Click the leads tab on the Project 
Info Panel  

2. Right click on the lead and click Add 
History 

3. Fill in the information (the 
Project/Lead and Linked to will be 
filled in automatically) 

4. Click OK 

From an Individual Lead Record 

 

1. Click the project tab on the Lists Panel 

2. Right click in the window and click Add History 
3. Fill in the information (the Project/Lead and Linked to 

will be filled in automatically) 
4. Click OK 

Scheduling an event for a Lead 
From a Project Record 

1. Click the Leads tab on the Project 
Info Panel  

2. Right click on the Lead record in the 
window and click Schedule 

3. Fill in the information (the 
Project/Lead and Linked to will be 
filled in automatically) 
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4. Click OK 

 
From an Individual Lead Record 

 

1. Click the project tab on the Lists Panel 
2. Right click in the window and click Schedule 

3. Fill in the information (the Project/Lead and Linked to 
will be filled in automatically). 

4. Click OK. 

Go to a project from a Lead 
1. Click the Project tab on the Lists panel 
2. Right click on the lead 

3. Click Go To Project 

Removing a Lead from a project 
From a Project Record 

1. Click the Leads tab on the Project Info Panel 
2. Right click on the lead 

3. Click Remove 

4. Confirm you want to remove the lead 
5. The lead will be removed from the project but will not be 

deleted from your database. 

From a Lead Record 
1. Click the Project tab on the Lists panel 
2. Right click on the Lead 

3. Click Remove from Project 
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4. Confirm you want to remove the lead 

Viewing a Leads Projects 
You can view all the projects a lead is involved in from the 
Projects tab on the leads individual record. 

 

Any project the record is a lead for will have the relation set to 
Lead. In the example above this contact is a lead for two 
available spaces. You can see the space listed under the project 
column. 

You can change the columns in this list by right clicking in the 
Projects window and selecting columns from the menu. 

You can go to a project this record is a lead for by right clicking 
the record and selecting go to project. 

If you are talking to this lead about a project and you want to 
record a history or schedule an event for the project simply 
right click the record and select history or schedule. The record 
you create will automatically be attached to the project for you 
and linked to the record. 

You can limit the list to just active projects by checking the 
Active check box at the bottom of the project list. If you want to 
see all the projects un-check that box. 

You can also query the project types so you only see specific 
types. If you are not seeing a project you expect to be in the list, 
make sure you click the Types link at the bottom of the window 
and select All types as well as un-checking the Active checkbox. 
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Viewing the Projects a Record is the Client for 
Only contacts and company records can be clients for a project. 
On a sale or lease the client would be the owner of the 
property. 

For representation the client would be the tenant or buyer. 

From the Projects tab on a contact or company record you can 
see projects they are the client for listed as Client in the 
Relation column. You can tell what type of a project it is by 
looking at the type column. 

For example if the relation was listed as Client and the Type was 
listed as For Lease then you would know that this company or 
contact is the owner of the property you are leasing. If the type 
was listed as Buyer Rep you would know that this company / 
contact was the entity you were representing on a purchase. 

You can limit the list to just active projects by checking the 
Active check box at the bottom of the project list. If you want to 
see all the projects un-check that box. 

You can also query the project types so you only see specific 
types. If you are not seeing a project you expect to be in the list 
make sure you click the Types link at the bottom of the window 
and select All types as well as un-checking the Active checkbox. 
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Viewing Leads for a property 
When you create a project you can select the listing. The listing 
can either be a property or a space. The listing field in a project 
is blank if you are working Tenant or Buyer Rep. 

 

Once you set a property or space as the listing for a project any 
leads you associate with that property or space will display on 
the project tab for that property or space. 
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You can limit the list to just active leads by checking the Active 
check box at the bottom of the project list. If you want to see all 
the projects un-check that box. 

You can also query the project types so you only see specific 
types. If you are not seeing a project you expect to be in the list 
make sure you click the Types link at the bottom of the window 
and select All types as well as un-checking the Active checkbox. 

Viewing Leads for a Tenant / Buyer 
If you work representation, the project and leads tabs takes on 
a different meaning. For representation a lead would be a 
property or space instead of a contact or company. When you 
look at a contact or company record you are representing, the 
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leads tab would show all the properties of which you are 
representing them. 

 

If you went to one of these property lead records and looked at 
the Projects tab you would see the relation set to Lead. That is 
because this property is a lead for your Buyer or Tenant. 
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Companies 
Overview 
Typically contact managers force you to add company 
information for every contact even though the information is 
already entered on other contact records. This leads to errors, 
wasted time and makes it very difficult to see all the contacts in 
a company.  

The key idea to grasp is the purpose of company records is to 
identify its location.  

3 Scenarios to consider 
Company records are broken down into three tiers; the 
organization, subsidiary and company. For small companies all 
three are the same, as they are located at the same physical 
address.  

For companies with two locations the organization would be the 
umbrella while the company level is the actual location of the 
business. Subsidiaries are used for very large corporations that 
have physical locations underneath secondary companies. 

In order to decide how best to use company records consider 
these situations: 

Chapter 

3 
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 A commercial broker has an office with a single 
assistant. They have one location; the organization and 
company are the same.  

 The broker in our previous example has expanded to 
two offices. Each is a LLP (separate legal entity) for 
liability reasons. Because there are now two physical 
locations and brokers working at each, you need a 
company record for both. Each broker contact is then 
linked to the appropriate company location.  

 Our intrepid broker has done so well that his two offices 
have been purchased by a large nationwide brokerage. 
Now, the Organization record becomes the nationwide 
brokerage, the subsidiary record is the one for the 
original broker and the companies are the two office 
locations.  

Advantages of CRM’s Companies System 
 Only one company record is required per office. 

 Each contact is attached to a company simplifying the 
creation of a new contact and eliminating office 
duplication. 

 Enhances database integrity 

 Changing address information for large groups of 
contacts at the same location is a simple one time 
change. 

 Creates a central storage area making it easy to view 
contacts at an organization, subsidiary and/or company 
location. 

 Allows you to view all the properties a company, 
subsidiary or organization owns. 

 Allows you to view all the spaces a company, subsidiary 
or organization occupies. 
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 Enhances speed as multiple records in a system are now 
reduced to a single record. 

 Makes $$$$$ 

The company table is broken up into three sections. (Figure 3-1) 

 
Figure 3-1: Company organizational chart 

 The Organization is the top level  

 The Subsidiary follows the organization  

 The Company follows the subsidiary  

 Contacts are attached to the company records. 

From this view you can maintain, merge and create companies 
and contacts. 

To track smaller companies you can simply specify the 
organization. You can also use this format to track owners who 
create Limited Liability Companies (LLC). Using the Organization 
to hold the owner’s corporation, then adding all the LLC’s into 
the company section. This makes it simple to find the real 
owner of a property when you are looking at the LLC in the 
property table. 

Another example of a good use for this format would be 
brokerage companies. You could put the parent or umbrella 
company as the organization, put in the actual office or 
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Companies 

franchisee as the subsidiary and then put in all the offices as 
companies. 

You’ll find a number of uses for the company table if think 
creatively.
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Companies Screen Breakdown 

 
Figure 3-2: Company Screen 

Company Panel 
Depending on the tab selected you can view the address 
information for the currently selected company or the 
organizational chart of the company. For a complete 
explanation see the Companies Company Panel in this 
chapter. 

Company Info Panel 
View the contacts at a company, subsidiary or company. 
See the properties a company owns or the spaces they 
are in. You can also view User defined fields and logical 
fields by clicking the individual tabs. 

Status Panel 
The status panel gives information about the record 
owner, team that can view and edit this record, as well 
as information about what groups this company is a 
member of. 
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Order of Company Records (Sort Order) 
You can sort the company records in any order you want 
using this section of the company record. The current 
company order will be listed in the window. For more 
information on sorting records see the chapter on 
Sorting Records in this user’s guide. 

Company Filter (Query) 
This section allows you to filter or query the company 
records for specific criteria. You can limit your database 
to specific companies using this section. For more 
information on sorting records see the chapter on 
Querying in this user’s guide. 

Total records and current record 
On the company toolbar you can access commonly used 
functions such as adding, deleting and printing a record. 
You can also move through the database using the arrow 
keys on this toolbar and you can see how many records 
you have available to you in the company database as 
well as the current record you are on. 

Record owner and Team 
The record owner controls all aspects of the record. They 
also decide which team has access to this record and 
what rights that team and its members has. 

The team section tells CRM which team is allowed to 
access this record.  There are three choices; everyone, 
private, or a specific team. For more information about 
teams see the chapter on Teams in this user’s guide. 

Verify Now 
Click this button to acknowledge the last time someone 
verified the company information for this record. You 
can right click on the date verified field and choose the 
sort options to sort your company records. 
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Add Contact Button 
Use this button to add a contact to the currently selected 
company. For more information see Adding a Contact 
from the Company Table. 

Groups Company belongs to 
This window shows you the groups the company 
currently belongs to and it allows you to change those 
groups. 

Date and Agent who added and updated record 
On the bottom left of each company record CRM will 
display who added the record to the system and when, 
as well as who last updated the record and when. 

Current time at this company’s location 
On the bottom right of the company record CRM displays 
the actual time where ever this company is located. 

Companies Company Panel 
The company window (Figure 2-2) is split into three panels: 
Company , Lists  and Status .  The company panel displays 
either the address information or the organizational hierarchy. 
(Figure 3-3) 

 
Figure 3-3: Org Chart Tab on Company Panel 

Working with the Org Chart Tab 
The company panel contains two tabs; the Address tab and Org 
Chart tab. Each list contains companies within the same 
organization.  
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In Figure 3-3 the organization is Olympia Partners. The 
organization only shows once in the chart at the top. The 
subsidiaries are listed directly under the organizations. In the 
example they are listed as Asset Services, Consulting and 
Property Management. 

The companies are listed under each subsidiary. To create the 
example list in (Figure 2-3) we created four company records. 
Each of the company records had the same organization, 
(Olympia Partners). Two of the companies had the same 
subsidiary (Asset Services) and the other two companies had 
different subsidiaries. 

When CRM creates the org chart it looks through your entire 
company table for matching organizations. Within each 
organization it organizes the companies by subsidiaries and 
then within the subsidiaries records are sorted by company 
name. 

You can edit all the fields in a company record if you find 
something isn’t matching up. Most of the time you’ll find the 
problem is a simple spelling mistake in the organization or 
subsidiary. 

Expanding the Organizational Chart 
To expand an organization or subsidiary Click on the plus (+) 
icon in front of the organization or subsidiary. To collapse the 
list Click the minus (-) icon. 

Resizing the Company Panel 
5. Move your mouse to the bottom of 

the Company Panel until it changes 
to a bar with up and down arrows. 
(Figure 3-4) 

6. Hold down your left mouse button 
and drag the panel up or down to re-
size it. 

Figure 3-4: Sizing panel 
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7. Release your left mouse button 

Hiding the Company Panel 
1. Move your mouse to the top of the 

Company Panel. (Figure 3-5) 
2. Click your left mouse button on the 

word “Company”. 
3. To expand the company panel, Click 

in the same spot. 

Adding a Company 
In a perfect world, you would begin using CRM by adding all the 
companies with which you plan to do, and are doing business. 
The reason for this idea is that as you add companies you can 
add and link the contacts that are associated with the company 
at the same time.  

CRM has a feature that makes it easy to enter a company while 
avoiding duplication. To enter a new company: 

1. Click the Search button  on the tool bar and 
choose Company or Press {Alt+F12}. The Select 
Company window appears as in (Figure 3-6).  

 
Figure 3-6: Select company window 

The fields in this window work as follows: 

Figure 3-5: Hiding panel 
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Organization: Top level, large corporations with multiple 
subsidiaries containing multiple companies. 

Subsidiary: Secondary level under every organization. Each 
organization can contain multiple subsidiaries 
and each subsidiary can contain multiple 
companies. 

Company: This section contains the location and company 
name for each company you track. 

Contact: Each Company can contain multiple contacts. 

Example 

 Campbell’s 
 Campbell’s Soups  
 Campbell's Chunky Soups 
 John Terrence, CEO 
 

2. Click Search. If one or more company records exists, or is 
close to what you entered, they (it) appear(s) in the 
lower portion of the window. You can browse the list 
and Click on the existing company record. 

3. If you get a dialog box message that reads, “No records 
meet your criteria” you are ready to add the new 
company. 

4. Click Columns to define the columns you see in the 
results window. 

5. Click New, the Company details window appears. (Figure 
3-7) 
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Figure 3-7: Window for entering company details 

6. Enter all the information. 
7. Click OK. CRM creates and displays the new company 

record. 

Adding to an Existing Organization 
1. Lookup the existing organization. 

2. From the Record menu select Add to Organization or 
Click {Ctrl+Alt+N}. 

Changing the Company Information 
1. Click on the Address tab.  
2. Double-Click in the Address window. 

3. Enter all the information. (Figure 3-8) 
4. Click OK. CRM will display your 

changes. 
Editing the address information for a company record changes 
the company information for all contacts attached to that 
company. Thus, when a company changes offices, you will only 
need to edit a record one time in order to update the 
information for all of the contacts for that company.  

Figure 3-8: Address tab 
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Company Info Panel 
The info panel (Figure 3-2 ) has five tabs: Contacts, Properties, 
Spaces, User Fields, and Logical Fields. 

The information shown in this panel depends on which tab you 
have selected and which company is selected. 

All tabs except the Contacts tab will only show information for 
the currently selected company record. 

Company Contact List  

 
Figure 3-9: Contacts attached to current company 

You can define a company as a specific type by checking 
Investor, Tenant, Agent, Vendor, Personal or Prospect. When 
you create new contacts using the “Add Contact” button CRM 
will automatically copy that attribute to the contact record. 

The contacts tab lists contacts for the organization, subsidiary, 
or company you are currently viewing. It lists the contact’s 
name, title, and telephone number, and the list can be viewed 
in order by any of those fields by Double-Clicking on the column 
header Name, Title, or Phone. (Figure 3-9) 

The contacts view of the companies is separated into 3 different 
sections: Organization, Subsidiary, and Company. Selecting one 
of the radio buttons will change the list of contacts. The 
organization button will show every contact that is associated 
with the organization of the office you are currently viewing in 
all of the offices and subsidiaries. Subsidiary will show all of the 
contacts that are at all of the offices within the subsidiary of the 
record you are currently viewing. Company will show only the 
contacts of the office record you are currently viewing.  
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Getting all the Contact’s Information 
To see all the information for a contact in the list Double-Click 
that Contact. This will open the Contact window and give you 
access to all of the contact’s information. 

Deleting Contacts from the Company Table 
To delete the contact from the table Right-Click on the contact 
and select Delete or highlight the contact in the list and press 
the {DEL} button on your keyboard. CRM will prompt you with 
the message “Are you sure you want to delete this contact?” If 
you Click “Yes” the contact along with all histories, events, links, 
attachments and notes will be removed from the table and 
cannot be recovered. 

Adding a Contact from the Company Table 
1. It’s a good idea to search for the contact before you add 

one using {F12}. For more information on that see the 
chapter on contacts in this user’s guide. 

2. Click the company record in the Org Chart that you want 
the contact attached to. 

3. Click the Add Contact button. (Figure 3-2 ) 
4. Add the information for the contact as outlined in the 

Contact Chapter in this manual. 

Properties 
Click the Property tab to view properties linked to the selected 
company record. You will only be able to see links that you are 
allowed access to.  

 
Figure 3-10: Properties attached to current company 

Page 61 



Companies 

Adding Property Links 
You can only add the company as an owner from the property 
or sale comp tables. When you make a company a site contact, 
owner or agent in one of those tables the link will show here. 

CRM will display the link type in the Relation column. If the 
company is linked to a property as a single entity CRM will 
display Site, Owner or Agent. If the company has multiple roles 
on a single property CRM will display S, O or A to let you know 
the company has multiple contact roles on that property. 

Go To Record 
To go to the linked record, double-click the link record or right-
click the link and choose Go To Record. 

Delete a Link 
To delete a link you must go to the linked record and click the 
contact from that record. 

Sorting the Links List 
Double-click the title at the top of the column you want to sort 
the links list by. CRM will indicate the current sort order of the 
list with an up or down arrow at the right side of the active 
column. You can reverse the order of the records by repeatedly 
double clicking on the same heading.  

Spaces 
Click the Spaces to view spaces linked to the selected company 
record. You will only be able to see links that you are allowed 
access to. 

 
Figure 3-11: Spaces attached to current company 
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Adding Spaces 
You can add a company as the tenant in a space from a space 
record. You can do that from either the property record on the 
spaces tab or from the Space table. 

To add a company from the company record right click in the 
space window and select Move In. Find the space in the Select 
Space dialog. You can also add a space from that dialog using 
the New button. 

Go To Record 
To go to the linked space or property right-click the linked 
record select Go To Property or Space. 

Move a Company out of a space 
Right-click on the space link and select Move Out. 

Sorting the Spaces List 
Double-click the title at the top of the column you want to sort 
the links list by. CRM will indicate the current sort order of the 
list with an up or down arrow at the right side of the active 
column. You can reverse the order of the records by repeatedly 
double clicking on the same heading. 

User Fields / Logical Fields 
CRM has some special fields added that allow you to track any 
outside information that you feel is important. The first set of 
these fields is under the User Fields tab on the company record. 
The second set is under the Logical Fields tab. 

You can change the labels for these fields. The change affects all 
company records and your entire database. 

To add information to the User Fields just type it in. The logical 
fields are Yes/No so you can check or uncheck those values. 
When you save the company record the values in these fields 
will be saved with the company record. 
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The fields in the User Fields and Logical Fields are linked to the 
individual company record. There is no way to create them for a 
Subsidiary or Organization. 

Companies Lists Panel 

 
Figure 3-12: Company List Panel 

 

The lists panel has six tabs: Contacts, Links, Attachments, User 
Fields, Logical Fields and Notes. 

The information shown in this panel depends on which tab you 
have selected and which company is selected. 

 

All tabs except the Contacts tab will only show information for 
the currently selected company record. 

Company Links List 

 
Figure 3-13: Company Links List 

The links tab lists records that have been linked to the selected 
company. This window lists the type of table i.e.: Contact, 
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Property or Company. The record field gives you a live listing 
from the linked record. You control the information in the 
Description field.  The owner field lists the name of the CRM 
user who owns the link. 

You can quickly jump to any linked record in this window by 
double clicking on the link.  

The information in this window can be modified to quickly show 
you important facts about the link. 

Adding a Link 
1. Click the links tab. 

2. Right-Click in the links window. 
3. Click Add from the menu. 

4. Create the record (for more information see the links 
chapter). 

5. Click OK to save the link. 
6. CRM will display the linked record in the links window. 

Deleting a Link 
1. Click the links tab. 
2. Right-Click on the link you want to delete. 

3. Click Delete from the menu. 

4. Click Yes in the “Are you sure you want to delete this 
link?” window. 

5. Once a link has been deleted it cannot be recovered. 

6. Click OK to save the link. 

7. CRM will display the linked record in the links window. 

Editing a Link 
1. Click the links tab. 

2. Right-Click on the link you want to edit. 
3. Click Edit from the menu. 

4. Make the changes you want to the link. 
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5. Click OK to save your changes. 

6. CRM will display the linked record in the links window. 

Go To Linked Record 
To quickly jump to a linked record Double-Click it in the link list. 
CRM will automatically open the correct table and show you the 
linked record.  

Filtering which Links you see 
1. Click the Filter button on the far left side of the list. 
2. Check any link types you would like to see and uncheck 

types you don’t want to see. 
3. Click in the list window to set the filter. 

NOTE: This will not remove any records from the table; just hide 
them from you until you change your filter. To see all links check 
All. This setting is global for every record in the company table but 
only applies to the current user so other users on your network will 
not be affected by the settings you make in the Filter dialog.  

Attachments 

 

Figure 3-14: Companies Attachment List 

The attachments tab (Figure 2-14) allows you to associate any 
type of file with a record. You can attach spreadsheets, scanned 
documents, faxes, graphics or any other file on your hard drive. 

When you Double-Click the file attachment icon, the file opens 
in the application that was used to create it. 
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Attaching a file to a Company 
1. Click the company you want to attach a file to in the 

Companies Org Chart. 

2. Right-Click in the attachments window and choose Add. 
3. Find the file you want to attach and Double-Click it. 

4. The file will show in the attachments window 

Deleting an Attachment to a Company 
1. Right-Click on the attachment you want to delete. 

2. Click Delete from the menu. 

Setting the Default Picture for Reports 
When you create reports you can add a picture holder in the 
report. CRM will send the default file from your attachment list 
to the report and display it. You can make one file for each 
company record a default file. To do so: 

1. Click the company you want to attach a file to in the 
Companies Org Chart. 

2. Right-Click in the attachments window and choose Add. 
3. Find the file you want to attach and Double-Click it. 

4. The file will show in the attachments window 
The files in the attachments tab are linked to the individual 
company record. There is no way to create an Attachment for a 
Subsidiary or Organization. 

Notes Tab 

 
Figure 3-15: Companies Attachment List 
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In the notes tab (Figure 3-2) you can type comments. A good use 
for this window would be general information such as the size 
of the company, when it was founded, interesting or helpful 
history or useful relationships the company has. 

Sorting Companies 
To change the order of the company records you can use the 
Sort combo box (Figure 3-2 ) at the top of the company table. 
For more information on sorting tables see the chapter on 
Sorting Records. 

Querying Companies 
If you want to restrict which companies you see you can use the 
Query combo box (Figure 3-2 ) at the top of the company table. 
For more information on querying tables see the chapter on 
Querying Records. 

Listing Companies {F5} 
Sometimes it is useful to see the company records in a list view, 
similar to a spreadsheet. The list function allows you to do just 
that. You can merge company records from the list window and 
you can send the list of records to Excel. For detailed 
information on the list window please see the chapter on Listing 
Records. 
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Contacts 
Overview 
CRM contacts are the people you do business with as well as 
your friends. By linking contacts to their companies, you create 
a powerful network of interactive information. It is important 
that you not only enter every contact into CRM and correctly 
identify their relationship to you, but that you link them to their 
companies at the same time.  

Contacts classifications: 

Investors: Owners, developers, potential buyers. 

Tenants: Businesses currently leasing or looking to lease 
space. 

Agents: Last resort for selling or leasing a property. 

Vendors: Contacts such as title companies, lenders, attorneys 
and plumbers. Basically anyone you do business 
with who doesn't lease or purchase properties. 

Personal: Your friends and acquaintances. 

 

Chapter 

4 
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Because a contact record can be in all 5 categories, if a contact 
has multiple identities such as an Investor who is also a Tenant, 
you only need to create one record. Using the check system in 
CRM you can mark any contact in multiple categories and fill in 
the appropriate tabs to track the specific information on each 
category. 

Contact Screen Breakdown 
The contact window (Figure 3-1) is split into four panels: 
Address, Contact Info, Lists and Status. There should 
only be one record for each contact you work with. It is 
important that you try and avoid duplicating contacts. 

 

Figure 4-1: Contact main screen 

Combining the category check boxes and contact tabs you 
can track all the contacts information in the same record. 

Contact Address Panel 
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Displays address information for the contact, attached 
company or alternate address information. For a 
complete explanation see the Contact Address Panel in 
this chapter 

Contact Phone, Email and Webpage 
This section displays the phone numbers for the contact 
tab selected in area 1. It also displays email and web 
page information and the Do Not Contact fields. 

Contact Type 
Each contact can be classified as investor, tenant, agent, 
vendor, personal and/or prospect. See the sections 
below for a complete breakdown of each type. 

Contact Detail Tabs 
The contact detail tabs allow you to view and change the 
specific information pertaining to each contact type. You 
can also query from this section to limit your contact 
view to those people you specifically want to work with. 

Contact Details 
The fields in the details section change with each tab you 
Click. Using this section gives you access to many fields 
for each contact. 

Contact Lists Panel 
Depending on the tab selected you can view all events, 
history, links and notes about this contact. 

Status Panel 
The status panel gives information about the record 
owner, team that can view and edit this record, as well 
as information about what groups this contact is a 
member. 

Verify Button 
Use this button to time and date stamp when you last 
confirmed the information for this contact. 
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Groups in which this Contact is a member  
This window shows you the groups the contact currently 
belongs to and it allows you to change those groups one 
by one or as a mass operation. 

Order of Contact Table (Sort Order) 
You can sort the contact records in any order you want 
using this section of the contact record. The current 
contact order will be listed in the window. For more 
information on sorting records see Sorting Records. 

Contact Filter (Query) 
This section allows you to filter or query the contact 
records for specific criteria. You can limit your database 
to specific companies using this section. For more 
information on sorting records see Querying Records. 

Total records and current record 
On the contact toolbar you can access commonly used 
functions such as adding, deleting, and printing a record. 
You can also move through the database using the arrow 
keys on this toolbar and you can see how many records 
you have available to you in the contact database as well 
as the current record you are on. 

Date and Agent who added and last updated record 
On the bottom left of each contact record CRM will 
display who added the record to the system and when, 
as well as who last updated the record and when. 

Current time at this companies location 
On the bottom right of the contact record CRM displays 
the actual time where ever this contact is located. 

Contact Address Panel 
The address panel displays the contact address information. You 
can also set flags for do not call, fax, mail and/or email. The 
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primary tab displays the contacts name, title, company and 
address information. (Figure 4-2) 

 
Figure 4-2: Contact address tab 

The company tab displays the information about the company 
the contact is linked to. You can Double-Click inside the 
company tab to go to the actual company record. (Figure 4-3) 

 

Figure 4-3: Contact company tab 

Contact Info Panel 
CRM contains six different contact types. To add a contact to a 
category just check the box(es) in front of the categories they 
are part of  (Figure 4-1 ). It is possible for a contact to be 
associated with multiple categories. Figure 4-5 shows the 
different contact classifications. 

 
Figure 4-4: Contact categories 

User Fields / Logical Fields 
Each of the five main contact types contain a tab for User Fields 
and Logical Fields. These are user definable fields that allow you 
to track any information about that specific type of contact you 
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want. You can modify the labels for the fields to suit your needs. 
For more information on modifying the field names see the 
section in this user manual on field names. 

Investors 
If the contact is a potential purchaser of commercial real estate 
they should be marked as an Investor. This allows you to quickly 
get a list of possible candidates for a property you are selling. 
This setting also tracks people who currently own properties 
and how many properties they own. 

The Investor section for each contact contains five separate tabs 
to track specific information about what their interests are. 

To see the tabs Click on the Investor tab just below the contact 
categories then Click one of the specific five tabs under the 
investor category. 

Product 1 / Product 2 
The Investor tab contains two sub tabs for tracking the products 
this contact is interested in purchasing as well as the price range 
they are interested in. 

 
Figure 4-5: Investor product tabs 

On this first tab (Figure 3-6) you can define purchase criteria 
for Office, Industrial, Retail and Land. On the second tab you 
can track Multi-Housing, Hotel and two others. All eight of these 
types are user definable. Next to each of these are fields to 
track the contacts minimum and maximum purchase 
requirements. 
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In the example above CRM utilizes the pop-up table for each 
field to define two letter codes for specialty interests. For more 
information on pop-up tables see Chapter Eight Pop-up Tables. 

For example in the Office field you can see four, two letter 
codes for this contact; EI, HI, QA, QU. Those codes represent 
specific product types that were defined in CRM and loaded into 
the pop-up table for that field. Figure 3-5 shows you an example 
of some codes you might use to classify office buildings and 
what they stand for. You could enter the actual full description 
but it would be much tougher to view multiple values that way. 

Since CRM allows you to query a field for ‘contains’ you can ask 
for all the investors who purchase high-rise office buildings 
using this method. The key is to make sure all your codes are 
two letters and that every code for a field is unique to that field. 
For more information on pop-up tables please read the chapter 
on Pop-up Tables. 

Buyer Info Tab 
On the buyer info tab (Figure 4-7 ) you can track generic 
information about the investor. 

 
Figure 4-6: Buyer info tab 

Min price: This is the minimum the investor will purchase 

Max price: Maximum investor typically will spend 

Max age: Maximum building age limits an investor will 
purchase 

Purchase: Information on the last purchase made by this 
investor 
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Areas: The areas where this investor will purchase  

Geographic: Further breakdown on purchase locations 

Hold 
period: 

Number of years the investor tends to hold 
properties 

Invest type: Pension fund, Private investor, REIT etc. 

Reference: Where you got the information about this 
investor 

No props: Number of properties this investor owns. 

Tenants 
From this tab you can track all the information about an existing 
tenant or the requirements for a tenant in the market. Use this 
tab to track lease information for a company, owner-users and 
companies looking to move. 

Using the Tenant section of the contact record you can easily 
locate all the companies looking for a particular type, size and 
space location. You can also quickly get a complete list of 
expiring leases and locations of particular business types.  

The Tenant section contains five separate tabs to track specific 
information about their current situation as well as their future 
interests. 

To see the tabs Click on the Tenant tab just below the contact 
categories then Click one of the specific five tabs under the 
tenant category. 

Below is a breakdown of each tab in the tenant section: 

Tenant Space Tab 
This tab displays the building the tenant occupies, the suite and 
floor information for the space. You can also move a tenant in 
or out of a space from this tab.  (Figure 4-8) 
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Figure 4-7: Tenant space tab 

To move a Tenant into an existing space: 
1. Locate the tenant record. 

2. Click the Space tab. (Figure 4-8) 
3. Click the Move In… button. 
4. From the Select Space dialog set the vacant filter at the 

bottom of the prompts to Yes. 

5. Enter the information to help you list vacant spaces. 

6. Click Search. 
7. In the list window highlight the space to move this 

tenant into and Click OK. 

NOTE: You cannot move a tenant into an occupied space until 
you move the existing tenant out of that space. 

To move a Tenant out of a space: 
1. Locate the tenant record. 
2. Click the Space tab. (Figure 4-8) 
3. Click the Move Out…. button. 

Changing the Suite or Floor information in the Space tab will 
change the information on the actual space record. It is 
recommended that you make changes to the space from the 
property table on the space tab to maintain database integrity. 

Go To Space or Property 
If you would like to quickly jump to this tenant’s property 
record or space you can Right-Click in the box surrounding the 
property and space information on the Tenant Space tab and 
select Go To or from the Record menu you can select Go To. 
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Tenant Lease Tab 
The space tab tracks a tenant’s lease information. (Figure 4-9) 

 
Figure 4-8: Tenant lease tab 

Lease comm: Date the tenant’s lease started. 

Lease exp: Date the tenant’s lease expires. 

Lease term: Length of the lease in months. 

Lease type: NNN, gross, modified gross etc. 

Sq Ft: Square footage of the tenant’s lease. 

Rent/Sq Ft: Amount per square foot tenant pays. 

Rent/month: Monthly rent. 

Effective rent: Effective rent paid over the entire lease. 

Increases: Rent increases as written in the lease. 

Options: Any options the tenant has. 

CAM: Common area maintenance charge. 

TIA: Tenant improvement allowance paid. 

Tenant Business Tab 
The business tab tracks specific information about the tenant. 
Use this to qualify the tenant for future searches. (Figure 4-10) 

 
Figure 4-9: Tenant business tab 

Business Use the pop-up table to consistently enter the 
Page 78 



Chapter 4 

Type: business type. For more information on pop-up 
tables see the chapter on pop-up tables. 

Employees: Number of people employed at this location. 

Founded: Year the company was founded. 

Units: Number of units per year. 

Sales: Total annual sales. 

Rating: Set up some rating system for tenants such as 
AAA or Credit and rate the tenant here. 

SIC Codes: Use the pop-up tables to enter the correct SIC 
code for a tenant. 

CPI: Corporation, Partnership or Individual. 

Tenant Requirements Tab 
The requirement tab tracks what a tenant is looking for. If you 
have a tenant in the market or someone who is looking to 
expand or downgrade you would enter that information in this 
tab. (Figure 4-11) 

 
Figure 4-10: Tenant requirement tab 

Min sq ft: Minimum square footage needed. 

Max sq ft: Maximum square footage needed. 

Office sq ft: Amount of office square footage required. 

Lot size: Land needed by tenant. 

Clearance: Minimum clear height needed by tenant. 

Dock doors: Number of dock doors required. 
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Grade doors: Number of grade doors required. 

Power: Power requirements for tenant. 

Location: Preferred locations tenant wants. 

Buy/lease: Is tenant interested in buying or leasing? 

Timing: Estimated timing for move. 

Other: Miscellaneous info you want to add. 

 

Agents 
Use the agent section of the contact record to track information 
about other real estate agents. You can specify the agents’ 
specialty as well as areas they concentrate on. (Figure 4-12) 

You can also link agents to deals they are involved in. 

Using the Agent section of the contact record you can easily 
locate all the agents in a particular specialty or company and 
using the CRM report engine you can track deals agents are 
doing. 

Below is a breakdown of each tab in the agent section: 

Agent General Tab 

 
Figure 4-11: Agent general tab 

Area: Area this agent focuses on. 

Listings: Existing listings agent has. 

Reference: Where you got the information on this agent. 

Other: Miscellaneous info you want to add. 
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Check boxes: Mark what each agent specializes in. 

Vendor 
The vendor table stores information about all the companies 
and individuals you do business with that support your deals. 
Examples of vendors would be title companies, escrow 
companies, accountants, attorneys and plumbers. (Figure 4-13) 

The vendor table makes it easy for you to track which vendors 
performed and which ones didn’t. This table also gives you a 
quick list of occupations when you are looking for help on a 
deal. Below is an explanation of the vendor section: 

Vendor General Tab 

 
Figure 4-12: Vendor general tab 

Business: Vendor’s business type. This is a field that 
should be tied to a pop-up table. 

Keywords: Any description to help you find this vendor. 

Rate: Billing rates. 

Areas: Areas this vendor works. 

Quality: Rating of the quality for this vendor. 

Contract date: Date vendor started work on current job. 

Personal 
The personal tab tracks generic information about the contact. 
This tab applies to both your friends as well as general 
information about the contact. Below is an explanation of the 
personal section: (Figure 4-14) 
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Personal General Tab 

 
Figure 4-13: Personal general tab 

Business: Line of work. 

Keywords: Words that make it simple for you to find this 
contact.  

Assistant: Name and extension of assistant. 

Spouse: Significant other. 

Other info: Miscellaneous info you want to add. 

Prospects  
The prospect contact-type is used for any prospective clients 
that you do not currently do business with, but think that you 
may in the future. There are no fields specific to prospects, as a 
prospect will still fall into one of the other main categories. 

Managing Contacts 
Since all contacts are stored in the same table in CRM you 
should be able to eliminate duplicate entries. You want to try 
and keep all communication with a contact in one place so 
everyone talking to that contact is in sync with the rest of the 
team. 

By using a single point of entry for each contact you can easily 
see which contacts are being neglected as well as which ones 
require the most attention. You can also see trends in your 
contacts and it is much easier to manage one record for a 
contact. 

In the examples below we illustrate three ways to add a contact 
to CRM. We suggest you read each one as they all have uses 
depending on your goal at the time. No matter which one of the 
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methods outlined below you use, we strongly suggest you start 
by using Global Search to make sure the contact is not already 
in CRM. 

Remember when using F12 (Global Search) that people often 
make mistakes when typing information into your system. For 
detailed information on using F12 see Chapter Twelve Contact 
Search. Armed with this information you can use F12 wisely to 
help you find the contact even if they are misspelled. 

Adding a single contact and new company 
1. Press F12 to bring up the Select Contact screen. 

2. Type in enough information to query the database and 
make sure the person you are entering is not already in 
the table.  

3. If you don’t find the contact already in your database 
click the new button to add the contact. (Figure 4-15) 

4. Enter the contact information. 
5. Enter the company information. 

6. Click OK to save the record. 

7. Answer Yes to the question ‘Would you like to create a 
new company record for this contact?’. 

8. CRM will prompt you with the Company Details dialog. 

9. Enter the company information and Click OK. 

10. CRM creates both the contact record and the company 
record and links them together. 
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Figure 4-14: Contact details window 

Adding a contact to an existing company 
1. Click the Search button or press F12 to bring up the 

Select Contact screen.  
2. Type in enough information to query the database and 

make sure the person you are entering is not already in 
the table.  

3. If you don’t find the contact already in your database 
Click the New button to add the contact. (Figure 4-15) 

4. Enter in the contact information. 

5. Pull down the With combo box under Address and 
choose Select Company. (Figure 4-16) 
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Figure 4-15: Select company dialog 

6. Type in enough of the company to find it and select it. 
7. Click OK to link the contact to the company. 

8. Enter the rest of the contact information. 
9. Click OK to save the contact. 

Adding multiple contacts 
1. Press Alt+ F12 to bring up the Select Company screen. 

(Figure 4-16) 
2. Type in enough information to locate the company the 

contacts belong with. If the company does not exist Click 
New to add the company. Read the company chapter for 
details on adding a company record. 
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3. Select the correct address on the company Org Chart 
tab. 

4. Click the Add Contact button. (Figure 4-17) 

 

Figure 4-16: Company record screen 

5. CRM will create a new contact record, link it to the 
company record and fill in all the information from the 
company record it can. 

6. Make any changes to the record needed and Click OK. 

Alternate contact information 
The alternate tab allows you to add an unlimited number of 
addresses to the contact as well as phone numbers and email 
addresses.  

Adding alternate addresses 
1. Find the contact you want to edit. 

2. Double Click in the address section to get the Contact 
details screen. (Figure 4-18) 
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Figure 4-17: Contact details screen 

 

Figure 4-18: Contact alternate details screen 
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3. Click the Alternate Tab 

4. Click the Add button. (Figure 4-19) 
5. Enter the alternate address information in the bottom 

half of the contact details screen. 
6. You can keep pressing the Add button and create as 

many alternate addresses as you want for each contact. 
7. Click OK to save the alternate contact information. 

 

You can also mark one of these addresses as the Primary and/or 
Mailing address.  

Mailing Address 
Marking an address as the mailing address tells CRM when you 
do a mail merge to use that address. Only one address can be 
the mailing address and by default it is the company address. 

Primary Address 
Marking an address as the primary address will force it to 
display in the contact window with the contact information. 
Only one address can be the primary address and by default it is 
the company address. 

Adding an alternate address 
To add another address, click the Add button and fill in the 
information. 

Removing an alternate address 
To remove an alternate address highlight it in the window and 
click remove. 

Adding alternate phone numbers/emails 
1. Scroll to the bottom of the phone/email list. 
2. Click in the description column and enter the 

description. 
3. Click in the phone/email column and type in the value. 
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4. Press Enter when finished to save the new entry. 

5. Click OK to save the alternate contact information. 

Deleting alternate phone numbers/emails 
1. If you see a pencil icon (Figure 4-20) in the window that 

means you are still in edit mode. To get out of edit mode 
press ESC or ENTER. The pencil will change to an arrow. 
(Figure 4-21) 

 
Figure 4-19: Edit mode on alternate grid 

2. Click in the first column to the far left of the entry you 
want to delete (on the arrow). (Figure 4-21) 

 

Figure 4-20: Deleting alternate entries 

3. Press the DEL key on your keyboard to delete the entry. 

4. Click OK to save the alternate contact information. 

Editing alternate phone numbers/emails 
1. Click in the field you want to change. 
2. Make your changes. 

3. Press Enter to save the changes. 

4. Click OK to save the alternate contact information. 

Editing a contact 
To edit a contact, open the contacts table and open the record 
for the contact you wish to edit. If you want to edit the 
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information other than the contact details, simply change the 
information. To edit the contact information (for example the 
contact’s address) either Click the Edit button, Double-Click on 
the contact information, or press {CTRL+Alt+E}. This will 
bring up the Contact Details dialog. Make any necessary 
changes in this dialog and Click OK. 

Address Standardization 
It is extremely important that you follow some standards when 
you are entering contact information. Before you start entering 
any data, draw up a set of rules and then pay attention when 
you enter contact information that you follow those rules. 
When you go back later to search you'll be glad you did. Here 
are some examples of pitfalls people fall into and then years 
later have to climb their way out of. 

Punctuation 
With the exception of the hyphen in the ZIP+4 codes, 
punctuation should be omitted in the contact information line. 

Directionals 
Abbreviate directionals to the appropriate one- or two-
character abbreviation (i.e. N, S, E, W, NE, NW, SE, SW). This 
rule applies to both pre directional fields and post directional 
fields. 

Two Directionals 
When two directional words appear consecutively as one or two 
words, before the street name or following the street name or 
suffix, then the two words become either the pre- or the post 
directionals. Exceptions are any combinations of NORTH-SOUTH 
or EAST-WEST as consecutive words. In these cases the second 
directional becomes part of the primary name and is spelled out 
completely in the primary name field. 
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Directional as Part of Street Name 
When parsing from right to left, if the directional word appears 
between the street name and the suffix, then it appears as part 
of the primary name spelled out in the ZIP+4 File and is spelled 
out on the mail piece. 

Secondary Address Unit Designators 
Always spell out all secondary designators, (i.e. Apartment, 
Building, Floor, Suite, Unit, Room, Department). Avoid using the 
pound sign (#) but if you must use it remember that the post 
office requires a space between the pound sign and the number 
such as 425 Flower Boulevard # 72. 

Dual Addresses 
Avoid dual addresses, they only confuse the post office. If you 
need to track a secondary address use the alternate address 
feature in CRM. 

City Names 
Spell city names in their entirety. 

States 
Use the accepted two letter state abbreviations. 

Zip Code 
Any time it is possible enter the zip+4 codes. Always try to enter 
at least the standard 5-digit zip code 

Company Name 
The one tricky situation in company names is the word "THE" as 
in "The Capital Corporation". In Realnex CRM, if you add “;The” 
to the end of a company name, when you use the company 
name for mailings and such, it will print out with “The” 
preceding the company name. This assures that the company is 
still easy to search for and that the company name appears as it 
should for all correspondence with that company. i.e. Jones 
Company; The. 
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Full Name 
The full name should contain the Salutation, First, Middle, Last 
and Suffix (i.e. Mr. John H Barleycorn CCIM) 

Greeting 
The greeting is a very important field that is often overlooked 
because it is misunderstood. This is the field that is used when 
you address an email to the client or in a letter. The value in this 
field is placed next to the Dear section. This allows you to refer 
to the person in a friendly manner as opposed to the formal 
method. It is important to note however that when you search 
for a contact by name, CRM will look for the name that is in the 
Full Name section NOT the greeting line.  
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Properties 
Overview 
The properties section is the heart of CRM, and this section 
along with its relationship with the other tables is what sets 
CRM apart from other programs. This section allows you to 
track properties, spaces, and units, link each property to its 
respective owner, tenant or agent, create sales and lease 
comparables, create professional-looking flyers, and keep track 
of all marketing opportunities for a given property. The 
hierarchy for the properties section is as follows: 

 

Chapter 

5 

Property 

Units 

Spaces 

Sale Comp 

Tenants 

Lease Comp 

Units 
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Sale Comps, Spaces and Units are linked to the property. 
Tenants and Lease Comps are linked to the spaces and property. 

To view properties open the View menu and select Properties 
and then Properties again. 

Property Screen Breakdown 
The property window (Figure 5-1) is split into four panels: 
Address, Property Info, Lists and Status.  

If you are tracking apartments or hotels you can link the units to 
each property record or for other property types you can link 
spaces to the property. This gives you complete flexibility no 
matter how many spaces or units are involved. 

 
Figure 5-1: Property main screen 

Property and Contact Address Panel 
Displays address information for the physical building or 
piece of land, a property manager or onsite contact, 
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attached owner, as well as a spot for an agent. For a 
complete explanation see the Property Address Panel in 
this chapter. 

Amenities and Contact Phone Number 
This section displays the amenities for a property when 
the Site tab is selected and the phone numbers and ‘Do 
Not’ fields when a Contact tab is selected. 

On Market Status 
Use this area to mark and query for properties that are 
for sale or for lease. This section also is used to track the 
property type. 

Property Detail Tabs 
These tabs allow you to break down the property by any 
criteria you find important. You can also view all the 
spaces and units from this section as well as listing 
information. 

Property Details 
Once you select a property tab (4) this section will 
display with relevant fields or secondary tabs detailing 
the break down information. 

Property Lists Panel 
Depending on the tab selected you can view all events, 
history, links, attachments and notes for this property. 

Status Panel 
The status panel gives information about the record 
owner, team that can view and edit this record, as well 
as information about what groups this property belongs 
to. 

Verify Button 
Use this button to time and date stamp when you last 
confirmed the information for this property. 
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Groups this property is a member of 
This window shows you the groups the property 
currently belongs to and it allows you to change those 
groups. 

Order of Property Table (Sort Order) 
You can sort the property records in any order you want 
using this section. The current property order will be 
listed in the window. For more information on sorting 
records see Sorting Records. 

Property Filter (Query) 
This section allows you to filter or query the property 
table for specific criteria. You can limit your database to 
specific property types using this section. For more 
information on sorting records see Querying Records. 

Total records and current record 
On the property toolbar you can access commonly used 
functions such as adding, deleting and printing a record. 
You can also move through the database using the arrow 
keys on this toolbar and you can see how many records 
you have available to you in the contact database as well 
as the current record you are on. 

Date and Agent who added and last updated record 
On the bottom left of each contact record CRM will 
display who added the record to the system and when, 
as well as who last updated the record and when. 

Property Image 
Displays a thumbnail of the default image attached to 
the property. Double Click on the thumbnail to display an 
enlarged view of the image. 

Property Website 
Add the properties website and you can Click the globe 
in front of the website to go directly to the link. 
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Address  
The address panel can be re-sized by clicking on the bottom of 
the panel and dragging it up or down. You can hide the address 
panel by clicking in the top left corner of the panel and you can 
re-display it by clicking in the same spot. The panel is split up 
into the following four tabs: (Figure 5-2) 

 

Figure 5-2: Property address panel 

Amenities, Site, Owner & Agent tab 
You can view the property name and address information in the 
window on the left. 

You can add, edit and remove amenities in the window on the 
right. The amenities window can hold many more entries than 
will fit on the screen so you can use the scroll bar on the right of 
the window to move through the items in the list. 

Adding amenities 
1. Scroll to the bottom of the amenity list. 

2. Click in the description column and enter the 
description. 

3. Click in the amenity column and type in the value. 
4. Press Enter when finished to save the new entry. 

5. Save the Property record by clicking the Save icon. 

Deleting amenities 
1. If you see a pencil icon (Figure 4-20) in the window that 

means you are still in edit mode. To get out of edit mode 
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press ESC or ENTER. The pencil will change to an arrow. 
(Figure 4-21) 

 
Figure 5-3: Edit mode on alternate grid 

2. Click in the first column to the far left of the amenity you 
want to delete (on the arrow). (Figure 4-21) 

 

Figure 5-4: Deleting alternate entries 

3. Press the DEL key on your keyboard to delete the entry. 

4. Save the Property record by clicking the save icon. 

Editing amenities 
1. Click in the field you want to change. 
2. Make your changes. 

3. Press Enter to save the changes. 
4. Save the Property record by clicking the Save icon. 

Site Contact | Owner | Agent Tabs 

 
Figure 5-5: Property contact tabs 
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These three tabs contain linked information to contacts in your 
table. You can track the contact information for a property 
manager or site manager, primary owner and listing agent as 
well. 

You cannot change the fields under the contact tabs as that 
information must come from the contact database.  

You can Click the link in the window under any of the three 
contact tabs and CRM will load that contact or company record 
for you so you can make changes. Changes made to a contact 
will automatically be reflected on all the records that person is 
linked to. For more information, see Adding a Property. You can 
click the email link to email, or the web page link to jump to the 
contacts webpage. If you have an auto dialer setup you can click 
the phone number to dial the contact. 

 

Property info panel 
At the top of the panel is a field that tracks the property type. 
You should always fill this section in. You cannot add property 
types to this window you can only select pre-defined types. To 
change the list of property types open the Tools menu and 
choose System tables and then Property Types. For detailed 
information on adding property types see the chapter in this 
manual on Tools. 

If the property is for sale or for lease check the appropriate box.  

 

Figure 5-6: Property marketing section 

The property info panel contains six tabs. The panel can be 
resized like the address panel. 
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General Tab 

 
Figure 5-7: Property general tab 

This tab contains information common to most properties. 

Details Tab 

 

Figure 5-8: Property unit tab 

This tab contains specific property type information. These 
include industrial, retail and land specific details. 

Units Tab 

 

Figure 5-9: Property unit tab 

This tab contains a list of the unit information. You can Double-
Click on any column heading to sort the information by that 
column. If you Double-Click inside the window you can edit the 
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information for the units. For more information on editing a 
property see the section below on adding a property. 

Spaces Tab 

 

Figure 5-10: Property spaces tab 

This tab contains a list of the spaces in the property. You can 
Double-Click on any column heading to sort the information by 
that column. If you Double-Click inside the window you can edit 
the information for each space. CRM allows you to track vacant 
spaces as well as occupied spaces and you can hook tenants 
from your contact table to their spaces. For more information 
on editing a property see the section below on adding a 
property. 

You can Right-Click on a tenant in the spaces tab and choose go 
to Tenant to view the complete tenant record. 

You can Click the Record menu and select go to Tenants to open 
a contact window that contains only the tenants linked to that 
property. 

Listing Tab 
This section is separated into the following three tabs: 

For Lease Tab 

 
Figure 5-11: Property for lease tab 
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This section of the property record tracks generic information 
about leasing information for the property. For specific 
information use the spaces tab. 

For Sale Tab 

 
Figure 5-12: Property for sale tab 

This section tracks the offered sale price and proforma 
information. You should fill in this section just as the property 
shows on the listing sheet. You can uncheck the Auto-calc 
button if you want to enter calculations by hand. 

What If Tab? 

 
Figure 5-13: Property listing what if tab 

If you want to do a quick evaluation for a potential buyer this 
tab is extremely useful. In a matter of seconds you can give an 
interested buyer an educated evaluation of his return on 
different price scenarios. Enter the price, down payment, base 
rent or income, expenses and loan information and get all the 
results immediately. 
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User Fields 
These are 12 fields designed to be customized to track 
information that CRM doesn’t already track. 

Logical Fields 
These are 24 checkboxes that are designed to be customized to 
fit the needs of the user. 

Lists Panel 
The lists section contains eight tabs: 

Events Tab 

 

Figure 5-14: Property events tab 

The events tab shows activities that are scheduled but have 
never been completed. Typical events are things like phone 
calls, meetings, tours or proposals. You can schedule these for 
multiple users and can set alarms for each event individually. 

Projects Tab 

 

The project tab shows links to any project that this property is 
linked as a listing and it also shows projects that this property is 
linked as a lead. The property would be a lead if it fulfilled a 
listing request such as a property that fit an investor’s needs. 
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Leads Tab 

 

The Lead tab will display all the leads that are interested in this 
property. Anytime you link a lead to a project and the property 
is linked as the listing those leads will show up on this tab. 

History Tab 

 

Figure 5-15: Property history tab 

The history tab shows completed events such as phone calls 
tours, offers, meetings and other activities. This should be a 
complete listing of everything you have ever done regarding this 
property. Using the history record you can create a marketing 
report showing an owner or tenant the history regarding this 
property. 

Links Tab 

 

Figure 5-16: Property links tab 
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The links tab allows you to view and navigate between all of the 
records linked to the current property. Links would include 
things such as owners, sale comps, lease comps, agents, sellers, 
and tenants. 

You have total control over what shows in the description line 
for each link. 

Attachments Tab 

 
Figure 5-17: Property attachment tab 

This tab shows auxiliary files that are used to evaluate the 
property. These might be graphic files such as pictures, plot 
maps or renderings. You might also attach a proforma or 
analysis file, scanned documents or other files. You can add 
attachments by dragging and dropping them into this folder or 
Right-Click. 

Notes Tab 

Figure 5-18: Property notes tab 

The note tab is for comments. For the property record this is 
best used to describe the property so you can have a summary 
on reports. The note tab can be used for anything you want but 
be careful; this field should not be used in lieu of history. 
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Creating a Property Record 
1. Click the Search button on the tool bar and click Property 

or press Shift – F12. (Figure 5-19) 

 
Figure 5-19: Property global search dialog 

2. Enter as much information on the property as you need 
to make sure it is not already in the database. This dialog 
allows you to enter partial information to find a 
property. For example if you know the property name 
contains the word Business and it is on Girard you can 
put “Business” in the Property field and “Girard” in the 
Address field. 

3. Click Search. CRM looks for matching properties already 
entered into CRM. If it finds any, it displays them in the 
lower half of the window where you can review each to 
see if in fact they are a match to the one you were 
planning to add. If you see a dialog box with the 
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message, “No records match your criteria” then go to 
step 4. 

4. Click the columns button to select the columns that 
display in the result set. 

5. Click OK and then New. (Figure 5-20) 

 
Figure 5-20: New property details screen 

This section is used to enter the information about the physical site; 
the property name, street address, city, state and zip code and to 
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allow you to search your contact or company database for the 
contact or company to associate with as a Site Manager, Owner or 
Agent. 

6. Enter as much address information as you can. Doing so 
saves time later when you are searching CRM for 
particular properties. 

7. To associate this property with a contact such as a 
property manager, owner or agent, pull down the 
correct list in the Contacts frame and Click the Select 
Contact/Company option.  

8. The Select Contact/Company window appears. Select 
the correct tab depending on which you want to 
associate and enter the information to find the correct 
record. If there is a match, CRM shows them and you can 
Click it to make the link. If there is no match, you can 
Click New to create the new contact/company.  Notice 
the Select Contact window has a filter section. By default 
CRM will set the filter to the contact type you are setting. 
For example, if you are setting the Owner CRM will filter 
the contacts database and only look at Contacts marked 
as Investors. You can change the filter but to keep data 
integrity if the contact is an owner they should be 
checked as in investors. Agents should be marked as 
Agents. Everyone is a contact so there is no mark for 
that.  

NOTE: It is important to establish a protocol for entering 
properties. Standardizing data entry will make it easier for 
everyone. 

Finishing the Property Record Entry 
Afew more important entries should be made on every new 
property record. Before getting to that, you should be aware 
that the screens in CRM are divided into frames. The frames can 
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be resized by dragging them up or down. This will hide or reveal 
more of each frame on the screen. In the middle section you’ll 
see the label Property Info with a down arrow. This is an 
example of a spot that can be resized by each user. 

In the Property Type field, right below the Property Info 
heading is a pull down menu. Use the pull-down list to identify 
what type of property you have entered. Next, indicate if the 
property is For Sale or For Lease. 

Deleting a Property 
Clicking the delete button  removes the property and all the 
supporting information for that property such as History, 
Events, Links and Notes. CRM will not remove the records that 
are linked to the property such as contacts but it will remove 
the link between the two records. 

Units 
The Units table stores information about the units for 
properties such as multi-family or hotels. It allows you to have a 
separate record for each of the unit types, mix, square footage 
and rent/square foot.   

 To access units, from the Property Database: 

1. Find the property you wish to view, edit or add units to. 
2. Open the View menu and select Property Units or Click the 

Units tab and Double-Click the area under the tab to 
display the Property Units window. (Figure 5-21)  
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Figure 5-21: Property Spaces detail window 

3. Click the New button to start a new unit entry. All details 
on the unit(s) are entered at the bottom of this window. 
In the Layout section enter the data pertaining to the 
physical structure. In the Financial fields enter the 
financial data. If there are amenities, add each in the 
Amenities section.  

4. Click the Save button to add the new unit. 
5. Click the X in the upper right corner of the Units window 

to close it and return to the Property Record.  

Spaces 
Each building should also contain at least one space; you need 
to identify each. To enter spaces for a building you have to open 
the Spaces window: From any property record:  

1. Open the View menu and select Property Spaces or Click 
the Spaces tab and Double-Click the area under the tab 
to display the Property Spaces detail window. (Figure 
5-22) 
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Figure 5-22: Property Spaces detail window 

2. Click the New button to start a new space entry. 
3. If there is a tenant in the space, Click the drop down at 

the right edge of the Tenant field and Click Select 
Contact. Use the Select Contact dialog to locate the 
tenant record and Click on it. Click OK. The tenant is 
added to the space. 

NOTE: A tenant can only be attached to one space. You must 
move a tenant out of a space before you can move them into a new 
one. You can move a tenant out of an existing space from the 
contact record. 

4. Enter the space details.  

5. Click Save after you have entered all the spaces.  
6. Click the X in the upper right corner of the Spaces 

window to close it and return to the Property Record.  
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Spaces are similar to any other type or record in CRM. That 
means you can query, sort and add them to groups. You can 
also link any other type of record to spaces.  

Sorting Properties 
The Sort box shows and allows you to change the order of the 
records that are currently visible. Each time you use the lookup 
menu to find a contact the Sort menu will change to the fields 
that match that lookup order. The drop down combo box will 
also remember previous sort orders making it easy to switch 
back to a previous record order by clicking on the down arrow 
and choosing the order you want. For more information see 
Chapter Twelve, Finding Records. 

Creating a New Order 
Click on the down arrow on the right side of the Sort box. Next, 
choose Sort in the drop down list. In the sort dialog window, 
remove the fields from the selected list and add the fields you 
want the table sorted by. The table is sorted by the fields in the 
list, ordered by the fields. You can move the fields up or down in 
the selected window using the up and down arrow keys on the 
right. Click OK to sort the contacts. For more information see 
Chapter Twelve Finding Records. 
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Comparables 
Overview 
Tracking the history of a property or lease is done via the Sale or 
Lease comps databases. Using these separate tables you can 
create a picture every time a property sells, every time a space 
is leased, and every time a tenant moves. 

The records in these two tables are linked back to the original, 
property, buyer, seller, agents, space and tenant making it easy 
to get all the reports you need for your next deals. 

Sales Comps Overview 
The Sale Comps table is used to store data on sale transactions 
that have occurred in your market. The tracking of sale data 
allows you to know and justify the value of a property. 

If you want to know what the market value of a property is you 
can query the Sales Comps table for similar properties and see 
what they have sold for in the past. The Sale Comps table 
should be used in conjunction with the Property table and all 
Sale Comps should be added from the Property table.  

Chapter 

6 
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This benefits you in two ways. First, CRM will take all the 
applicable data from the Property record and place it on the 
new Sales Comp record.  

Second CRM will automatically link the Sales Comp to the 
Property record enabling you to display a sales history of the 
property. 

The hierarchy for the sale comps section is as follows: 

 

Sale Comps are linked to properties, you can also link units to 
sale comps. 

To view sale comps open the View menu and select Properties 
and then Sale Comps or press {Ctrl+Shift+K}. 

Sale Comps Screen Breakdown 
The sale comps window (Figure 5-1) is split into four panels: 
Address, Property Info, Lists and Status.  

If you are tracking apartments or hotels you can link the units to 
each sale comp record. 

Each sale comp should also be linked to the property table so 
you can quickly get all past sales information on a current 
property and it should be linked to the buyer, seller, procuring 
agent and listing agent. 

Property 

Units 

Spaces 

Sale Comp 

Tenants 

Lease Comp 

Units 

Page 114 



Chapter 6 

 

While linking the sale comps to each of these records is time 
consuming, the added information at your fingertips when 
looking at a contact or property is invaluable. By making the link 
to a contact you can see from that contact’s record every 
property they ever purchased or sold and immediately get 
complete details on that transaction. 

 

Figure 6-1: Sale Comps main screen 

Property Address Panel 
Displays address information for the property. 

Contact Information 
This section displays the company and address 
information for the contact tab selected. Double Click 
this window to edit the information or Right-Click to 
jump to the contact. 

Property Photo 
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Thumbnail view of the attached default property image. 
Double Click the picture to get a larger view of the 
image. 

Property Detail Tabs 
These tabs allow you to select detailed information 
windows regarding the actual property characteristics as 
well as the sale information. 

Property Details 
The information in this window corresponds to the tab 
selected in step (4). You can change the information 
located in this area and on the Sale tab you can do 
calculations. 

Lists Panel 
Depending on the tab selected you can view links, 
attachments and notes for this sale comp. 

Status Panel 
The status panel gives information about the record 
owner, team that can view and edit this record as well as 
information about what groups this property belongs to. 

Verify Button 
Use this button to time and date stamp when you last 
confirmed the information for this property. 

Groups this sale comp is a member of 
This window shows you the groups the sale comp 
currently belongs to and it allows you to change those 
groups. 

Order of Sale Comps Table (Sort Order) 
You can sort the sale comp records in any order you 
want using this section. The current sale comp order will 
be listed in the window. For more information on sorting 
records see in Chapter Twelve. 
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Property Filter (Query) 
This section allows you to filter or query the property 
table for specific criteria. You can limit your database to 
specific property types using this section. For more 
information on sorting records see Querying Records. 

Total records and current record 
On the property toolbar you can access commonly used 
functions such as adding, deleting and printing a record. 
You can also move through the database using the arrow 
keys on this toolbar and you can see how many records 
you have available to you in the contact database as well 
as the current record you are on. 

Date and Agent who added and last updated record 
On the bottom left of each contact record CRM will 
display who added the record to the system and when as 
well as who last updated the record and when. 

Address  
The address panel can be resized by clicking on the bottom of 
the panel and dragging it up or down. You can hide or unhide 
the address panel by clicking in the top left corner of the panel.  

 
Figure 6-2: Sale comp address panel 

Site window 
The site window contains the address information for the site as 
well as a section for property amenities.  
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You can view the property name and address information in the 
top window on the left. 

You can add, edit and remove amenities in the window on the 
right. The amenities window can hold many more entries than 
will fit on the screen so you can use the scroll bar on the right of 
the window to move through the items in the list. 

Adding amenities 
1. Scroll to the bottom of the amenity list 
2. Click in the description column and enter the 

description. 

3. Click in the amenity column and type in the value. 

4. Press Enter when finished to save the new entry. 
5. Save the Property record by clicking the Save icon. 

Deleting amenities 
1. If you see a pencil icon (Figure 6-3) in the window that 

means you are still in edit mode. To get out of edit mode 
press ESC or ENTER. The pencil will change to an arrow. 
(Figure 6-4) 

 
Figure 6-3: Edit mode on alternate grid 

2. Click in the first column to the far left of the amenity you 
want to delete (on the arrow).  

 
Figure 6-4: Deleting alternate entries 
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3. Press the DEL key on your keyboard to delete the entry. 

4. Save the Property record by clicking the save icon. 

Editing amenities 
1. Click in the field you want to change. 
2. Make your changes. 

3. Press Enter to save the changes. 
4. Save the Property record by clicking the Save icon. 

Amenities | Buyer | Seller | Agent Tabs 

 
Figure 6-5: Property contact tabs 

These five tabs contain information about the amenities and 
contacts involved in this transaction. The entries in this section 
can be automatically populated from your contact table but 
they are not a linked relationship. This means that changes you 
make in the future to contact records will not be reflected here. 

Unlike the property table you can change the fields under the 
contact tabs in the sale comps table.  

You can double Click in the window under any of the four 
contact tabs and CRM will open the Sale Comp Details window. 

Property info panel 
t the top of the panel is a field that tracks the property type. 
You should always fill this section in. You cannot add property 
types to this window you can only select pre-defined types. To 
change the list of property types open the Tools menu and 
choose System tables and then Property Types. For detailed 
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information on adding property types see the chapter in this 
manual on Tools. 

If the property is for sale or for lease check the appropriate box.  

 
Figure 6-6: Property marketing section 

The property info panel contains six tabs. The panel can be 
resized like the address panel. 

General Tab 

 
Figure 6-7: Sale comp general tab 

For fields such as construction type, condition and location you 
should use the pop-up tables. Create accepted entries in the 
pop-up tables and use them. You can set up fields so CRM 
forces users to pick values from the pop-up tables. This helps 
ensure that data is entered consistently by everyone on your 
team. 

Details Tab 

 

Figure 6-8: Sale comp detail tab 
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This tab contains detailed property information. Depending on 
the property type you will mix the fields needed. 

This tab contains a list of the unit information. You can double-
Units Tab 

 

Figure 6-9: Sale comp unit tab 

This tab contains a list of the unit information. You can Double-
Click on any column heading to sort the information by that 
column. If you Double-Click inside the window you can edit the 
information for the units. For more information on editing a 
property see the section below on adding a property. 

For Sale Tab 

 
Figure 6-10: Sale comp for sale tab 

This section tracks the offered sale price and proforma 
information. You should fill in this section just as the property 
shows on the listing sheet. You can uncheck the Auto-calc 
button if you want to enter calculations by hand. 

User Fields 
These are 12 fields designed for customization for tracking 
information that CRM doesn’t already track. 
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Logical Fields 
These are 24 checkboxes that are designed to be customized to 
fit the needs of the user. 

Lists Panel 
The lists section contains five tabs: 

History Tab 

 
Figure 6-11: Sale comp history tab 

The history tab shows completed events such as phone calls 
tours, offers, meetings and other activities. This should be a 
complete listing of everything you have ever done regarding this 
property. Using the history record you can create a marketing 
report showing an owner or tenant the history regarding this 
property. 

Links Tab 

 
Figure 6-12: Sale comp links tab 

The links tab allows you to view and navigate between all of the 
records linked to the current property. Links would include 
things such as owners, sale comps, lease comps, agents, sellers, 
and tenants. 
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You have total control over what shows in the description line 
for each link. 

Attachments Tab 

 
Figure 6-13: Sale comp attachment tab 

This tab shows auxiliary files that are used to evaluate the 
property. These might be graphic files such as pictures, plot 
maps or renderings. You might also attach a proforma or 
analysis file, scanned documents or other files. 

Notes Tab 

 
Figure 6-14: Sale comp notes tab 

The note tab is for comments. For the property record this is 
best used to describe the property so you can have a summary 
on reports. The note tab can be used for anything you want but 
be careful; this field should not be used in lieu of history. 

Creating a Sale Comp Record 
To create a sales comp from a property:  

1. Find the property record. 
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2. Open the Record menu and select Create Sale Comp or 
press {Ctrl+Alt+K}. 

CRM will create a new sale comp, and copy and link the 
information for you. 

To create a standalone sales comp record:  
1. Open the View menu and select Properties and from the 

submenu, Sales Comps. The Sales Comps window opens.  

2. Click the New Record button. The Sales Comp Details 
dialog opens. (Figure 6-15) 

 
Figure 6-15: Sale comp details window 

3. Click the pull-down at the far right of the Property field, 
and Click the Select Property option. The Select Property 
dialog box opens. (If the property is not in your CRM 
table, you can create a new property record by clicking 
the New button in the Search dialog. You may also enter 
a new Property directly into details dialog, but then it 
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will not appear anywhere else in CRM-not 
recommended.) (Figure 6-16) 

 

Figure 6-16: Select property dialog   

4. Enter enough information to locate the property.  

5. Click Search. CRM displays possible matches to the data 
you entered. If it finds an exact match, you are returned 
to the Sales Comp details dialog and all of the data in the 
property record are transferred. Otherwise you can 
highlight the property and Click OK. 

CRM will automatically create a link for you between the 
Property you selected and the Sale Comp making it easy for you 
to jump between the records. 
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6. Enter the Details, concomitant to this transaction, at the 
right top of the dialog. (Figure 6-15) 

7. Click the Buyer tab. (Figure 6-17) 

 
Figure 6-17: Sale comp buyer details screen 

8. At the far right of the Buyer field, Click the pull-down and 
Click Select Contact. The Select Contact dialog box 
opens. (If the contact is not in your CRM table, you can 
create a new contact record by clicking the New button 
in the Search dialog. You may also enter a new contact in 
the details dialog, but it will not appear anywhere else in 
CRM-not recommended.) 

9. Enter enough information in the Select Contact dialog to 
find the buyer.  

10. Click Search. CRM displays possible matches to the data 
you entered. If it finds an exact match, you are returned 
to the Sale Comp details dialog and all of the data from 
the contact record is transferred. 
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CRM automatically creates a link for you between the Buyer you 
selected and the Sale Comp making it easy for you to jump 
between the records. 

11. Follow the same steps as you did in the buyer tab for the 
Seller, Procuring Agent and Listing Agent. 

12. Before clicking OK, check the Record Owner and Team 
entries at the bottom left of the dialog. Change them as 
needed.  

13. Click OK, to save the Sales Comp.   
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Lease Comps Table 
The Lease Comps table is used to store data regarding lease 
transactions in your market. The tracking of lease transactions 
will allow you to know and justify what the market rents are for 
any given area. 

If you store your lease comps data correctly you will be able to 
query your Lease Comps table for lease transactions that have 
occurred in a specific area, during a certain time period, and for 
a desired building type. 

The Lease Comps table should be used in conjunction with the 
Spaces table and you should add your Lease Comps from the 
Spaces Table. This benefits you in several ways. First CRM will 
take all the applicable data from the space record and place it 
on the new Lease Comp record. Second CRM will create a link 
between the Space, Tenant and Property owner and the Lease 
Comp; third you will be able to display a lease history of the 
tenant or space. 

Adding a Lease Comp 
To create a lease comp from a space: 

1. Find the space. 
2. Open the Record menu and select Create Lease Comp or 

press {Ctrl+Alt+K}. 
CRM will create a new lease comp, and copy and link the 
information for you. 

To create a standalone lease comp record: 
1. Open the View menu and select Properties and from the 

submenu, Lease Comps. The Lease Comps window 
opens. 

2. Click the New Record button. The Lease Comp Details 
dialog opens. (Figure 6-18) 

Page 128 



Chapter 6 

 

 
Figure 6-18: Lease comp details window 

3. Click the pull-down at the far right of the Space field, and 
Click the Select Space option. The Select Space dialog 
box opens. (Figure 6-19) (If the space is not in your CRM 
table, you must create it first. See Chapter Five Spaces.) 
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Figure 6-19: Select space dialog 

4. Enter enough information to find the space.  
5. Click Search. CRM displays possible matches to the data 

you entered. If it finds an exact match, you are returned 
to the Lease Comp details dialog and all of the data in 
the space record are transferred. Otherwise you can 
highlight the space and Click OK. 

CRM will automatically create a link for you between the Space 
you selected and the Lease Comp making it easy for you to jump 
between the records. 

6. Enter the Details, concomitant to this transaction at the 
right top of the dialog. (Figure 6-18) 

7. Click the Lessee tab. (Figure 6-20) 
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Figure 6-20: Lease comp lessee detail screen 

8. At the far right of the Lessee field, Click the pull-down 
and Click Select Contact. The Select Contact dialog 
opens. (If the contact is not in your CRM table, you can 
create a new contact record by clicking the New button 
in the Search dialog. You may also enter a new contact in 
the details dialog, but it will not appear anywhere else in 
CRM–not recommended.) 

9. Enter enough information in the Select Contact dialog to 
find the lessee.  

10. Click Search. CRM displays possible matches to the data 
you entered. If it finds an exact match, you are returned 
to the Lease Comp details dialog and all of the data from 
the contact record is transferred. 
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CRM will automatically create a link for you between the Lessee 
you selected and the Lease Comp making it easy for you to jump 
between the records. 

11. Follow the same steps as you did in the lessee tab for the 
Lessor, Procuring Agent and Listing Agent. 

12. Before clicking OK, check the Record Owner and Team 
entries at the bottom left of the dialog. Change them as 
needed.  

13. Click OK, to save the Lease comp.  

Space info panel 

 

Figure 6-21: Space info screen 

Use the check boxes at the top of the panel to signify the type 
of space. You can check multiple types and you can set up the 
labels on the check boxes to match your line of business. You 
can only set up the labels once for the table. For more 
information on setting up field labels see the section in this 
manual on field labels. 

The section below defines the fields in this panel and explains 
their use within CRM: 

Floor The floor the space is located on. 
Suite The suite number of the space. 
Sq ft Total square footage of the space. 
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Lease comm. Date lease commenced if there is a tenant. 
Lease exp. Date lease expires if there is a tenant. 
Lease term Term of current tenants lease. 
Rent/sq ft Rent paid per square foot. 
Rent/month Rent paid per month. 
Effective rent Effective rent per foot over the lease term. 
Increases Rent increases over lease period 
Options Options tenant has on space 
TIA Tenant improvement allowance 
Lease type Expense reimbursement i.e. NNN, Gross 
Exp. Stop Expense stop year and amount if there is one 
CAM Common area maintenance cost 
Taxes Tax reimbursement per foot 
Insurance Insurance reimbursement per foot 
Usable sq.ft. Total useable square footage in space 
Load factor Load factor 
Frontage Road frontage (visibility) 
Percent rent Percentage rent 
Office sq.ft. Total office square footage 
Grade doors Total number of grade doors for space 
Dock doors Total number of dock doors for space 
Truck doors Total number of truck doors for space 
Clear height Total clearance 
Power Phase, amps, volts and wire for space 
Rail service Type of rail 
Yard Yard description 
 

User Fields 
These are 12 fields designed to be customized to track 
information that CRM doesn’t already track. 
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Logical Fields 
These are 24 checkboxes that are designed to be customized to 
fit the needs of the user. 

Lists Panel 
The lists section contains three tabs: 

History Tab 

 

Figure 6-22: Sale comp history tab 

The history tab shows completed events such as phone calls 
tours, offers, meetings and other activities. This should be a 
complete listing of everything you have ever done regarding this 
property. Using the history record you can create a marketing 
report showing an owner or tenant the history regarding this 
property. 

Links Tab 

 
Figure 6-23: Lease comp links tab 

The links tab allows you to view and navigate between all of the 
records linked to the current lease comp. Links would include 
things such as space, property, and tenants. 
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You have total control over what shows in the description line 
for each link. 

Attachments Tab 

 
Figure 6-24: Lease comp attachment tab 

This tab shows auxiliary files that are used to evaluate the 
property. These might be graphic files such as pictures, space 
layouts or renderings. 

Notes Tab 

 
Figure 6-25: Sale comp notes tab 

The note tab is for comments. For the property record this is 
best used to describe the property so you can have a summary 
on reports. The note tab can be used for anything you want but 
be careful; this field should not be used in lieu of history.  
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Tags 
Overview 
The tag feature makes it easy to mark individual records and then 
use them for merges and reports. For example if you had 6,000 
contacts in your database and you wanted to do a mass marketing 
campaign for a listing. You most likely would not want to market to 
all 6,000 so you would set a query to limit the contacts you could 
see. Once you set the query you might end up with two hundred 
contacts but at that point you would like to look at those 200 
people and choose which ones you actually market to. Using the tag 
feature you can individually decide which contacts you want to 
keep in your and which ones you want to get rid of. 

Tagging Records 
From a Complete Record 
Tagging/Un-tagging a Single Record 

 

Click the tag box on the toolbar, Click again to untag the record or 
from the Record menu choose Tag to check or un-check the record 
or use the accelerator key {Alt+Shift+G} 

Chapter 
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Tagging the Current Set of Records 

  

  

To tag all the records currently visible Click the drop down arrow on 
the tag toolbar and choose Tag All or from the Lookup Menu under 
the Tagged Records option choose Tag All. This feature will tag any 
records CRM can currently see so if you have set a query this option 
will only tag the records visible to that query. 

Clear Tags 
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Choosing this option will clear all the tagged records from memory. 
To clear all tags Click the drop down arrow on the tag toolbar and 
choose Clear Tags or from the Lookup Menu under the Tagged 
Records option choose Clear Tagged. This feature will clear all tags 
from memory regardless of any filter you have set. 

From the List Window 
Using the Tag Column 
  

  

The list window has all the capabilities listed above in the Complete 
Record section. The list window also has an enhanced feature to 
make it easy to tag multiple records. Using the check box column on 
the left you can Click and tag or untag single records. You can also 
use the windows {Shift+Click} option to select a group of records all 
at once. 

Selecting Contiguous Records 
1. Select the first record in the group by clicking on it. 
2. Hold down the {Shift Key} and Click the last record in the 

group making sure you Click on the check box column. 
3. You can either tag or untag a set of records this way. 
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Selecting Random Records 
1. Hold down the {Ctrl Key} and Click any records you want 

to select or un-select. 

Viewing Tagged Records 
You have multiple options when viewing tagged records. When 
viewing tagged records CRM respects any query that is currently set 
and a query will respect the tag setting as well.  

Displaying All Tagged Records 
1. First make sure you release any query 

set on your table {CTRL+R}. 
2. Next Click the drop down arrow on the 

tag tool button and choose Show 
Tagged or from the menu Click Lookup 
| Tagged Records | Show Tagged. 

 

Hide Tagged Records 
1. First make sure you release any query 

set on your table {CTRL+R}. 

2. Next Click the drop down arrow on the 
tag tool button and choose Hide 
Tagged or from the Lookup menu 
choose Tagged Records and Hide 
Tagged. 

 

Displaying All Records Regardless of Tag State 
 

1. First make sure you release any query 
set on your table {CTRL+R}. 

2. Next Click the drop down arrow on the 
tag tool button and choose Show All or 
from the Lookup menu choose 
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Tagged Records and Show All. 

Working with Tags inside a Query 
The tag feature will respect any query that is currently set. If you set 
a query in CRM and choose one of the display options above CRM 
will only show you the records that are contained in your current 
query. So for example if you had tagged 50 records in CRM and 
then set a query for City = San Diego. When you asked to see the 
tagged records CRM would only show you records that were tagged 
and in the City of San Diego. If you wanted to see all the tagged 
records you would need to remove the query set using {CTRL+R}.  

Clearing Tagged Records 
Clear Tags 

Choosing this option will clear all the tagged 
records from memory. To clear all tags Click 
the drop down arrow on the tag toolbar and 
choose Clear Tags or from the menu Click  
Lookup | Tagged Records | Clear Tagged. 
This feature will clear all tags from memory 
regardless of any filter you have set. 

 

Special List Window Feature 
From the List Window you can select a group of records to clear the 
tags from. 

1. Open the List Window {F5}. 
2. Highlight the first record in the group of records. 

3. Hold the {Shift key} and Click in the tag column of the 
last record you want to clear the tag for. 
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Saving Tagged Records 
You can save your tagged records for later use. Saving a tag record 
set will allow you to create a new group, replace an existing group 
or add to an existing group. 

Creating a New Group from a Tag 
1. From the tag tool button select {Save Tags} or from the 

menu Click Lookup | Tagged Records | Save Tags. 
2. Click Create a new group for these tags. 

3. Enter a Name for the group. 

4. Set the Owner and Team. 
5. Click {OK}. 

6. The tag set will be saved in the list of groups on the 
bottom left of your complete record screen. 

Replacing an Existing Group from a Tag 
From the List Window you can select a group of records to clear the 
tags from. 

1. From the tag tool button select {Save Tags} or from the 
menu Click Lookup | Tagged Records | Save Tags. 

2. Click Add tags to existing records in group. 

3. Select a Group from the pull down combo box. 
4. Click {OK}. 

5. The tag record set will be added to the existing members 
of the group you selected. 

Adding to an Existing Group from a Tag 
From the List Window you can select a group of records to clear the 
tags from. 

1. From the tag tool button select {Save Tags} or from the 
menu Click Lookup | Tagged Records | Save Tags. 

2. Click Tags replace contents of group. 
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3. Select a Group from the pull down combo box. 

4. Click {OK}. 

5. The tag record set will replace the existing members of 
the selected group. 

Reusing Saved Tags 
 

You can save your tagged records for later use. 
Saving a tag record set will allow you to create a 
new group, replace an existing group or add to an 
existing group. 

Adding an existing Group while keeping any currently tagged 
records 

 

1. From the tag tool button select {Save Tags} or from the 
menu Click Lookup | Tagged Records | Load Tags. 

2. Click Add group records to existing tags. 

3. Click {OK}. 
4. All the records in the group selected will be tagged. Any 

records that are already tagged will remain tagged. Any 
query that is set will remain set. Records that are 
included in the selected group will be tagged regardless 
of if they are in the current query or not. 
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5. To see all the tagged records first make sure you release 
any query you have set {CTRL+R} then Click Show 
Tagged from the tag tool button. 

 

Replacing any currently tagged records from an existing group 
1. From the tag tool button select {Save Tags} or from the 

menu Click Lookup | Tagged Records | Load Tags. 

2. Click Group records replace existing tags. 
3. Click {OK}. 

Any currently tagged records will be replaced with members of the 
group selected. Any query that is set will remain set. Records that 
are included in the selected group will be tagged regardless of if 
they are in the current query or not. 

To see all the tagged records first make sure you release any query 
you have set {CTRL+R} then Click Show Tagged from the tag tool 
button. 
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Pop-up Tables 
Overview 
Popup tables help make entering data faster and more 
consistent. Every field in CRM has the ability to use these tables. 
You can define the values that are stored for each character 
field and you can restrict a field to only using values from the 
pop-up table. This makes your data consistent eliminating 
invalid entries.  

Different field types have different pop-up helpers. For example 
if you are in a date field and you hit the pop-up hot key CRM will 
bring up a calendar to help you pick the correct date. If you are 
in a numeric field CRM will load up a calculator, and if you are in 
a character field CRM will load a list of default answers for the 
field. 

Although each field type has a special pop-up table, you always 
access it with the same keystroke, Alt – Enter. 

Updating a single entry character field 
1. Select a character field to update. 
2. Click in that field and notice the button that appears 
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3. Press Alt – Enter while in the field or Click on the button. 
This displays the pop-up table for the field. (Figure 8-1) 

 

Figure 8-1: Pop-up table 

4. Use the quick search to find the value you want. Quick 
search is automatic-just type the letters for the key you 
want. In the example (Figure 8-1) HB was typed to jump to 
Hotel Broker. 

5. Press Enter to select it. 

 
6. CRM automatically enters the value in the field. 

Updating a multi entry character field 
1. Select a character field to update. 
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2. Click in that field and notice the button that appears 

 

3. Press Alt – Enter while in the field or Click on the button. 
This will display the pop-up table for the field. (Figure 8-2) 

 
Figure 8-2: Pop-up table 

4. Use the quick search to tag the values you want. Quick 
search is automatic-just type the letters for the key you 
want, press the space bar to check the field, then type 
the next value and press the space bar.  In the example 
(Figure 8-2) CB was typed then [Space Bar], GO [Space Bar], 
MI [Space Bar]. 
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5. In multi-select field if you are not required to use the 
entries already in the pop-up table you can type in other 
entries using the Other field at the bottom of the 
window. If there are entries already in the field that are 
not in your list they will display in the Other field. You 
can Click the X to remove those characters from the 
field. 

6. Press Enter to select it. 

 
7. CRM automatically enters the values in the field 

separated by a comma. 

NOTE: To set up a field to use the pop-up tables Right-Click on 
the label of the field and Click Properties. For more information 
on setting field properties see Chapter Nineteen Field 
Properties. 

Updating a numeric field 
1. Select a numeric field to update. 

 

2. Click in that field and notice the button that appears 

 

3. Press Alt + Enter while in the field or Click on the 
button. This will bring up the pop-up calculator. (Figure 
8-3) 
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Figure 8-3: Pop-up calculator 

4. Type in or Click in your formula like you would on any 
calculator. In this example I’ll type in 2.5 * 43560 
(converting acres to feet) and press Enter or Click =. 

 
5. CRM automatically enters the value in the field. 

Updating a numeric field with a calculation 
1. Select a numeric field. 

  

2. Click in that field and notice the button that appears. 
Use the short cut keys to enter large numbers in the field. M 
(million), T (thousand), H (hundred). 

1M will convert to 1,000,000 
1T will convert to 1,000 
1M20T will convert to 1,020,000 

 

3. Enter the first number of your equation and press the 
operator on your keyboard. For example if you wanted 
to enter a down payment of 14% on a purchase price of 
$1.2 Million you would start by entering 1,200,000 (or 
use the CRM method 1M, for 1 Million, 200T for 200 
Thousand. 
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4. Press * (multiply) on your keyboard. (Figure 8-4) 

 
Figure 8-4: Pop-up calculator 

5. Type in .15 (fifteen percent) Enter. 

 
6. CRM automatically enters the calculation in the field. 

Updating a date field 
1. Select a date field to update. 

 

2. Click in that field 

 

3. You can use the CRM short cut keys to quickly get a date. 
T Today 
+ Increments date in field one day forward 
- Increments date in field one day backward 
W Converts date in field to First day of Week 
K Converts date in field to Last day of weeK 
M Converts date in field to First day of Month 
H Converts date in field to Last day of montH 
Y Converts date in field to First day of Year 
R Converts date in field to Last day of yeaR 
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4. Press Alt + Enter while in the field or Click on the 
button. This will bring up the pop-up calendar. (Figure 8-5) 

 
Figure 8-5: Pop-up calendar 

5. Click on the date you want. You can Click on the arrow 
keys at the top of the calendar or use [PgUp] / [PgDn] 
to change months. You can use [Ctrl–PgUp] / [Ctrl–
PgDn] to change years, and you can use the arrow keys 
on your keyboard to move around the grid. 

 
6. CRM automatically enters the date in the field. 

Adding Pop-ups to character fields 
1. Select a field to add pop-up values to. 

 

2. Click in that field. 

 

3. Press Alt +Enter while in the field or Click on the button. 
This will bring up the pop-up table. (Figure 8-6) 
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Figure 8-6: Pop-up table 

4. Click Edit Table and choose Add. 
   

Figure 8-7: Pop-up item window 

5. Type in the Key (search value) and the Value (entry that 
will be placed into the field when the user types the key. 

6. Click OK. 

Changing Pop-ups 
Highlight the pop-up you want to change and then Click Edit 
Table and choose edit. Make your changes and Click OK to save 
them. 

Deleting Pop-ups 
Highlight the field you want to delete then Click edit table and 
choose delete. You cannot restore the entry once deleted.  
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Pop-up Table Review 
Selecting Pop-ups 
You can either select a pop-up by highlighting it and pressing 
{Enter} or with the select button. 

Alt Enter 
To access the pop-up tables for a field, you can Click on the icon 
at the far right end of the field but if you want to save time you 
should use the accelerator key {Alt+Enter} to access the tables. 

Select Button [Also ENTER key] 

Clicking the Select button will replace the existing field with the 
value selected in the pop-up table. Any other information that 
was previously in the field will be replaced with the selected 
data in the pop-up table. 

Clicking the Add button will add the selection to whatever was 
already entered into the field. 

Quick Search the table by typing the letters of the key you want 
to find. If you mistype use the {backsapce} key to clear the 
letters or you {Ctrl+backsapce} to start over. There is an auto 
time-out feature on the search that shuts it off after a three 
second pause. 

Single Value Pop-ups: Click on the value you want to place in 
the field and press {Enter}. The field will be replaced with the 
new value.  

Multi Value Pop-ups: Check the box in front of the values you 
want to place in the field. Next Click {OK} to paste the data into 
the field. For information on setting up pop-up tables please see 
the CRM Setup section in this manual.  

Use the {SPACE} bar to check a value. Coupled with the quick 
search method you can type an abbreviation, Click {SPACE}, 
type another abbreviation Click {SPACE} etc.  
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Select Button {ENTER}  

Click the Select button to replace the existing field with the 
value selected in the pop-up table. Any other information that 
was previously in the field will be replaced with the selected 
data in the pop-up table. 
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Links 
Overview 
Links are a very powerful feature of CRM. This function allows 
you to create a dynamic link between records in CRM. For 
example you can link an owner to the property they own or a 
vendor to properties they maintain. Links are unlimited so it is 
possible to link someone to multiple records. 

You can Double-Click on a linked record under the link tab from 
a contact or property record and CRM will immediately take you 
to the full linked record.  

Creating a Link 
1. Locate one of the records you want to link. 

2. Click on the Links tab in the Lists window. 
3. Check to make sure the link you are creating is not 

already created. 
4. Press {Ctrl+K} or from the menu choose Record and 

Link or Right-Click in the Link window and choose Add. 
(Figure 9-1) 
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Figure 9-1: Create link window 

5. Change the Link From to the record type you want 

6. Fill in the description with whatever helps you recognize 
this contact. The description you enter in ‘Link From’ will 
show up on the linked record to remind you of why this 
record is linked. 

7. Select Link to and change it to the correct record type. 

8. Click on the pop-up button in the field next to the Link to 
field and select the record to link to. 

9. Type in a description for the ‘Link to’ record. This will 
show up on the current record reminding you why this 
record is linked. 

Changing a Link 
1. Click on the Links tab in the bottom most window. The 

view will change slightly and you will now be viewing all 
links pertaining to the currently viewed record.  

2. Click on the link you wish to edit. 

3. Right-Click and choose Edit in the menu.  
4. A new window will open titled Link. In this window you 

define the Link and its properties, and this is also where 
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you edit the link’s properties. To make a change to any 
section, Click on that section and change all required 
information. 

5. Click OK. You will be taken back to the original "Link" 
screen displaying info on the currently selected Link.  

6. Once again choose OK. The changes will take effect 
immediately. 

Deleting a Link 
1. Click on the Links tab in the bottom most window of the 

CRM table. 
2. Select the Link you wish to delete by clicking on it with 

your mouse. 

3. Right-Click on the selected link and choose Delete from 
the menu.  

4. You will be asked if you really wish to Delete this Link; 
choose Yes. The link will be deleted immediately.  

Attachments 
Attachments allow the users to attach files and pictures to your 
properties and contacts. Attaching pictures can be extremely 
useful to be able to view the property and for making reports. 
Attaching files can be useful for attaching text documents, PDF 
flyers, or anything else that you may wish to be able to have at 
your fingertips whenever you are viewing a contact.  

When you create an attachment, it will ask you to provide a 
description (the default description is the file name without the 
extension), the location of the file and which team has access to 
the attachment. When the attachment is created, it will show 
you the description you provided, the file name of the file, 
whether or not it is a picture, if it is a picture, whether or not it 
is the default picture, and what team the attachment is for.  
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Dashboard 
Overview 
The Dashboard screen is the center for communication in CRM. 
This screen allows you to view events and history in a grid with 
complete control over all the information. To access the 
Dashboard screen press {F2} or from the View Menu select 
Dashboard. 

From this screen you can access all associated contacts and 
properties or view events or history scheduled for yourself or 
anyone associated with you. You can add, edit and delete 
records in the list, finish events and move them from your 
scheduled items to history. 

Unlike the popular calendar view, which shows data in an easy 
to view but restricted format, the Dashboard screen allows you 
to see every record with no date or time restrictions. This 
critical view helps you see the things you missed as well as 
alerting you to upcoming items before it is too late. 

You can also view all your projects and leads from the 
Dashboard screen. 
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Filtering Dashboard 
Past / Future records: To see events or history inside a date 
range just Click the drop down combo box for past or future and 
highlight the number of days. All other filters you set will 
respect these date ranges. If you don't want date ranges to 
affect your other filters set past / future to All. You can also type 
in values such as 47 days or 9 months into these drop down 
combo boxes.  

                                 

Participant: Checking this box will limit the event tab to only 
show events in which you are a participant. Unchecking this box 
will show you all events that are scheduled for a team you are a 
member of or that you are a participant in.  

My records:  If you want to filter out all the events or 
histories that are you are not the record owner on check the 
Mine box at the top of the list. The Mine check box will respect 
any other queries that are set so if you want to see all the 
events on which you are the record owner set past / future to 
All and set the query to All records. 

Finished: Show all events that have all been finished.  

User defined Queries 
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Click the query combo box at the top of the Dashboard screen 
or open the Lookup menu and choose Query or press {Ctrl+Q} 
on your keyboard 

Choose the fields and values to query from. For details on 
querying a table please read the section on Queries. 

Sorting from Dashboard  
Double-Click the column heading of the field you want to sort 
the list by.  

For example: to sort the event list by project, Click the word 
Project in the heading of the project column. To reverse the 
order of the same column, Double-Click the header again.  

Columns 
You can set the columns in the Dashboard screen by right 
clicking in one of the windows and choosing Columns. 

Check the columns you want and uncheck the ones you don’t 
want to see in the window. 

Events 
An event is a future action you want to do. CRM lets you create 
events as far in the future as you wish. 

You can create alarms, write down details about the event, 
attach events to contacts and properties, set priorities for 
events, change the colors of events, decide who can see the 
event in your system, set a start date and an end date as well as 
a start time and end time, create events that are timeless or last 
all day, set a project name and you can make an alarm for an 
event show up on the calendar beforehand. 

Event types are things like Phone Calls, Meetings, Follow-Ups, 
Anniversaries and Birthdays. CRM allows you to create as many 
event types as you want. 
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You can see events on the records they are scheduled for, on all 
calendars and on the Dashboard screen. You can finish events 
once you have completed them and CRM will send those events 
to history so you retain a record of the things you have done.  

Sorting by the linked records 
You can also sort events on the contact or property records by 
selecting the Events tab on the record and clicking in the 
column heading for the correct field. 

Viewing Events 
Dashboard 
The best overall view of the events in CRM is the Dashboard 
screen {F2}. From Dashboard you can filter, sort, manage and 
print events. 

Calendar 
The calendar {F6} has three formatted views for events. Daily, 
Weekly and Monthly all allow you to manage and print events. 

Database Record 
Use the Search button to find the record you want to view and 
then Click on the Events tab.  
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Adding Events 

 

Adding an Event from a record 
1. Right-Click in the events box or you can open the 

Schedule menu and select the type of event you wish to 
schedule.  

2. This will bring up the Schedule Event dialog. By default, 
this event will be scheduled with the record you are 
currently on.  

3. Enter the information for the event and Click OK. 

Adding an Event from Dashboard 
Right-Click in the Dashboard area, or open the Schedule menu 
and select the type of event you wish to schedule.  

This will bring up the schedule event dialog box.  

Scheduling an event from here will, by default, not be scheduled 
with a contact. 

Enter the information for the event and Click OK. 
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Subject: Enter what the subject of the event is here. 

Event Type: What type of event you are scheduling.  

Color: 
This allows you to change the color the event 
appears as on your screen. 

Priority: How important the event is. 

Project/Lead: Project / Lead tied to this event. 

Start Date: The day that the event starts. 

Start Time: What time the event begins. 

End Date: The day the event ends. 

End Time: What time on the end date the event ends. 

Timeless: If the event has no specific time check this box. 

All day: Check this for events that last all day. 

Recurring: To make the event recurring Click this button. 

Alarm 
Checkbox: 

If this box is checked, an alarm will pop-up in CRM 
before the event to remind you. The amount of time 
beforehand that the alarm pops up is determined by 
the drop down box next to the checkbox. 

Preview: 
This will remind you a certain amount of time before 
the alarm. 

Participants: 
This allows you to schedule the event for a team or 
as a private event only for you. 

Linked: 
You can link an event with as many records as you 
want.  

Notes: 
This is where you can write any notes regarding the 
event. 
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Owner: Who created and owns the event. 

Team: Who the event can be seen by. 

Event Types 
CRM maintains a table of event types. You can create an 
unlimited number of event types for your system. To manage 
your event types open the Tools menu and select System 
Tables and then Event Types. 

Adding an Event Type 
1. Click the New button. 

2. Type in the new event type. 
3. Under duration, choose the default length for this event. 

The user can always change the duration when they 
create the event. 

Changing an Event Type 
Click on the existing event and make any changes you want. 

Deleting an Event Type 
Click on the event type and Click the Delete button. 

Sorting the Events 
Click the Sort button to sort the events alphabetically 

Placing Event Order 
If you want certain events to come first in the list you can use 
the Up and Down buttons to sort the list to your own taste.  

Finishing Events 
Once you have completed an event you should finish it. That 
will move the event from pending to history. This keeps a 
record of everything you do and allows CRM to create a 
complete report by contact, property or project that you can 
give to the owner of the property. 

1. Highlight the event and Right-Click it. 
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2. Choose Finish.  

3. Enter the correct information in the history screen. 

4. Click the Follow-Up button and schedule a follow-up.  
5. Click OK to save the history. 

Alarm Dialog 

 

Dismiss Pressing the dismiss button clears the alarm for the 
highlighted event. 

Finish Clears the alarm and brings up the history window allowing 
you to finish this event. 

Finish 
Now 

Clears the alarm and converts the event to a history record. 

Edit Click the edit button to make changes to the event. 

Snooze Clicking the snooze button will reset the alarms for the 
highlighted events. 

Go To 
You can jump to the attached client or property record by 
clicking this button The buttons are located in the bottom half 
of the alarm window next to the contact and property fields. 
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Managing Events 
Click on the Events Tab on the Dashboard screen to access your 
events. There are several ways to access the record functions in 
the event list. You can use the menus at the top of the 
Dashboard screen; you can Right-Click in the event list window 
and you can use the accelerator keys provided on the menus. 

Record Menu and Right-Click Menu  
Edit 

This menu option lets you change the information for the event 
using the event dialog. 

Finish 

Once an event has been completed you should finish the event. 
This action will remove the event from your scheduled list of 
things you need to do and place it in the history table. All linked 
contacts and properties will remain intact and finished events 
will appear in your marketing reports. 

Delete 

To remove an event completely from the system highlight the 
event and choose the delete menu item. You will be prompted 
to confirm the removal of the event from the system. Records 
deleted from CRM cannot be recovered.  

Go To 

Each event can be attached to a contact or property record. If 
you would like to quickly go to the linked contact or property, 
highlight the event and choose Go To Contact or Property from 
the menu. 

Schedule Menu 
From this menu you can create new events. For more 
information on creating events see the Scheduling Events 
section in this help file. 
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History 
A history is an accounting of things that you have done. This 
record chronicles everything you do and is one of the most 
important tables you'll use in CRM. Records entered here can be 
used for suspicious owners, law suits, follow ups and future 
prospects. 

The number of records in this table is unlimited so you should 
create a history record for everything you do. CRM allows you 
to print a marketing report by project, tenant, owner or any text 
entered into the history records. 

It is important that you understand every field in the history 
record and it is equally important that you create a history 
record for everything you do. This one feature in CRM will make 
you better than any other agent you compete with. 

You can see history on the contact records they were scheduled 
for, and on the Dashboard screen.  

Sorting and Viewing History 
Sorting and viewing Histories is the same as sorting Events. All 
Histories are sorted by their Event type which is set when either 
creating the History or finishing an Event, or by a Date Range. 

Filtering the History List 
To the left of the History list, you will see two buttons: Events 
and Dates. Clicking these buttons allows you to filter what you 
see in the History window. 

Events button 
Clicking the events button will display a list of all the event types 
in your system. Any events you check will show up in the list 
and events that you do not check will be filtered out of your 
view. The settings you make will affect the History list window 
for every record you view in the system. These settings will not 
affect any other users in your system. 
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Date button 
Clicking the date button will display a set of three check boxes 
on one tab. Checking the boxes on this tab will give you access 
to Past, Present and Future Histories linked to the currently 
displayed contact. Clicking the Range tab allows you to set an 
upper and lower range in days from the current date. Settings 
made on this tab will affect all the records you view.  

Creating History 

 

You can create Histories under the History window of a record, 
from Dashboard, or by using the call timer. 

Creating a History: 
1. Press {Ctrl+H} or Right-Click in the History View dialog 

and choose Add or click the History icon on the tool bar. 

2. In the History Record dialog, fill in all details you wish to 
record.  
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Description of History Details: 

Subject: Enter what the subject of the history is here. 

Event Type: What type of event you are scheduling.  

Color: Set the color the history for display. 

Project/Lead: What projects the history is a part of. 

Status: Status of the history in your pipeline model. 

Start Date: The day that the event starts. 

Start Time: What time the event begins. 

End Date: The day the event ends. 

End Time: What time on the end date the event ends. 

Timeless: If the event has no specific time check this box. 

Linked to: Link the history to any records  

User Field: 
You can change the labels on these for check boxes 
and four text fields and use them for anything you 
wish. 

Attachment: Attach any file to the history record. 

Notes: 
This is where you can write any notes regarding the 
event. 

Owner: Who created and owns the event. 

Team: Who the event can be seen by. 

Update: Update the linked project / lead. 

 

3. Click OK to save the record.  

Page 170 



Chapter 10 

Managing History 
Click on the History Tab on the Dashboard screen to access 
historical records. There are several ways to access the record 
functions in the history list. You can use the menus at the top of 
the Dashboard screen, you can Right-Click in the history list 
window and you can use the accelerator keys provided on the 
menus. 

Record Menu and Right-Click Menu 
Edit 
This menu option lets you change the information for the 
historical record using the history screen. 

Follow up 
To create a follow up event for a historical record you can Click 
this option and create a follow up event. This option will leave 
the historical record in the list unchanged and create a new 
event on your calendar and event list reminding you to do some 
future activity. For help creating the event please see the 
Scheduling Events section in this help file. 

Delete 
To remove a history completely from CRM, highlight the history 
record and choose the Delete menu item. You are prompted to 
confirm the removal of the history record from the system. 
Records deleted from CRM cannot be recovered.  

GoTo 
Each historical record can be attached to a contact or property 
record. If you would like to quickly go to the linked contact or 
property highlight the history and choose Go To Contact or 
Property from the menu 

Calendar 
Calendars display a formatted view of your scheduled events in 
three formats: daily, weekly and monthly. 
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Calendar Settings 

 
Figure 10-1: Event setup dialog 

1. To set your calendar defaults, open the Tools menu and 
select Options. 

2. Click on the Events/History tab. 
The first section under the heading Calendar sets the start and 
end time as well as the time division for your daily calendar. 

Calendar------------------------ 
Day starts at 
This setting affects the daily calendar. Set this value to the 
general time you start your day and CRM will gray out the times 
previous to this setting. You can still create events that occur 
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before this time but by default your calendar will start the view 
at this hour. 

Day ends at 
This setting only affects the daily calendar. Set this value to the 
general time you end your day and CRM will gray out the times 
beyond this setting. Events that occur after this time can still be 
scheduled, but by default, your calendar will end the view at 
this hour. 

Time slot size 
This setting only affects the daily calendar. This is for display 
purposes and printing only. The increment in this box will 
change the increment between hours. This setting does not 
affect your ability to schedule events for any time needed. 

Alarms------------------------ 
Pop up alarm window on top of other windows 
Checking this box will force CRM to put the alarm window on 
top of anything else you are doing. If you don't check this you 
may not see your alarms as they can be hidden by other 
windows on your screen. You may want to uncheck this if you 
get a lot of alarms and the window popping up in front 
interferes with your work. 

New Items------------------ 
Color 
Checking the color box and choosing a color will default any 
new Events or History you create to this color. In multi-user 
systems it is popular to assign a unique color to each individual 
on a team. When you view a calendar with multiple users this 
setting can make it much easier to see who has scheduled 
items. 

Event participants 
When you create an event you can set the participants for the 
event. The participants’ setting decides who in your office can 
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see the event on their calendar. The default setting is <just me> 
which means the event will only display on your calendar. You 
can change the default participants and every time you create 
an Event CRM will use this setting for whose calendar the event 
shows on. You have control on each event you create or edit to 
change the participants this setting is just the starting value. 

History type 
This sets the default history type. Each user can set their default 
history type from this menu. You can of course change the type 
while you are in a history record. 

Update project/lead from new history records 
This setting sets the state of the auto update feature when you 
add a new history to a record that is linked to a project / lead. 
You can manually override the setting for every history you 
create. 

Quick Letters------------------ 
Offer to create history for quick letters and emails 
When CRM creates a quick letter or email from the Write menu 
it can also create a history detailing what you sent. Checking 
these boxes will tell CRM to prompt you to create a history 
record before you create the document. You have the option to 
skip the history dialog if you want to. If you do not check the 
box CRM will automatically skip the history and go directly to 
creating your letter or email. You still have the option from 
Word to attach the document if you want and if you have 
Outlook set to track emails you will get a history of quick emails 
through Outlook. 

From any of the calendars you can view your events and the 
events scheduled for teams you belong to. If you have rights 
you can also manage others users events from the calendars. 

To display the calendar, press {F6} on your keyboard or open 
the View menu and select Calendars. Once in the calendar view 
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you can select Daily, Weekly or Monthly using the buttons at 
the top of the window. 

When an event is finished in Realnex CRM and you are viewing 
it in the calendar view, the event will appear crossed off.  

Calendar Tool Bar 
 

 Print: 
Prints the default calendar report labeled 
Calendar Events to the default printer. 

 
Print 
Preview 

Prints the default calendar report labeled 
Calendar Events to the screen. 

 New Creates a new event. 

 Finish 
Creates a history record of the currently selected 
event and finishes the event. 

 
Quick 
Finish 

Finishes the event and sends a copy to the history 
database without prompting you. 

 Delete Deletes the highlighted event. 

 Refresh 
Updates the calendar to show events changed or 
added since you opened the window. 

 Go To 
Enter the date you want to jump to in the 
calendar and then press Enter or Click the Go To 
button next to the date. 

 Today Takes you to the events for today. 

 Day Displays the daily calendar view 

 Week Displays the weekly calendar view 

 Month Displays the monthly calendar view 
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Filtering Events    
• Mine: Checking mine will hide all events in which you are 

not the Record Owner. Un-checking mine will show you 
all the events that you are a participant in as well as all 
the events in which you are the record owner. 

• Finished: Checking this box will force CRM to show you 
events that you have finished. The finished events will be 
shown with a strike through the text. This can make your 
calendar quite full, you can hide the finished events by 
un-checking this box. 

• Timeless: Checking timeless will show you all the 
timeless events in which you are a participant. 

 

Daily Calendar 

 

Figure 10-2: Daily calendar view 
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From the daily calendar you can add, edit and view your 
appointments as well as the other users’ events you have access 
to. 

Appointments can be color coded making it easy to quickly view 
things you want to see. 

Opening the Daily Calendar 
1. To open the calendar window press {F6} or open the 

View menu and select Calendar. 
2. Press {Ctrl+Y} or from the View menu select Day. 

Selecting Dates 
You can select one or more dates in the daily view and see them 
all at the same time. To view a date Click the day in the monthly 
calendars. To select more than one date hold down the {Ctrl} 
key while clicking on days you want to see. 

Adding an Event 
Double Click on an open time or select a time and Click the New 
tool button. 

Deleting an Event 
1. Select the event or events you wish to delete. 

2. Right-Click the event and select Delete or from the 
Record menu select Delete or press {DEL}. 

Editing an Event 
1. Select the event or events you wish to edit. 

2. Double Click the event or from the Record menu select 
Edit or select the event and press {ENTER}. 

Recurring Event 
1. Click the Recurring button. 

2. In the Recurring Event window set the time, duration 
and Time zone if necessary then select the Recurrence 
Pattern. 
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3. None makes the event a onetime occurrence and is the 
default. 

4. Daily allows you to create an event that will occur every 
day for until the ending date set. 

5. Weekly allows you to set an event that will occur on 
certain days during the week. 

6. Monthly gives you options for specific dates in a month 
or specified occurrences of a day in a month. 

7. Yearly is used for annual events such as Birthdays. 

Recurrence Range 
Start date is the date that the recurring event begins. Select No 
end date if you don't want the event to ever end. Select End by 
and enter a date if you want the event to end by a certain date. 

Finishing an Event 
1. Select the event or events you wish to finish. 
2. Right-Click the event and select Finish or Quick Finish or 

from the Record menu select Finish or Quick Finish or 
select the event and press {Ctrl+F}. 

Go To a linked Contact or Property 
1. Select the event. 
2. Right-Click the event and select Go To. If the event is 

attached to a contact or property the menu option will 
be available. Click the option and CRM will open the 
record. 

 

Page 178 



Chapter 10 

Weekly Calendar 

 

Figure 10-3: Weekly calendar view  

From the weekly calendar you can add, edit and view your 
appointments as well as the other users’ events you have access 
to. 

Appointments can be color coded making it easy to quickly view 
things you want to see. 

Opening the Weekly Calendar 
1. To open the calendar window press {F6} or open the 

View menu and select Calendar. 

2. Press {Ctrl+W} or from the View menu select Week. 

Print / Print Preview    
1. Click the Report Menu and Select Run Reports. You can 

also Click the print button on the toolbar if you want the 
default calendar report. 
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2. Right-Click the event and select Go To. If the event is 
attached to a contact or property the menu option will 
be available. Click the option and CRM will go to the 
record. 

Adding an Event   
Double Click on an open time or select a time and Click the New 
tool button. Fill in the event as described in Adding an Event. 

Deleting an Event  
1. Select the event or events you wish to delete. 

2. Right-Click the event and select Delete or from the 
Record menu select Delete or press {DEL}. 

Editing an Event 
1. Select the event or events you wish to edit. 
2. Double Click the event or from the Record menu select 

Edit or select the event and press {ENTER}. 

Finishing an Event    
1. Select the event or events you wish to finish. 
2. Right-Click the event and select Finish or Quick Finish or 

from the Record menu select Finish or Quick Finish or 
select the event and press {Ctrl+F}. 

Go To a linked Contact or Property 
1. Select the event. 
2. Right-Click the event and select Go To. If the event is 

attached to a contact or property the menu option will 
be available. Click the option and CRM will go to the 
record. 

Refresh Calendar    
If you are a part of a multi-user system and you have not re-
loaded the calendar in a while you should refresh the screen to 
see any changes to events that might have been made by other 
users in your system. 
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1. Click the Record Menu and Select Refresh.  

2. Click the refresh icon. 

Go To a Specific Date    
1. Enter the date you want to see in the lookup date box. 

2. Click the Go To button to the right of the date. 

Changing the Calendar View 
1. Today   

2. Daily  

3. Weekly  

4. Monthly  

Filtering Events 
• Mine: Checking mine will hide all events in which you are 

not the Record Owner. Un-checking mine will show you 
all the events that you are a participant in as well as all 
the events in which you are the record owner. 

• Finished: Checking this box will force CRM to show you 
events that you have finished. The finished events will be 
shown with a strike through the text. This can make your 
calendar quite full, you can hide the finished events by 
un-checking this box. 

• Timeless: Checking timeless will show you all the 
timeless events in which you are a participant. 

Viewing Multiple Events Side by Side 
1. Select the events while holding down the {Ctrl} key to 

select multiple events. 

2. Click the daily calendar button. 
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Monthly Calendar 

 
Figure 10-4: Monthly calendar view 

Opening the Monthly Calendar 
1. To open the calendar window press {F6} or open the 

View menu and select Calendar. 

2. Press {Ctrl+M} or from the View menu select Month. 

Adding an Event 
Double Click on an open time or select a time and Click the New 
tool button. Fill in the event as described in Adding an Event. 

Deleting an Event 
1. Select the event or events you wish to delete. 
2. Right-Click the event and select Delete or from the 

Record menu select Delete or press {DEL}. 

Editing an Event 
1. Select the event or events you wish to edit. 
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2. Double Click the event or from the Record menu select 
Edit or select the event and press {ENTER}. 

Finishing an Event 
1. Select the event or events you wish to finish. 
2. Right-Click the event and select Finish or Quick Finish or 

from the Record menu select Finish or Quick Finish or 
select the event and press {Ctrl+F}. 

Go To a linked Contact or Property 
1. Select the event. 

2. Right-Click the event and select Go To. If the event is 
attached to a contact or property the menu option will 
be available. Click the option and CRM will go to the 
record. 

Viewing Multiple Days Side by Side 
1. Select the days while holding down the {Ctrl} key to 

select multiple events. 
2. Click the daily calendar button. 

.  

Call Timer 

 
Figure 10-5: Call timer window 

Page 183 



Dashboard  

The Call Timer not only logs the length of your call but it allows you 
to move around in CRM while talking to a client and will 
automatically create a history record and attach it to the client and 
property specified. 

You can have multiple call timer windows running at the same time. 
To begin the call timer press Shift-F8, or Click the timer icon on the 
tool bar or from the Tools menu choose Call Timer.  

The Call Timer Window 
Subject 
This is the subject line for the history record that will be created. 
This field is directly related to the subject field in the history record. 

Project/Lead 
Allows you to assign a project or lead to this history record. You can 
attach multiple projects/leads to the record using the button to the 
right of the field with three dots on it.  

Status 
Here you can set the status of the event. The status indicates where 
in the process this contact or property is. You should create a flow 
chart of the important steps you track as a deal progresses. Once 
you have the chart convert that process into the CRM status fields. 
Then each time a deal reaches a new level you create a history 
record and set the status. In the end you can get a complete report 
showing where each client or property is in your pipeline.   

Linked to 
You can link multiple objects to a history record. To link a single 
item click the down arrow and select what you want to link, then 
search for that record. To link multiple records click the button with 
three periods. 
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Notes 
Insert notes regarding the call here. 

Always on Top 
Keeps the call timer window on top of all the other windows so you 
can always see it. 

Projects 
Click the projects tab to view your projects. 

 

At the top of the projects window you can check Active which 
limits the list to only projects you have set as active in the result 
field. 

If you want to see any other project types such as Won, Lost, 
Inactive you have to uncheck that box 
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You can check the mine box to limit the projects to only the 
projects you are the Record owner for. 

If you want to see all the projects you are a member of you 
should uncheck the Mine check box. 

You can right click in the project window to perform different 
actions on the records in the list. For detailed information on 
projects please see chapter 2 in this manual. 

Leads 
The leads tab works the same way as the projects tab. You can 
see only active leads and just the ones you own. 

Right click in the window to perform different actions on leads. 
Please see chapter 2 for more information on Leads. 
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Timelines 
Overview 
Timelines are a visual representation of projects you are working 
on. You can create a timeline template for things such as escrows, 
marketing plans and lease renewals.  

Each timeline can contain an unlimited number of events. Each 
event is based on the starting date of the timeline and can be 
scheduled for as many people on your team as you choose. Each 
event can also be linked to an unlimited number of contacts and 
properties in your CRM database. 

All events display in Dashboard, calendar and on the contact or 
property record. The events for your timeline sync to Outlook and 
your PDA / Phone. 

Events can be finished and sent to history to display in your 
marketing report and as finished on your timeline. 

 

Chapter 
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Managing Timeline Templates 
Before you can schedule a timeline you must create a timeline 
template. The templates are generic and can be used over and over 
again for different deals. When you actually schedule the timelines 
you can decide the starting date, which contacts and properties the 
timeline events are linked to, what team can see the timeline as 
well as the project a timeline is linked to. 

To create a new timeline, either go to Schedule and select Timeline 
from the record you wish to schedule the Timeline for, or press {Ctrl 
+ Shift + F8}. 

 

New 
To add a new timeline template Click the New button. 

Edit 
To change an existing template highlight the template in the list and 
Click the Edit button or double Click the timeline in the list. 

Delete 
If you want to remove a timeline template from the list highlight it 
and Click the Delete button. You cannot restore a timeline template 
once it has been deleted. Deleting a template will not affect the 
timelines that were created using the template. 

Properties 
Use the properties button to change the attributes of the timeline 
template such as name, description and owner. 
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Schedule 
Once you have created a timeline template you schedule it using 
the Schedule button. 

Close 
Click the Close button to close the Timeline template dialog.   

Timeline Template Properties 

 

Description 
The description shows in the timeline list window. Since this is a 
description of the template try to use wording that will help define 
what someone would use this template for. 

Owner 
The Owner of the template has full control over the template. Even 
if the owner is not part of the team associated with the timeline 
they can see it and manipulate it. 

Team 
The team setting tells CRM who can see and use this template. If 
you don't want anyone else to see the template make yourself the 
owner and make the team private. 
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Show Template on Menu 
Checking this option will place the template description on the 
schedule menu for the team that is listed. 

Typing in a value for Submenu will create a listing on the Schedule 
menu and the description will show once a user clicks on the 
submenu listing.  

Edit the Timeline Template 
The Edit Timeline Template dialog box allows you to create new 
Phases and Events for a Timeline. 

 

  

New Event 
Adds a new event to the current timeline. The event will be inserted 
below the currently highlighted event in the timeline. 

New Phase 
Adds a new phase to the current timeline. The new phase will be 
added at the end of the currently selected phase. 
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Copy 
The copy command makes a copy of the currently selected event. 
You cannot copy a phase. 

Edit 
If you want to modify an existing event, highlight the event and Click 
the Edit button. 

Delete 
To remove an existing event in a timeline, highlight the event and 
Click the delete button. 

Arranging Events Inside the Timeline 
You can relocate your events inside the timeline by either dragging 
and dropping the events in the list or using the up and down arrows 
on the toolbar. To use the arrows, highlight the event and Click the 
up or down arrows on the toolbars.  

Adding Phases and Events to Timelines 
Phases 
Phases separate a series of events into sections making it easier to 
follow events that are related. Phases can also have a color band 
making the timeline easier to read. 

Name 

Type in the name of the phase. 

Color 

If you want to set a color for the phase check the box in front of 
color and then pull down the combo box to set the color you want 
to use. The example on page 126 uses colors to separate the three 
phases of our example timeline. 
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Events 
You are able to add unlimited different events to your timeline 
and have them separated by Phases. For more information on 
adding Events, please see Chapter 8. 

Deleting Events from a Timeline 
Deleting from Calendar, Time Manager or a Record 

Right-Click the event and select Delete from the menu. 

From a Timeline  

1. Right-Click the event you want to delete in the timeline. 
2. Select Delete from the menu. 

Managing Timelines 
Creating Timelines 
You can only create a timeline from a timeline template. 

1. Click the Schedule menu and choose timeline. 

2. Highlight the timeline you want to schedule. 

3. Click the schedule button. 
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Start date 

The timeline is based on the start date you enter. Every event in the 
timeline is created a specific number of days from this date.  

When an event falls on a Weekend 

If one of the dates in your timeline projects out to a weekend you 
can have CRM move it forward to the following Monday, move it 
back to the previous Friday or leave it on the weekend day it is 
assigned. You will still be allowed to change dates for each event 
before the timeline is actually created. 

Linked to 

The entry here tells CRM who to link all the events too. If you want 
to link the events to a single record Click the down arrow and select 
the record type you want to link to. If you want to link the events to 
multiple records Click the button to the right of the down arrow 
with three ellipses on it and select as many records as you wish. 
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There will only be one copy of each event created but that event 
will be linked to all the records listed in this window. For example 
you could select a property, tenant and owner and each event 
would show up on all three of those records in CRM. If you change 
the event from any of the three records, from your calendar or 
Dashboard the change will show up on all the records. 

If you finish the event CRM will create a history and link the history 
to all the linked records as well. Even though the history record 
shows up on all the linked records it is still only one history record. 

Project/Lead 

You can only link one project/lead to the events. To link the event 
to an active project Click the down arrow and select the project. If 
you want to link the events to a lead Click the button to the right of 
the down arrow and select the project/lead. When you finish the 
event and create it as a history you can link the record to multiple 
projects if needed.  

Owner 

During the creation of the timeline the owner field will be 
populated with the agent listed in this field. This includes every 
event that is created by the timeline.  

Team 

Only the members of the team set will be able to view the timeline. 
Any event included in the timeline that has the team set as 
“Default” will be set to use the team listed in this field. Events that 
are set to use Private or <everyone> will keep those teams. If an 
individual event is set to <everyone> that event will be visible from 
the record it is linked to regardless of the team setting for the 
timeline. 
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Confirm Timeline Events 

 

 

Once you have created an initial timeline CRM will show you the 
events in a temporary viewer. You have the option at this point to 
make changes to the events produced by the timeline template 
before they actually become a timeline in CRM. 

If you decide any of the events in the confirm window are not 
needed for this timeline just uncheck them. Only the events that 
are checked will be used to create the final timeline. 

If you want to make a change to an event in the confirm windows 
before it is created just double Click on it. This will not change the 
actual timeline template but just the event for the timeline you are 
creating. 

You can use following keys to adjust the dates for each event. To 
use these keys you must first highlight the event you want to 
change: 
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+ increase the date one day 
- decrease the date one day 
W first day of Week 
K last day of weeK 
M first day of Month 
H last day of montH 
Y first day of Year 
R last day of year 

Timeline Details 

 
 

Description 
The description is listed in the timeline viewer to help you select 
which timeline you want to view.   

Report title 
The report title is what will be displayed on the timeline print out 

Subtitle 
Subtitle is the second line displayed on the timeline print out. 
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Notes 
Notes will be saved with the timeline but are not displayed on the 
report or print out. 
Viewing Timelines 

 
 

1. Click the View menu and select Timelines or press {F7}. 
2. Select the timeline you want to view and Click OK.  

NOTE: If you want to view a timeline that is not currently active 
you have to uncheck the Active timelines only check box. 

You can also view a timeline by Right-Clicking on any event that is 
part of a timeline and selecting Go To Timeline. 

Modifying Timelines 
Open the timeline you want to modify. 
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Drag and drop events to move them in the timeline list.  

Timeline Properties 

 
  

Description 
The description shows in the timeline list window. Since this is a 
description of the template try to use wording that will help define 
what someone would use this template for. 
  
Start date 
The timeline is based on the start date you enter. Every event in the 
timeline is created a specific number of days from this date.  
  
Active 
While you are working on a timeline this box should be checked. 
Once you are finished with the timeline uncheck this box to remove 
it from the timeline view list. You can always see it by unchecking 
the view active check box on the timeline viewer. 
  
Report title 
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The report title is what will be displayed on the timeline print out 
  
Subtitle 
Subtitle is the second line displayed on the timeline print out. 
  
Notes 
Notes will be saved with the timeline but are not displayed on the 
report or print out. 
  
Owner 
The Owner of the template has full control over the template. Even 
if the owner is not part of the team associated with the timeline 
they can see it and manipulate it. 
  
Team 
The team setting (along with the Owner setting above) tells CRM 
who can see and use this template. If you don't want anyone else to 
see the template, make yourself the owner and make the team 
private. 
Deleting a Timeline 

1. Click the View menu and select Timelines or press {F7}. 
2. Select the timeline you want to view and Click OK. 
3. Click the Timeline Menu and select Delete Timeline. 

Printing Timelines 
1. Open the timeline you want to print. 
2. Click the Printer Tool-button or press {Ctrl+P}. 

Exporting Timelines to Excel 
1. Open the timeline you want to export. 
2. Click the Excel tool button or from the Timeline menu 

select Send to Microsoft Excel.  

Making a Timeline Inactive 
Once you have finished a timeline you can make it inactive so it 
doesn't show up on the Timeline View menu. You can always see 
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Inactive timelines by un-checking the Active Timelines only check 
box. Making timelines Inactive cleans up your viewer so you can 
quickly get to projects that you are currently working on. 

You can also use the teams to keep projects you are working on 
hidden from other people on your team or in your office. If you 
create a timeline that only you need to see set the team to private 
so others don't have to sort through timelines that have no 
relevance to them. 

1. Open the timeline you want to edit. 
2. Click the Timeline menu and select Properties or Click the 

Properties tool button. 
3. Check or Uncheck the box in front of Active. 
4. Click OK.  
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Finding Records 
Overview 
As the number of records in your CRM database grows, you will 
need to be able to find specific records quickly. CRM uses 
Searching and Queries to locate records and to a lesser extent, 
Lookups and Sorting.  

In this chapter you will also learn to create Groups, Custom 
Views, Validation Views and how to view records in a List 
format.  

Finding Records 
When you start CRM at the beginning of your workday, you 
probably are going to start working with the events listed in 
your Dashboard screen.  

Right-Clicking on an event in the Dashboard screen opens a 
menu from which you can select the Go to Contact option and 
the table with that record is opened. 

Contact Search 
1. If you want to find a contact which could be in any table 

in CRM, the quickest way to do so is by using {F12} or 
click 

Chapter 
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2.  the  button on the toolbar and then click 
Contact. 

 
Figure 12-1: Select contact dialog 

3. Enter the information you want to locate in the Select 
Contact dialog. To find a contact by name, you can enter 
any part of the name. CRM will search combinations of 
the full name field, first and last name fields and the 
greeting field to find matches. 

4. Click OK. 
CRM reads the field entries you make and then does a global 
search of all records and lists the matching records at the 
bottom of the Select Contact dialog. 

5. Double-Click on the record you want in the list. CRM 
opens the table and the record you selected.  
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Here are some tips on doing lookups:  
Pay attention to the first name, if it is a name that has different 
spellings such as Bill, William, Billy, Willy then you might have to 
try the search with more than one spelling for the first name. 
When creating a new record, people can misspell the name so 
you might also look for only the last name or only the first name 
or a combination of name and some other field. CRM does it's 
best to help you with lookups but you are smarter than the 
computer and will have to help it in some cases. 

Narrow information the search by entering into other fields. 
Most of the fields in the Select Contact screen use a partial 
match to find a contact. So, for example, if you entered SAN 
into the city field CRM would search for any contact that had 
the three letters SAN in the city name. No matter where those 
letters were in the field it would find a match for you. 

Special Case Searches 
Contact Name 
The Name field in the Contact Search dialog searches three 
fields in each contact record. It searches the Full Name and 
combinations of the First, Last and Greeting fields. This search 
window also removes all punctuation and spaces before it 
searches.  

Example: If you had the following contact record in your system. 

 

You could find the record using any of the following names: 

William J. Berkley William J Berkley 
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WilliamJBer WilliamJ 
William Berkley William B 
Berkley, William Berkley, W 
Bill Berkley Berkley, Bill 
Bill Berkley 
Phone Number 
The phone number field in the Contact Search dialog searches 
all phone fields including the alternate phone numbers. The 
phone number field can search for contains or starts with.  

If you are looking for a particular area code you must surround 
the area code with parenthesis and it must be the first entry in 
the phone look up field, i.e. (619). 

If you are looking for a particular area code and prefix you must 
enter the area code in parenthesis followed by a space and the 
phone number prefix, i.e. (619) 920. 

If you type a number with no formatting in the phone look up 
field CRM will return any record whose phone number contains 
those numbers. i.e. if you enter 619 in the phone look up field 
the following would all be returned: 

(619) 444-2311, (858) 542-6194, (926) 561-9442. 

Email Address 
The Contact Search dialog also searches the alternate email 
address fields. 

NOTE: Using Contact Search does NOT change the sort order of 
the table.  

Company Search 
1. If you want to search the company table specifically, the 

quickest way to do so is by using {Alt-F12} or click the  
button from the toolbar and click Company. 
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Figure 12-2: Select company dialog 

2. Enter the information you want to locate in the Select 
Company dialog. 

3. Click Search. 

CRM will open the companies’ database and find the companies 
that match your filter. CRM looks for the information you enter 
in this dialog anywhere in the field. So, if you were to type INC 
in the Organization field CRM would read every company record 
in the table and if the letters INC were found anywhere in the 
organization field it would list the record. 

4. Double-Click on the company you want in the list. CRM 
will open the company table and display the record you 
selected.  
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Property Search 
1. Press {Shift-F12} or click the search button on the 

toolbar and then click Property. (Figure 12-3) 

 
Figure 12-3: Select property dialog 

2. Enter the information you want to locate in the Select 
Property dialog. 

3. Click Search. 
4. Double-Click on the property you want in the list. CRM 

opens the property table and displays the record you 
selected. 

To find properties you have to enter the information exactly as 
it is in the record but you only have to enter as much as you 
need to find it. For example: if you are looking for 1253 North 
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Dallas Forty, but you don't know if it is 1253 N or North or 40 or 
Forty you could just enter 1253 N and Click OK. You can also 
enter partial information in other fields to narrow the list such 
as Diego for the city. That might be enough to cut the list to a 
few properties making it easy for you to pick the correct one. 

The property table can be the most difficult to search of all the 
tables because of our inability as data processors to enter 
information consistently. It is extremely important that you 
create a set of rules for entering address information before you 
start adding properties. Read the guideline under 
Standardization of Address Information in this manual.  

Sale Comp Search 
1. Press {Ctrl-F12} or click Search on the toolbar and then 

click Sale Comp. (Figure 12-4) 

 

Figure 12-4: Select sale comp dialog 
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2. Enter the information you want to locate in the Select 
Sale Comp dialog. 

3. Click Search. 

4. Double-Click on the sale comp you want in the list. CRM 
opens the Sale Comp table and displays the record you 
selected. 

Lease Comp Search 
1. Press {Ctrl-Shift-F12} or click Search on the toolbar and 

click Lease Comp. (Figure 12-5) 

 

Figure 12-5: Select lease comp dialog 

2. Enter the information you want to locate in the Select 
Lease Comp dialog. 

3. Click Search. 
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4. Double-Click on the lease comp you want in the list. CRM 
opens the Lease Comp table and displays the record you 
selected. 

Space Search 
1. To quickly find a space from anywhere in CRM use the 

accelerator key {Alt-Shift-F12} or click Search from the 
toolbar and then click Space. (Figure 12-6) 

 
Figure 12-6: Select space dialog 

2. Enter the information you want to locate in the Select 
Space dialog. 

3. Click Search. 
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4. Double-Click on the space you want in the list. CRM will 
open the Space Table and displays the record you 
selected. 

The Find command enables you to lookup records by every field 
in the table. 
NOTE: The find command will only search the records that are 
currently available. If you have executed a query or activated a view 
and the record you are looking for is not in that sub-set, CRM will 
not be able to find it. 

You must be in a table such as Contacts, Companies or 
Properties to use the Find command. 

1. Press {Ctrl+Shift+F} or open the Lookup menu and 
select Find to load the Find dialog.   

2. Select the field(s) to search in the drop down list. (Figure 
12-7) 

 
Figure 12-7: Find dialog 

3. Enter the search criteria, to the right of the field name. If 
you want CRM to search for the matching information 
anywhere in the field(s) Click the checkmark in front of 
Find Anywhere in Field. Otherwise the Find dialog 
searches for starts with. 

4. Click OK.  
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Sort Order Changes 
Besides finding records, the Find command also changes the 
sort order of the table. For example, if you use the Find 
command to lookup a zip code, CRM will change the order of 
the open table to zip code order. CRM will also take you to the 
first record that matches the zip code you entered. Pressing 
{PgDn} to move to the next record will take you to the next zip 
code in ascending numerical order. If you search on multiple 
fields CRM will change the order to match those multiple fields. 
For example if you searched by state and city, CRM would 
change the order of your table alphabetically to state, and 
within each state by city. 

The Find command does not change the current record set. So 
if you Find by mobile phone number and look for 619, CRM will 
sort the table by the mobile phone field, jump to the first 619 
record in your system but it will not remove records that are not 
in the 619 area code from your view. If you are looking to limit 
the table to a value in a field please read the next section in this 
help file on Queries. 

Queries 
The term query is used to describe the process of asking a 
question of your CRM database. Queries can involve simple 
single field questions such as “find me everyone who has the 
last name Smith” or advanced field questions such as “all 
properties in the 92121 zip code with 20,000 square feet and 
zoned commercial”.   

The difference between these two questions is the number of 
fields that are involved and the operators used. Asking for more 
than 20,000 square feet is an example of the greater than 
operator.  

When you run a query, CRM locates the records that match 
your criteria (a subset) and restricts your table to seeing only 
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those records. In other words, you have temporarily reduced 
the number of records available in CRM to the ones that match 
your question. The other records are still in CRM, but are hidden 
by the query criteria. You can release the query at any time by 
looking up all records to once again see all of your records. 

Simple Queries 
To create a simple query in CRM:  

1. Right-Click on the field you want to search. (Figure 12-8) 

 
Figure 12-8: Field Right-Click menu 

2. Select Query. (Figure 12-9) 

 
Figure 12-9: Simple query dialog 
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The field that you have selected to query is listed in field .  
Below that field name is a drop-down  with operators for the 
query.  

From the drop-down, select the appropriate operator. A brief 
summary of each type is listed below. The list of evaluators 
changes depending on which field is selected.  

Field Conditions for Queries 
Operator  Result 

Is 
Equal to. Select a value from the pop-up table or 
enter your own 

Is Not 
Not equal to. Select a value from the pop-up table or 
enter your own 

Is Empty Finds all records with no entry in the field 

Is Not Empty Finds all records that have any entry in the field  

Is greater than 
Finds all records whose value is greater than the 
value you enter in the query field or from the pop-
up menu 

Is less than 
Finds all records whose value is less than the value 
you enter in the query field or from the pop-up 
menu 

Is greater than 
or equal to 

Finds all records that are greater than or equal to 
the value you enter or select from the pop-up menu 

Is less than or 
equal to 

Finds all records that are less than or equal to the 
value you enter or select from the pop-up menu 

Starts with 
Finds all records where the value(s) in the field 
begins with the same characters as you enter in the 
field or from the pop-up 

Does not start 
with 

Finds all records where the value(s) in the field does 
not begin with the same characters as you enter in 
the field or from the pop-up 
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Ends with  
Finds all records that end with the characters you 
enter in the field or from the pop-up 

Does not end 
with  

Finds all records that do not end with the characters 
you enter in the field or from the pop-up 

Contains 
Finds all records that contain the characters you 
enter in the field or from the pop-up 

Does not 
Contain 

Finds all records that do not contain the characters 
you enter in the field or from the pop-up 

Sounds Like 
Finds all records whose letters sound like those you 
have entered in the field.  

Between 
Finds all records that have an entry in the field 
between your entries in the two fields or from the 
pop-up 

 

3. Click OK to run the query.  
CRM locates the records that meet your query conditions. In the 
upper left corner of the record window between the records 
movement (browse) buttons, CRM shows you the total number 
of records that match the query.  

 

Simple Query Options 
When you start CRM and execute your first query, the query 
dialog box has several options that are not selectable. (Figure 
12-10)  
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Figure 12-10: Simple query dialog 

These options become available in the query dialog only when 
there is a query currently in effect. The three options are 
explained below: 

Replace current query 
This option releases any previous query and looks at all records 
in the table. In other words, all records will be searched to 
match the new query, not only those that were located in the 
previous query. You could achieve the same results by looking 
up all records in the table first and then creating the query. 

Drill down within current query 
This option queries only the records that are currently selected. 
This process is called drilling down as it allows you to execute a 
query and continue to refine that query until you get exactly the 
records you want. 

Add to current query 
This option keeps the current set of records you have and adds 
any records that match the new query criteria to those existing 
records. 
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Table Access to Query dialog 
Besides Right-Clicking a field, you can access the query dialog 
from the top of the window.  

Click on the down arrow to the right of the Query field and Click 
Query. (Figure 12-11)  

 
Figure 12-11: Access to previous queries and new ones 

From the pull down combo box you have a few options. 

Query: This option opens the query dialog and allows you to 
create a query. 

Restore previous queries: Any query ran in this session will be 
listed in the window. 

All records: If you had selected all records {Ctrl+R} during this 
session that will be listed in this window too. 

NOTE: if you Right-Clicked on a specific field this box will already 
be filled in for you. 

Advanced Queries 
Advanced queries allow you to combine multiple criteria in a 
single dialog. An example of a multiple criteria query is locating 
properties that are 20,000 square foot or greater in a specific 
zip code.  

To begin an advanced query: 

1. Open the Lookup menu and select Query. (Figure 12-12) 

Page 216 



Chapter 12 

 
Figure 12-12: Simple query dialog 

2. From the Query dialog, Click the Advanced button. 
(Figure 12-13)  

 
Figure 12-13: Advanced query dialog 
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Advanced query dialog: 

Field 
In this field, open the pull down menu list and 
select the field you want to set query criteria for.  

Operator 
Beneath the field name, select the operator for the 
criteria as described in table 1 above.  

And 

After you select a field to query and the operator, 
you can add more fields to query and separate the 
queries by the And condition. Using the example of 
square foot and zip code, you are asking CRM to 
locate all properties that have a certain square foot 
AND are in the zip code you specify. If a property 
record does not meet both criteria, it is not located.  

Or 

After you select a field to query and the condition, 
you can add more fields to query and separate the 
queries by the Or condition. Using the example of 
square foot and zip code fields, you are asking CRM 
to locate all properties that have a certain square 
foot OR are in the zip code you specify. If a property 
record meets either criterion, it is located. 

Add 
Click the Add button when you want to add an 
additional clause to an existing query or to start a 
new query.  

Remove 

The Remove button will delete a clause or clauses 
(if you select multiple clauses) from the query 
dialog. Select the clause you want to delete and 
Click Remove.  

Clear 
The Clear button removes all clauses in the 
Advanced Query dialog.  

Up 
Arrow 

The up arrow button moves the selected clause up 
in the query window.  

Down 
Arrow 

The down arrow moves the selected clause down in 
the query dialog. 
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Group 

The group button allows you to set the order of 
operation of a query clause. When selected, it 
inserts parentheses at either end of two or more 
selected query statements.  

UnGroup 
The ungroup button removes parentheses from the 
selected query statements. 

Order of Operations and CRM Queries  
When you want to create a query that has multiple criteria and 
clauses, you must be aware of the way the order of operations 
affects the results of your query.  

The order of operations in which one is to interpret a 
mathematical expression such as "2+3 * 5" is a convention. This 
means that a long time ago, people just decided on an order in 
which operations should be performed. It has nothing to do 
with magic or logic. A method was adopted and it has stuck ever 
since. 

Another way of saying this is that rather than being inherent in 
the structure of mathematics, the concept of "order of 
operations" is a matter of mathematical notation. Order of 
operations refers to which operations should be performed in 
what order, but it's just convention.  

CRM uses the standard order of operation for queries.  
Here is an example:  

3 + 5 x 7 = ? 

Most people forget that in the equation above that the multiply 
sign is executed first and then the addition. So, they would think 
the answer is  

3 + 5 x 7 = 8 x 7 = 56 (reading from left to right).  

But the right way to get the answer is to follow the convention 
and multiply first and then add:  
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3 + 5 x 7 = 3 + 35 = 38 

The 5 X 7 is done first, equaling 35 and then you add the 3 to 
get 38.  

If you wanted the result of the equation to be 56 you would use 
parenthesis to achieve that. The following equation equals 56. 

(3 + 5) x 7 = 8 x 7 = 56 

The rule is always do the equation inside the parenthesis before 
any other operation. 

An CRM Example 
If you wanted to locate all the offices of a certain company in 
two different states (Florida and California) you might try this 
query: 

state = ‘CA’  or state = ‘FL’ and company = ‘XYZ’ 

If you used this query as it is written above, the AND statement 
would take precedence and locate all the XYZ company offices 
in Florida or EVERY company in California regardless of the 
companies name. To get the correct results you need to group 
the query using parentheses:  

(state = ‘CA’  or state = ‘FL’) and company = ‘XYZ’ 

CRM first finds all the records that are in the state of Florida or 
California, then inside that group of records it finds and returns 
only the ones with the company name equal to XYZ.  

Precedence of AND / OR explained 
When a query is executed, it first evaluates the clauses linked 
with NOT, then AND, and finally those linked with OR. So, using 
our previous example above the following is true. 

A or B and C = everything that is A as well as everything that is B 
and C. 
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To override the default precedence of AND over OR, you can 
put parentheses around specific conditions in the Advanced 
Query window. Conditions in parentheses are always evaluated 
first.  

(A or B) and C = everything that is either A or B AND also is C. 

Tip: It is recommended that, for clarity, you always include 
parentheses when combining AND / OR clauses instead of 
relying on the default precedence.  

How AND Works with Multiple OR Clauses  
Understanding how AND / OR clauses are related when 
combined can help you construct and understand complex 
queries in the Advanced Query dialog.   

If you link multiple conditions using AND, the first set of 
conditions linked with AND applies to all the conditions in the 
second set. In other words, a condition linked with AND to 
another condition is distributed to all the conditions in the 
second set. For example, the following schematic 
representation shows an AND condition linked to a set of OR 
conditions:  

A AND (B OR C)  

The representation above is logically equivalent to the following 
schematic representation, which shows how the AND condition 
is distributed to the second set of conditions:  

(A AND B) OR (A AND C)  

The principle of distributing AND clauses to linked OR clauses 
applies no matter how many individual conditions are involved.  

The Common Sense Test 
The key idea in building queries is that when you create 
complex queries with multiple clauses, if the numbers of 
records retrieved are far too many, or none at all, you have to 
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do a sense test i.e. does the logic in my query make sense? If 
not, you have to go back and try again.  

Working with Session queries 
Every time you open a main window such as contacts or 
properties you start a session. CRM temporarily stores each 
query you run in memory during a session. Using the drop down 
combo box to the right of the Query label (Figure 12-14) you 
can quickly recall queries run during that session.  This is very 
handy when you need to release a query temporarily and re-set 
it later. 

 
Figure 12-14: Drop down query combo box 

When you select a query from the drop down, CRM 
immediately executes the query for you.  

When you Close the window it ends the session and CRM will 
release the temporary queries set from its memory. When you 
re-load the window the drop down query box will be empty 
again.  

Editing a Query in same Session 
f you need to edit a query that you are testing, you can do 
so if you have not exited the window session. That is, your 
session queries are stored temporarily and therefore can be 

modified.  

To edit a session query: 
1. Open the Lookup menu and select Edit Query or press 

{Ctrl+Alt+Q} on your keyboard. 

I 
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2. The Advanced Query dialog opens with the current 
query.  

3. Make the changes you want and Click OK to execute the 
query.  

NOTE: if you want to edit a previously executed query pick it first 
in the drop down query combo box and then edit it. The edit query 
menu option always works on the currently set query. 

Saving Queries 
1. While you are building a query you can Click the Save 

button at the bottom of the Advanced Query dialog. The 
Save Query dialog opens. (Figure 12-15)  

 
Figure 12-15: Save query dialog 

2. In the name field type a descriptive name for the query. 
This will show in the list above under the name column 
for future reference. 

3. Set the query ownership by selecting a name from the 
drop-down. 
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4. Assign the query to a team, <everyone> or set it as 
private. Choose the team from the drop-down combo 
box.  

5. Click OK.  
6. You can also save the query to disk so you can share it 

with other CRM systems.  

Executing a Saved Query 
Saved queries are accessible via the Lookup menu. The table 
that you want to query must be open. To execute a saved 
Query: 

1. Open the Lookup menu and select Load Query. The Load 
Query dialog opens. A list of saved queries appears.  

 
Figure 12-16: Load query dialog 

2. Double-Click on the query you want to execute or select 
the query and Click OK.  

3. You can also load a query from disk using the From Disk 
button. 
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Editing a Query 
1. Open the Lookup menu and select Edit Query. The 

advanced query dialog opens. The most recent query 
appears in the dialog. 

2. To change a value, select the clause and change the 
value. You can also remove an existing clause. To do this, 
highlight the line and Click Remove. 

3. Click OK to execute the edited query. 

To replace an Existing Query: 
1. From the Advanced Query dialog create your query and 

Click Save.  
2. The Save Query dialog opens.  

3. In the list of saved queries, Click the query you wish to 
replace. 

4. Click OK.  
5. Answer Yes to the prompt asking if you want to replace 

the existing query. 
6. The Advanced Query dialog opens and the query is 

replaced with the newer query.  
7. Click OK to execute the query or Click Cancel.  

NOTE: Once you have overwritten an existing query the only way 
to get it back is to recreate it. 

Releasing a Query 
To release a query press {Ctrl+R} or go to the Lookup menu 
and choose All Records or Click on the Query combo box and 
choose All Records. 

NOTE: you can use the accelerator key CTRL+R to release a 
query much quicker. 
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Deleting a Saved Query 
1. Open the Lookup menu and select Load Query.  

2. Highlight the query you want to delete. 

3. Click the Delete tool button. 
4. Click Cancel to close the Load Query window.  

Changing the Properties of a Saved Query 
1. Open the Lookup menu and select Load Query.  

2. Highlight the query you want to change. 
3. Click the Properties tool button. 

4. Make the changes you want. 

5. Click OK to save your changes 
6. Click Cancel to close the Load Query window.  

Custom Views  
Custom views allow you to create subsets of your data making 
it easier for you to work inside a predefined record set. In a 
database of 250,000 records, you are likely to only use a small 
percentage of those records at a given time. To make it easy, 
you can create a View and then when you wish to use that 
record set just enable the view. A view is created using the 
Advanced Query dialog.  

Activating a custom view executes the underlying query and 
then creates a subset of the CRM database. The view only 
restricts those records in the view window opened. That means 
you can activate a view of contacts in one window while still 
viewing a separate window of all contacts. There is no limit to 
the number of views you can have open at the same time. 

NOTE: When you enable a view, only the records in the view are 
available for querying etc. If your view is restricted to State equals 
California for contacts, no records that are defined as being in any 
other state are available.  
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Dynamic Effect 
A view is dynamic and automatically adds any records that 
match the query you have defined.  For example: if you do a lot 
of email blasts to investors and you specialize in retail strip 
centers. You could create a view that pulls Retail Investors, with 
email addresses that are not checked “Do Not Email”. Any time 
you wanted to do an email blast you would just select the view 
and send. 

If you have created a view that locates those records, when you 
activate the view, CRM searches the database for all the 
investor records that meet the criteria and adds them to the 
view. This makes a view dynamic as opposed to a static set of 
records in which you mark specific records to show up and 
those records always appear no matter what the criteria. To 
create a static record set use the Group function described in 
this chapter. 

Custom views can be created for private use or for teams 
making it easy for you to limit the views you see to records 
useful to you.  

Creating a Custom View 
1. Open the table from which would like to create a view. 

2. Open the View menu and select Custom Views. (Figure 
12-17) 
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Figure 12-17: Custom view dialog 

3. Click New to create a new view or if you have an existing 
view that is close to what you want, highlight that view 
and Click the Copy tool button. (Figure 12-18) 

 
Figure 12-18: Custom view properties dialog 

4. Enter a description of the View. The text you enter in 
this field will be displayed in the list of custom views for 
use later.  
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5. Select the table to use in the Type field.  

6. Choose the Owner of this view. 

7. Select the Team that can use this view, and/or create the 
query for the view you want and Click OK. The Advanced 
Query dialog opens.  

8. Click OK. The new view is saved.  

Activating a Custom View 
Activating a custom view executes the underlying query and 
then creates a subset of the CRM database. The view is opened 
in its own window and does not affect any other views. Each 
custom view works on a single table.  

1. Open the View Menu and select Custom Views. (Figure 
12-17) 

2. Double-Click the view you wish to activate or select the 
view and Click Activate. 

3. The query runs and the records that meet your query are 
located. The new view appears in a new window in CRM.  

If you have several views open, you can switch to each view via 
the Window menu. Custom views are listed as table name and 
then the name of the view i.e. Contacts California. 

To switch views, open the Windows menu and select the 
window that has the view listed.  

Editing a Custom View 
1. Open the View menu and select Custom Views. 
2. Highlight the view you wish to change and Click the Edit 

button. The Advanced Query dialog opens.  
3. Make the change(s) you want. 

4. Click OK. 

Changing Custom View Properties 
1. Open the View menu and select Custom Views.  
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2. Highlight the view you wish to change and Click the 
Properties button. (Figure 12-19)  

 
Figure 12-19: Custom view properties 

3. Make the change(s) you want 

4. Click OK. 

Deleting a Custom View 
1. Open the View menu and select Custom Views.  
2. Highlight the view you wish to delete. 

3. Click on the Delete button. 

Lookups 
Lookups are used to quickly locate a record in CRM in an open 
table. In order to see the Lookup menu, you have to have one 
of the 13 main tables opened.  

1. Each database varies in the lookup fields that are 
available. For example in Contacts you can select Last 
Name. (Figure 12-20) 
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Figure 12-20: Lookup find dialog 

2. Enter the last name of the person you want to locate.  
3. Click OK. 

4. CRM will either display the first record found or tell you 
it could not find any matching records.  

 
Figure 12-21: Example after doing a find 

CRM matches from left to right the closest spelling of the name. 
So, if you are not sure of the exact spelling, enter the first 
several letters and then Click OK.  

In the example from Figure 12-20 above the search was for Last 
Name = ‘Hart’ and First Name = ‘R’. In Figure 12-21, the Lookup 
by Last Name displayed the contact record that most closely 
matched the letters entered. In the field to the right of Sort 
(circled in figure) CRM tells you the Sort Order of the contacts; 
in this example Last Name and then by First Name. To the right 
of the Query field (circled in figure) CRM tells you the current 
set of records that were searched. Remember that the Find 
command only looks at the current set of records; it does not 
change the current subset.  
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Two things make a Lookup different from a Query. 

1. A Lookup sorts the records by the criteria you entered. 
So, if you used Last Name, then the contacts are sorted 
by last name with the closest match appearing in the 
window.  It DOES NOT change the set of records you are 
looking at. 

2. A Query changes the set of records you are looking at. It 
DOES NOT change the order of those records. 

Sorting 
Sorting records is reordering the way the records are displayed 
in CRM. In other words, when you sort, you are changing the 
order of the records by the field(s) you choose for the sort. 
When you do a Lookup CRM automatically resorts the record 
set by your lookup fields. Sorting affects all records in the table 
but it DOES NOT change the current record set you are viewing.  

If you had set a query in a table and then did a sort your current 
subset would show in order by the sort you used. If you then 
released the query and said Every Record the entire database 
would now be sorted by the same sort as the subset was. 

If you execute a Query, you can work within just those records 
(the subset) and re-sort the records that are in the query.  

Creating a Sort Order 
1. Open a table to view. 

2. Press {Ctrl+O} or open the Lookup menu and choose 
Sort or Click the Sort dialog. (Figure 12-22) 
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Figure 12-22: Sort dialog 

3. CRM opens the Sort dialog window. From this dialog 
select the fields from the left side to sort by.  

4. To add a sort field, double Click on the field or highlight 
the field you wish to add in the Fields column and Click 
the button with the arrow pointing right (towards the 
selected window). (Figure 12-22 ) 

5. To remove one of the selected fields, double Click the 
field or highlight the field you wish to remove from the 
selected column and Click on the button with the arrow 
pointing left (towards the Fields window). (Figure 12-22 
)   

6. To remove all of the selected fields from the list, Click the 
button with two arrows pointing left. (Figure 12-22 ). 

7. You may also change the order in which the fields are 
sorted. To do this, highlight the field in the selected 
window and Click the up or down buttons to the far right 
of the sort dialog. (Figure 12-22 )  
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8. In the example Sort dialog, the list would first be sorted 
by the company name, then by last name, then first 
name, then by city and finally by the work phone 
number.  

9. You can re-load saved queries by clicking the Load 
button. (Figure 12-22 ) 

10. You can save a sort for use in the future by clicking the 
Save button. (Figure 12-22 ) 

11. When you are finished selecting which fields to sort by, 
Click on the OK button to execute the sort. (Figure 12-22 
) 

Selecting Sorts run since loading CRM 
1. Click in the Sort combo box at the top of the open table. 

2. Select the Sort you want to restore from the list. 
3. CRM will execute the sort and re-arrange the records. 

Editing Sorts run since loading CRM 
1. If you don’t have the correct sort set Select it first from 

the Sort combo box at the top of the open table. 
2. Click the Sort combo box at the top of the open table 

and choose Sort. 

3. Make changes you want in the Sort window. 

4. Click OK. 

Working with Session sorts 
Every time you open a main window such as contacts or 
properties you start a session. CRM temporarily stores each sort 
you run in memory during a session. Using the drop down 
combo box to the right of the Sort label (Figure 12-23) you can 
quickly recall sorts run during that session.  
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Figure 12-23: Drop down sort combo box 

When you select a sort from the drop down, CRM immediately 
executes the sort for you.  

When you Close the window it ends the session and CRM will 
release the temporary sorts from memory. When you re-load 
the window the drop down sort box will only contain the last 
sort ran.  

Editing a Sort in the same Session 
Ycan edit any sorts you have run in the current window using 
the Sort option on the main toolbar. Once you close any 
window the sorts you have not saved are lost. If you create a 
sort you want to use in the future make sure you save it. 

To edit a session sort: 
1. Open the Lookup menu and select Sort or {Qtrl+O}. 

2. The Sort dialog opens with the current sort fields listed.  

3. Make the changes you want and Click OK to execute the 
sort.  

NOTE: if you want to edit a previously executed sort pick it first 
in the drop down sort combo box and then edit it. The edit sort 
menu option always works on the currently set sort. 

Saving Sorts 
It is a good idea to save commonly used sorts as you build them 
so that you can use them again without having to recreate 
them.  
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1. While you are building a sort you can Click the Save 
button at the bottom of the Sort dialog. The Save Sort 
dialog opens. (Figure 12-24)  

 
Figure 12-24: Save sort fields dialog 

2. In the name field type a descriptive name for the sort. 
This will show in the list above under the name column 
for future reference. 

3. Set the query ownership by selecting a name from the 
drop-down. 

4. Assign the sort to a team, <everyone> or set it as private. 
Choose the team from the drop-down combo box.  

5. Click OK.  
6. You are returned to the Sort dialog and the sort is saved. 

Click OK to execute the sort or Click Cancel.  

Executing a Saved Sort 
Saved sorts are accessible via the Lookup menu. The table that 
you want to query must be open. To execute a saved Sort: 
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1. Open the Lookup menu and select Load Sort or press 
{Ctrl+O}  

2. Click the Load button on the Sort dialog. 

3. The Load Sort dialog opens. (Figure 12-25)  

 
Figure 12-25: Load sort fields dialog 

4. Double-Click on the sort you want to execute or select 
the sort and Click OK.  

5. Click OK from the Sort dialog to execute the sort. 

Editing a Sort 
1. Open the Lookup menu and select Sort or press 

{Ctrl+O}. The sort dialog opens with the current sort 
fields listed. 

2. Use the arrow keys to rearrange the sort. 
3. Click OK to execute the edited sort. 

To replace an Existing Query: 
1. From the Sort dialog create your sort and Click Save.  

2. The Save Sort dialog opens.  

Page 237 



Finding Records 

3. In the list of saved sorts, Click the sort you wish to 
replace. 

4. Click OK.  

5. Answer Yes to the prompt asking if you want to replace 
the existing sort. 

6. The Sort dialog opens and the sort is replaced with the 
newer definition.  

7. Click OK to execute the sort or Click Cancel.  

NOTE: Once you have overwritten an existing sort the only way to 
get it back is to recreate it. 

Deleting a Saved Sort 
1. Open the Lookup menu and select Sort.  
2. Click the Load button. 

3. Highlight the sort you want to delete. 
4. Click the Delete tool button. 

5. Click Cancel to close the Load Sort window.  

6. Click Cancel to close the Sort window. 

Changing the Properties of a Saved Query 
1. Open the Lookup menu and select Sort.  
2. Click the Load button. 

3. Highlight the sort you want to change. 
4. Click the Properties tool button. 

5. Click Cancel to close the Load Sort window.  

6. Click Cancel to close the Sort window. 

Groups 
Groups allow you to organize contacts into categories. Groups 
can be used for many things, including "Christmas card lists", 
“Newsletter recipients” or “Your personal Outlook sync”. 
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Groups can contain records from as many different databases as 
you like.  

The membership of a group is static. That is, you have to add or 
remove a record manually. This is the key difference between 
Groups and Views as discussed in the views section.  

Groups cross tables 
Another powerful aspect of groups is that records can be from 
different tables. That means you can have 3 records from 
contacts and 15 from properties and 10 from companies if you 
wish. When you are working on a project, activating a group 
immediately opens all the tables and records that are part of 
the group.  

Adding a Group 
1. Open the table to which you want to add a group.  

2. Open the View Menu and select Groups. This will open 
the "Groups" dialog. (Figure 12-26)  

 
Figure 12-26: Groups dialog 

3. In the Groups dialog Click New. (Figure 12-27)  
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Figure 12-27: Group properties dialog 

4. Enter a Name for the Group. The name you enter will 
display under the group column in the Group dialog. 

5. Select the table Type. If you want to use multiple tables 
select Unknown for the group. If this group only pertains 
to one table type select it and CRM will hide the group 
from the other tables. 

6. Select the Owner. 

7. Assign it to a Team or you can make the group private or 
available to <everyone>. On a group such as your 
Outlook contacts you would always want to make it 
private. On a group such as a newsletter you would 
probably make it visible to everyone or at least to your 
own team.  

8. Click OK to finish creating the group.  

Adding Records to the Group 
With a group or groups created, you can add records 
individually or as a group.  

To add a single record to a group: 
1. Locate the record you want to add to the group.  

2. In the Status panel, Click the box in front of the group to 
which you want the record added. If you can’t see the 
status panel, open the View menu and select Panels and 
then Status. (Figure 12-28)  
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Figure 12-28: Group list window 

3. The record is now part of the Newsletter group.  

To add multiple records to a group: 
1. Execute a query in your table to create a subset of 

records you want to add to a group.  

2. Open the Lookup menu and select Add to Group or 
Right-Click on the group and from the menu select Add 
to Group. 

3. All records in the query are added to the group. 

Editing a Group 
1. Open the View Menu and select Groups. This opens the 

Groups dialog.  

2. Click the Group you wish to edit and Click Properties.  
You can rename the Group, reassign it to a different 
Owner and/or reassign it a Team. 

3. Click OK. 
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Deleting a Group 
Deleting a group does not delete any records.  

1. Open the View Menu and select Groups. This opens the 
Groups dialog.  

2. Click on the Group you wish to delete 

3. Click Delete.  
4. Click OK. The group is deleted and cannot be recovered. 

This will not delete the records from the table. 

Querying a Group 
1. Click on the View menu and select Groups.  
2. Double-Click on the name of the group or Click the 

Activate button. This will bring up only the contacts 
within the specified group. 

3. Open the Lookup menu and select Query.  

4. Enter your query criteria and Click OK.  
Only the records that are in the group are searched to match 
the query.  

To release the query use {Ctrl+R} or open the Lookup menu 
and choose Every record. The table reverts back to all the 
records marked in that group. 

Validate Query 
Validation is CRM's way to assist you and your team(s) in 
entering data in records so that it is consistent. This feature is 
query based and monitors keystrokes as you edit or add 
records. If the record does not meet the validation criteria, a 
warning dialog appears and you cannot leave the record until 
the criteria is met.  
Each team can have a single validation query for the various 
tables.  When a contact is entered, Team 1 might want to force 
a new record to have an email address included and Team 2 
might want to have the cell phone required.  
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Or, for a property record, Team 1 might require last sold date 
and Team 2 might require total square foot and Team 3 might 
want something else.  
In any case, you cannot create one validation for companies, 
contacts etc. that affects all teams entries across the board. This 
means that if Team 1 and Team 2 and Team 3 all want the email 
field to be a required field, you must create a separate 
validation query for each team, with the exact same criteria.  

Some examples of potential users: 
 If you set up a validation custom view for "contact's 

email address field is not empty", whenever you have 
that custom view active and you attempt to delete the 
email address for a contact, it will pop a reminder 
telling you that there are fields that should have a value 
but are not filled in and will not let you continue until a 
value is filled in for that field or those fields. 

 If you mark a property FOR SALE you must enter a sale 
price. 

 If you enter a tenant lease commencement and 
expiration you must enter the term.  

 Another scenario where this feature is useful is if you 
hire someone to come in and add records to the 
database for you. You can set up rules so they don't 
accidentally miss some information you want. 

To create a validation query: 
1. Create a query as outlined in creating a query.  
2. When you Name the query you must call it Validate 

<Table name>. Valid names are as follows 
VALIDATE CONTACT 

VALIDATE PROPERTY 
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VALIDATE SPACE 

VALIDATE COMPANY 

3. Select Type if different from the current table. 

4. Select the Owner. 
5. Assign it to a Team. This validation will only work on 

records that are assigned to the team it was created for. 
You can create one validate query for each table per 
team.  

As you enter/edit records, if you fail to meet the criteria that 
you have set in the validation view, CRM opens a warning dialog 
and informs you as to which criteria has been violated and what 
you need to do to correct it. You cannot close or move off the 
record until you make the correction(s). 
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Lists 
Overview 
CRM allows you to view either all or a select group of records in 
a list format. This allows you to easily view the contacts, 
companies, properties, comps and spaces in a spreadsheet 
format. You can sort the records by any combination of fields 
and export the records to either Microsoft Word or Microsoft 
Excel. (Figure 13-1) 

 
Figure 13-1: List Window 
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Opening the List Window 
From a table view such as Contacts, Properties or Spaces press 
{F5} or from the View menu choose List. 

The lists window shows a list of all of the records in your current 
query (or all records if you have no query set) in a spreadsheet 
format. At the bottom - left side, CRM displays the number of 
records in the list and which number out of the total you are 
currently highlighting (Figure 13-1 ). 

Sorting the List 
Single Column Sort 
To sort the list by a single column you can just double Click on 
the column heading in the list window. The list will be sorted 
from lowest to highest. 

Multi Column Sort 

 
Figure 13-2: Use this drop down to sort the list 

You are able to sort the list by any of the available fields in CRM. 
For example, you could sort a list of contacts first by the 
company name, then by the last name, and then by the first 
name. Being able to sort contacts by multiple fields can be 
extremely helpful in a larger database where you have contacts 
with the same name. 

To sort the list:  
1. Click on the dropdown box next to Sort. This dropdown 

contains the pre-selected sort orders or any sort orders 
you have recently used, and Sort, which allows you to 
create a new sort order. (Figure 13-2) 

2. For details on creating a sort order see Chapter Twelve 
Sorting. 
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Creating a Field List 
When viewing the list mode, you are able to select exactly 
which fields you wish to show. This gives you full control over 
the data you are viewing and what information you export. 

Rearranging columns in the list 
You can quickly change the order of the columns in a list by 
clicking on a column header and dragging the column to a new 
location in the grid. (Figure 13-3) 

 
Figure 13-3: Dragging columns in a list 

If you want to save the new format you need to follow the 
instructions under Saving a New Field List later in this chapter. 

1. To select fields to list, press {Ctrl+I} or from the menu, 
select List and then Fields or use the drop down list titled 
Fields and choose Fields. (Figure 13-4 )  

 
Figure 13-4: Field list 

2. In the Fields dialog choose the fields to list. (Figure 13-5) 
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Figure 13-5: The Fields dialog  

The Fields column lists all of the available fields in Realnex CRM. 
The Selected column lists the fields that are currently being 
shown in list mode.  

3. To add a field to the Selected column, Double-Click the 
field you want to add or highlight the field and Click on 
the button with the arrow pointing towards the right. 
(Figure 13-5 )  

4. To remove fields from the list double Click on the field 
you want to remove or select the field and Click on the 
button with the arrow pointing towards the left. (Figure 
13-5 ) To remove all of the selected fields, Click on the 
button with two arrows pointing toward the left. (Figure 
13-5 )  

5. From this dialog, you may also select the order in which 
the fields appear. The fields in the list window will 
appear in the list window from left to right in the same 
order as they appear from top to bottom in the selected 
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column window. To move a field up or down, use the 
buttons with the arrows pointing up and down on the 
right side of the dialog box. (Figure 13-5 )  

6. Once you have selected the fields and the order in which 
to show the fields, Click OK. (Figure 13-5 ) 

7. CRM displays the fields you choose. The list is not saved at 
this point. If you want to save the list, continue to the next 
section, Saving a Field List. 

Saving a New Field List 
1. Click the List menu and select Fields, or press {Ctrl+I} to 

open the Fields window. 

2.  Click the Save button. (Figure 13-5 ) 
3. The Save Fields dialog loads. (Figure 13-6)  

 
Figure 13-6: Save field list 

4. Enter the name for the field list. This will be used in the 
name column for later use so make sure the name is 
descriptive of the list. 

5. Set the owner of the list. 
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6. Set the team that can use this list. 

7. Click OK. 

Replacing an Existing Field List 
1. Click the List menu and select Fields or press {Ctrl+I} to 

open the Fields window. 
2.  Create the field list you want to save. 

3. Click the Save button. (Figure 13-5 ) 
4. The Save Fields dialog loads. (Figure 13-6)  

5. Highlight the list you want to replace. 

6. Change any information you want. 
7. Click OK. 

Deleting an Existing Field List 
1. Click the List menu and select Fields or press {Ctrl+I} to 

open the Fields window. 

2. Click the Load button. (Figure 13-5 ) 
3. Highlight the list you want to delete. 

4. Click the Delete tool button. 
5. Click OK or Cancel to close the Load Fields window. 

6. Click OK or Cancel to close the Fields window. 

Synching the List with a Record View 
To make the List window faster, CRM does not automatically 
synchronize it with the main table window. That means that as 
you move through the list, the main table window will not 
change. 

If you would like the main table window to change with the List 
window you can Click the Sync button (Circled in Figure 13-7) or 
open the List menu and choose Synchronize. 

If the list window is in synchronize mode each record you move 
to will also be displayed in the main window. (Figure 13-7) 
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Figure 13-7: List window synchronized with contact window 

Exporting lists to Word or Excel  
CRM has the capability to easily export the list to either 
Microsoft Word or Microsoft Excel.  

1. Query for the records you want to export. 

2. Bring up the List Window. 

3. Select the fields you want to export 
4. Click on the button to either export to Microsoft Word  

or to Microsoft Excel . (#1) 
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5. The progress window opens. (Figure 13-8) 

 

Figure 13-8: The export progress window 

Once CRM has finished exporting the records to either 
Microsoft Word or Microsoft Excel, it opens that application 
with the list of fields and the sort order that was being used in 
Realnex CRM. 

Checking for Duplicate Records 
Duplicate records are a common problem in shared databases. 
Merging the duplicate records with all the history, links, events, 
notes, groups etc. can be very tedious. The CRM duplicate 
checking engine will make merging duplicates simple. 

Creating a duplicate list 
1. Open the table you want to check 

2. Set any query you want, the duplicate checker will only 
look at the records in the current view. 

3. From the Lookup menu select Check for Duplicates. 
(Figure 13-9) 
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Figure 13-9: Check for Duplicates Dialog 

4. Double Click each field in the field’s window that you 
want to base your check on. 

5. The order of the fields in the selected panel will also 
determine the order of the records in the duplicate list 
window. 

6. For each field you can check the Ignore empty field box. 
Checking this will force CRM to skip any records that 
contain blanks in that field. 

7. Set the Match criteria for each field. 

a) Exact: The two fields must match exactly 
b) Fuzzy: Everything is removed from the field except 

letters and numbers and then the fields are compared 
and the remaining characters and numbers much 
match exactly 

c) Sounds like: A Fuzzy search is done and additionally 
letters such as “C” and “K” are treated as the same 
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letter except when the letter is the first letter in the 
word. 

8. Click OK to execute the duplicate checker. 

Saving a Duplicate List 
1. Click the Lookup menu and select Check for Duplicates. 

2. Select the fields you want to use. 

3. Click the Save button. 

 
Figure 13-10: Save Fields dialog 

4. From the Save Fields dialog (Figure 13-10) type the name 
of the list you would like to create. 

5. Set the owner and the team. 

Renaming an Existing Duplicate List 
1. From the Duplicate List Window. 
2. Select the List menu and Click Display fields or use 

{Ctrl+I}. 

3. Click the Save button from the Display Fields window. 

4. From the Save Fields dialog (Figure 13-10) Click on the 
existing field list you want to rename. 
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5. Type the new name. 

6. Set the owner and the team. 

7. Click OK. 

Using an Existing Duplicate List 
1. From the Lookup menu select Check for Duplicates. 

(Figure 13-9) 
2. Click the Load button. 

 
Figure 13-11: Load Field dialog 

3. Select the list you would like to use and Click OK. 
4. Click OK from the Display Fields list. 

Merging Duplicate Records 
ou can merge duplicate records in the company, contact and 
property databases using the List window {F5}. This feature 
is used instead of deleting a duplicate if there are existing 
ancillary records such as history on the duplicate record. 

1. Drag the record you want to merge (source record) and 
drop it onto the record you want to keep (target record). 

Y 
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2. CRM will prompt you with the Merge Records dialog. 
(Figure 13-12) 

 

Figure 13-12: Merge Records dialog 

The following rules apply when merging records. 

 The source record will be deleted and the target record will 
be kept. 

 If there is a conflict the data in the target record will be 
kept and the data in the source record will be lost. For 
example if both records have a work phone number the 
phone number from the target record will be kept in the 
field. 

 If a field in the target record is empty and the same field in 
the source record has information the information from 
the source record will be copied into the empty target 
records field. 

 If the field property is set to use Comma-separated values 
(csv) the information from the two fields will be merged. 
For example if the Investor Type field was set to use “csv” 
and one record contained the values “PE,RE” while the 
other contained the values “IN,RE” the new merged record 
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will contain the value “PE,RE,IN”. For information on 
setting a fields properties see the section in this manual on 
setting up field properties. 

 All events, history, links, attachments and notes will be 
merged. 

 Once the source record has been merged with a target 
record the source record cannot be recovered. 

Note: You can avoid the merge records dialog by holding down 
the shift key as you drag and drop the source record onto the 
merge record. 

Page 257 





 

 
MS Office Integration 
Overview 
CRM combines with the strength of Microsoft Office to make 
correspondence, faxing, analysis, email and PDA connection 
possible. You must purchase Microsoft Office version 2003 or 
above to use these capabilities in CRM. 

Outlook 
When you open Outlook to view your email, incoming messages 
can automatically be attached as a history record to the contact 
in CRM. This only works if the incoming email address matches 
the email address stored in CRM. Once it is setup, you do not 
have to do anything, CRM does it all for you.  

User Driven Contact and Events Synchronization 
In addition, you can synchronize your calendars and contacts 
between CRM and Outlook. This type of synchronization is user-
driven. That means you decide when and if you want to 
synchronize your calendars and/or contacts between CRM and 
Outlook.  

Before you can begin, you must configure CRM to work with 
Outlook.  
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Setting up Outlook to work with CRM 
To configure Outlook to work with CRM, you must 
enable Realnex CRM extensions for Outlook.    

1. Start Outlook. 

2. Go to the Tools Menu 
3. Select Options 

 
4. In the Options window select the Realnex CRM tab 
5. Click the checkmark to Enable CRM extensions for 

Outlook 

6. Click the Server Options button. 
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7. Click the Browse button (three dots) to locate the 
installed instance of CRM. A dialog box should appear 
listing all instances of SQL running on your system. Select 
the CRM instance.  You can also load Realnex CRM to 
find this information. From Realnex CRM Click the File 
menu and Click Log In. Copy the information from that 
dialog box into Outlook. 

8. Click OK. 
Use Windows 
Authentication:  

We prefer you use SQL Server 
Authentication. 

Use SQL Server 
Authentication: 

This is the preferred option for access 
to CRM.  

NOTE: If your system has an installed instance of SQL and the 
administrator has changed login, enter the login here. Otherwise, 
no change is necessary.  

Login:  Your Realnex CRM Login.  

Password: Your Realnex CRM Password 

9. Click the Email Options button. 
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10. History Record settings 
a) Subject date and time only is recorded while the 

message text is not stored in the CRM history record. 

b) Message text is stored in the notes section of the 
history record along with a) above. 

c) Attach a copy of the email will create a linked 
attachment for each email message you receive. 

d) When Outlook creates the history record in CRM it 
will associate the record with the Team set in this 
box. 

e) Use my default team: This option will instruct Outlook 
to use whatever team is set as the Default Team in 
your CRM Options dialog. 
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f) Link history records to companies as well as contacts 
will attach the history to both the contact and the 
company that contact is linked to. 

11. On outgoing email. If you include a Cc or Bcc in your 
outgoing email those will each be linked to the email 
history in CRM if you check these boxes.  

12. Create History Automatically. Checking these options 
instructs Outlook to attach every incoming and/or 
outgoing email to the matching CRM contacts 
automatically. Regardless of these settings you can 
manually attach any emails to the corresponding history 
records. 

13. Click OK to save the email settings.  

Performing an Email Sync to Outlook 
  
If Outlook is set to automatic mode you don't have to do anything. 
As emails are received or sent from Outlook they will be 
automatically attached to every existing contact in your system. 

Manually adding Single Emails to History 

1. Open Outlook. 

2. Highlight the email you want to attach to CRM. 

3. Click the CRM History button on the Outlook Toolbar. 

4. Fill in the CRM History dialog (make sure you link the 
correct contacts). 

5. If you want the email attached check the "Attach 
document check box". 

6. Click the Follow Up button if you want to create a follow 
up event to this email. 
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Manually adding multiple emails to History 
1. Open Outlook. 

2. Highlight the emails you want to attach to CRM records. 
3. Click the CRM History button on the Outlook Toolbar. 

4. When selecting multiple emails you will not be given the 
option to select who the emails are linked to. CRM links 
them automatically to the sender or recipient. If no 
matching email is found in CRM the email will be created 
as an unlinked history. 

5. You cannot create a follow up for multiple emails.  

Logging a New email or a Reply to History 
1. Press the New, Forward or Reply button in Outlook 

2. Write your email. 
3. Instead of clicking the normal Send button in Outlook 

Click the Send w/CRM History button, see example 
below. 

Outlook 2003 Example 
  

 
  

Outlook 2007 Example 
The interface changed from the standard menu's to Ribbons in 
Outlook 2007. You'll find the Send w/CRM History option on the 
Add-Ins Ribbon, see the example below. 
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Syncing Contacts and Calendar 
CRM syncs the basic contact information with Outlook. The 
fields included are, name, company, address, email, web, notes 
and four phone number fields; work, fax, mobile and home. 

CRM also syncs the basic calendar information to Outlook. The 
fields included are date, time subject and notes. 

CRM is capable of storing many more contacts than you might 
want in Outlook or your PDA. To select which contacts are 
included in the sync you create a group in CRM and add the 
contacts to that group. 

Creating a Sync Group 
Add a Group to CRM 
Before you can sync contact records from Realnex CRM to 
Outlook you must add the contacts to a group. 

1. Open the Realnex CRM Contact table. 

2. Right-Click in the group window and select New Group.  
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3. Name the group  (Your name) Outlook Sync and set 

the team to Private.  

 
 

 
4.    Add the contacts you want to sync 
with Outlook to the group by checking 
the box in front of the group you made. 
You can add the contacts one by one or 
you can mass add contacts to the group 
using the Add Lookup option from the 
group menu.  
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To add multiple contacts to a group. 
1. Query your contacts so you have the correct records 

visible. 

2. Right-Click on in the group window. 
3. Click Add Lookup 

4. CRM will automatically add all the visible contacts to the 
group for you.   

Configuring CRM with Outlook 
The first step is to configure your CRM and Outlook contacts. 
Outlook has a simplified contact screen and is not capable of 
holding the detailed information that CRM does. The CRM to 
Outlook sync will concentrate on the main address and phone 
fields only. 

 
Synchronize CRM and Outlook contacts 

First time contact sync 
ALL contacts in Outlook will be added to CRM and all 
contacts (in the selected group) will be added to Outlook, 
there is no duplicate checking done. This means that if you 
have the same contact in Outlook and CRM it will be 
duplicated. Before you do your first sync between CRM and 
Outlook you should remove the contacts from Outlook that 
are already in CRM or create a second address book in 
Outlook and move your contacts into that alternate address 
book. 
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The CRM categories located at the top of the Contact Info 
panel will be synched to Outlook. New categories will be 
created in Outlook for each of the six check boxes. The 
name of the field will be prefaced with CRM, for example 
CRM Investor, CRM Tenant, CRM Agent, CRM Vendor, CRM 
Personal and CRM Prospect. If you uncheck one of those 
categories in Outlook and sync to CRM the check box will be 
automatically unchecked in CRM and vice-versa. 

Home Address / Other Address 
If you have marked the address in CRM as the Home 
address CRM will sync that address to the Outlook Home 
address field.  

Second and subsequent contact syncs 
All new contacts added to Outlook since the last sync will be 
added to CRM and new contacts added to CRM since the 
last sync will be added to Outlook. Any changes made to 
contacts in Outlook will be made to the matching CRM 
contact and changes made to CRM contacts will be made in 
Outlook. If the same record was changed in both Outlook 
and CRM the setting you make in the Conflict Resolution 
will be followed. 

Export CRM contacts to Outlook 
The contacts marked in the selected CRM group will be 
exported into Outlook. There is no duplicate checking or 
record updates. Any records already in Outlook will remain 
as they are and the new exported records will be added to 
those existing records. 

Import Outlook contacts into CRM 
All the contacts in the selected Outlook address book will be 
imported into CRM. There is no duplicate checking or record 
updates. Any records already in CRM will remain as they are 
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and the new imported records will be added to those 
existing records. 

Do not synchronize contacts 
This option forces CRM to skip the contact section. 

Configuration 

  

CRM group: Only the records that are marked in the selected 
CRM group will be synchronized with CRM. If you take a contact 
out of the selected group in CRM (uncheck them from the 
group) or delete the contact from CRM they will be removed 
from your Outlook address book. If you delete a contact from 
your Outlook address book that contact will be removed from 
your CRM group when you sync but the contact WILL NOT be 
deleted in CRM. You can only delete a contact from CRM while 
you are in CRM.  

Outlook Folder: Outlook allows multiple folders for contact data 
with the default folder being Contacts. If that is not the folder 
that contains the Contacts you want in CRM, Click the Browse 
button and select the correct folder.  

Team: In addition to grouping the contacts, you can designate 
every contact as part of the Private (or any other) team in CRM. 
By selecting Private, only you will be able to access those 
contacts. 
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Conflict Resolution 

 
When a contact is changed in both CRM and Outlook, a conflict 
occurs when the next synchronization is attempted. Rather than 
lose valuable data, CRM handles this as per the options offered: 

If you select the first option, the old Outlook record is moved 
into a special folder in Outlook named Conflict. It is then 
entirely replaced by the contact record from CRM. You can open 
the Conflict folder and see the old record and recover any data 
that you might need.  

If you select the second option, CRM overwrites the Outlook 
contact record.  

If you select the third option, the Outlook contact record 
overwrites the contact record in CRM.  

A best practices recommendation would be to always make 
your changes in CRM and then select the first option for 
synchronization. That way, when you synchronize and CRM 
replaces an Outlook contact record and you recognize data is 
missing, you can recover it from the Conflicts folder.  
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Synchronize CRM and Outlook events 
Action 

 
First time event sync 

ALL appointments in the selected Outlook calendar will be added to 
CRM and ALL events in CRM will be added to Outlook, there is no 
duplicate checking done. This means that if you have the same 
appointment in Outlook and CRM it will be duplicated. Before you 
do your first sync between CRM and Outlook you should remove 
the appointments from Outlook that are already in CRM or at least 
create a second calendar folder in Outlook and move your 
appointments into that alternate calendar folder. 

Second and subsequent event syncs 

All new appointments added to Outlook since the last sync will be 
added to CRM and all new events added to CRM since the last sync 
will be added to Outlook. Any changes made to existing 
appointments in Outlook will be made on the matching CRM event 
and changes made to existing CRM events will be made to the 
Outlook appointment. If the same record was changed in both 
Outlook and CRM the setting you make in the Conflict Resolution 
will be followed. 
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Export CRM events to Outlook 
The events in CRM will be exported into the selected Outlook 
calendar. There is no duplicate checking or record updates. Any 
records already in Outlook will remain as they are and the new 
exported events will be added to those existing records. 

Import Outlook events into CRM 
All the appointments in the selected Outlook calendar will be 
imported into CRM. There is no duplicate checking or record 
updates. Any records already in CRM will remain as they are and 
the new imported records will be added to those existing records. 

Do not synchronize events 
This option forces CRM to skip the event section. 

Configuration 

 

My personal events only… Only events that you own will be 
synced to Outlook.  
All events on my schedule 
All events that you are allowed to see will be synced to 
Outlook.  
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Do not synch events older than…Choose a time limit for older 
events to be sent from/to CRM or from/to Outlook.  This setting 
is useful to see historical events in either CRM or Outlook that 
originated in the other program. If you have been using Outlook 
and then add CRM, you might want all past meetings to appear 
in the CRM calendar.  

Mark events finished if older than … Use this setting to 
automatically show events as finished. If you add Outlook 
events to CRM, you can have any event older than 30 days (or 
whatever time limit you choose) to be marked as finished.  

Skip these event types If there are specific event types you do 
not want synched to Outlook (and/or your PDA) you can set the 
event types to skip. Since CRM also allows you to create as 
many event types as you want you could create certain event 
types and use those to schedule events you do not want 
synched to Outlook. 

 

To exclude specific event types from a sync Click the 
change button and check the event types you do not want 
synched to Outlook. If you change your mind and want to 
include those event types you can always uncheck the 
event types and sync. 

 

Outlook folder Select the folder with which you want events to 
synchronize. The default folder is Calendar, but you can select a 
different folder if your events are in a different folder.  

For new records imported from Outlook: Use this option 
to assign imported events to a specific team. By default, events 
are assigned to the Private team meaning that only you can see 
them. Select a different team if desired.  
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Conflict Resolution 

  

If events are in conflict between CRM and Outlook, you can 
select an option to handle those conflicts: 

If you select the first option, the old Outlook record is moved 
into a special folder in Outlook named Conflict. It is then 
entirely replaced by the contact record from CRM. You can open 
the Conflict folder and see the old record and recover any data 
that you might need.  

If you select the second option, CRM overwrites the Outlook 
contact record.  

If you select the third option, the Outlook contact record 
overwrites the contact record in CRM. 

Click OK to finish the setup for Synchronization.  

Performing the Contacts and Event Sync 
Synchronizing data between CRM and Outlook is the way you 
keep information up to date in both programs. For example, if a 
contact is in CRM and you want it to be in Outlook you need to 
synchronize for that to happen. If you subsequently change the 
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phone number for that contact in CRM, you must synchronize 
again for that change to appear in Outlook.  

The initial synchronization takes more time as all the data has to 
be synchronized. After that, only changed data is exchanged 
and so it happens quickly. 

CRM does not automatically sync your contacts and calendar to 
Outlook you must initiate the action. 

Before you can sync your contacts and calendar to Outlook you 
must have set up an CRM Group and configured the sync. For 
steps on setting up your Outlook Sync Group and Configuring 
Contacts and Events see read the previous sections in this 
chapter. 

1. Start CRM. 

2. Click the File menu and select Synchronize and then 
select Microsoft Outlook… menu item or Click the 
Outlook Tool button on the CRM Toolbar.  

 
3. The CRM Synchronizing with Microsoft Outlook dialog 

appears. 

  

 CRM will respond with the Ready to Synchronize Dialog. 
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If your system is configured just press OK to begin the sync. 

VERY IMPORTANT NOTE FOR FIRST TIME SYNCS: 

ALL contacts in Outlook will be added to CRM and all contacts 
(in the selected group) will be added to Outlook, there is no 
duplicate checking done. This means that if you have the same 
contact in Outlook and CRM it will be duplicated. Before you do 
your first sync between CRM and Outlook you should remove 
the contacts from Outlook that are already in CRM or create a 
second address book in Outlook and move your contacts into 
that alternate address book. 

Second and subsequent contact syncs 
All new contacts added to Outlook since the last sync will be 
added to CRM and new contacts added to CRM since the last 
sync will be added to Outlook. Any changes made to contacts in 
Outlook will be made to the matching CRM contact and changes 
made to CRM contacts will be made in Outlook. If the same 
record was changed in both Outlook and CRM the setting you 
make in the Conflict Resolution will be followed. 
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When CRM is finished synching your records it will show you 
any conflicts area .  

 

 

 

1. To keep a text file record of the changes that were made 
during the synchronization process, Click the Save Log 
button.  

2. Create a name for the log file and Click Save. This file can 
be opened in any word processor to verify what occurred 
during the synchronization.  

When the sync is finished Click the Close button. 

Viewing Synchronize Conflicts 
CRM creates a folder in Outlook with any conflicts if you have 
set your options to do so. 

To review conflicts do the following in Outlook: 

1. Start Outlook 
2. Go to the Contacts or the Calendar folder(s) and look for 

the Conflicts sub folder.  
3. Open the CRM Conflicts Folder 
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4. Review the conflicts. 
5. Make any changes to the records in your primary 

Outlook database 
6. Delete the conflicts.  

Mail Merge 
CRM supports multiple mail merge formats. You can mail merge 
to contacts, companies, properties and spaces. All mail merge 
formats require you have a document template setup in CRM. 
You can create as many templates as you want and use them 
over and over. 

It’s a good idea to create basic templates that you can use on 
the fly as well as templates that are ready to use without any 
changes. 

An example of an on-the-fly template might be a Quick Letter. 
You create a template that contains the fields for the current 
date, the contacts address information, and your signature line. 
You can use this template to create a letter on-the-fly. 

An example of a ready-to-go template would be a listing 
package. You create the entire package as a template with the 
merge fields in it and then you send it as is. 

About Document Templates 
CRM uses templates to create all merged documents. You can 
create as many templates as you want and you can select who 
can use those templates. Some examples would be fax cover 
sheets, company letter head, sales templates, envelopes, labels 
or standard letters. 

The first thing you should do is create some basic templates; 
once you get the hang of it you can create more complex 
templates such as listing agreements, brochures or 
questionnaires. 

Page 278 



Chapter Fourteen  

What is a Merge Fields 
A Merge Field is a special field inserted into your template that 
allows you to pull specific data from CRM and insert it into your 
letter where you have chosen to do so. When the template is 
used it will replace the mail merge field with actual data from 
the record. This works the same in all Templates, Letters, Labels 
and Reports. 

Creating a Template 
First open the database you want to mail merge from. Each 
template must be created for the correct table. 

Once you have the correct table open click Write | Document 
Templates 

Templates View Window 
In the CRM interface Click on the Write button in the top menu. 
A new window appears entitled Document Templates. 

From the Document Templates window Click New or Copy 

 

Clicking New creates a blank Template. If you already have a 
template that is similar to the new one you are creating you can 
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highlight the existing template and Click Copy. That will create a 
new template based on the existing one saving you some work.  

Template Properties Window 

 

Description: Enter a description of what this template will be 
used for. This description will show up in the Document 
Template window so make the description useful. 

Type: Choose letter, email, fax, envelope or label depending on 
what you are trying to create. 

For: Contact. 

Owner: The owner of this Template has all rights to make 
changes. 

Team: The selection made here will decide who can see this 
template.  
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Show Documents on Menu: Selecting this option will put the 
document on the write menu for the members on the team 
selected. 

Sub menu: If you want to add this template to a sub menu under 
the write menu type in the name of the menu you created here. 

Creating a Template 
1. Click the Write Menu in CRM and choose Document 

Templates. 
2. Click New. 

3. Enter a Description for your email template. 

4. Set the Type so CRM knows if this is an email, envelope, 
letter or mailing label. (A fax is considered a letter) 

5. If you would like the template to show on the write 
menu, check Show template on menu and under 
Submenu add the menu you want to create. You can 
create other templates and enter the same submenu 
name to have them all show up under the same 
submenu. 

6. If you don't want anyone else to see the email set the 
Team to Private. 

Setting the history defaults for a template 
1. Click the History Tab. 
2. Click Edit. 

3. The Event type will be automatically filled in with the 
template type when you send the email. 

4. Fill in all the other fields for the history with whatever 
defaults you want and when you use the template CRM 
will offer to create a history for you and pre-fill all the 
fields with these defaults. You can change any value each 
time you use the template to email someone. 

5. Click OK. 
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6. Click OK again to create the template and open Word. 

Selecting the fields to merge 
CRM allows you to select any fields from the table you want for 
your merge. The more fields you choose the longer it will take 
so you only want to choose fields you are actually using in your 
merge document. 

Check any fields you want and click OK to save the properties. 

From the CRM Tools | Administration | Global Settings menu 
you can set the default fields for all mail merge templates. 

Typing your Document Template 
1. In Word you can use the Insert Merge Field option to add 

fields such as <greeting> or <First name> to your 
template. Type any text you want, add Hyperlinks and 
pictures. 

2. Save the document in Word DO NOT CHANGE THE NAME 
or LOCATION of the Document. 

Once you are finished creating your template and have saved it 
make sure you close the template in Word. 

Performing a Mail Merge 
Once you have created your templates you can use them over 
and over again. 

1. Click the Write menu. 

2. Click Mail Merge. 

3. Select the merge type (see description below). 
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Manual Merge Type 
The manual option is the most flexible option. Using this option 
you can create Letters, Envelopes, Emails and Faxes with the 
added advantage of making changes to the document before 
you actually send it. The disadvantage of this method is you 
cannot attach any files (for email merge) and you have to tell 
Word to finish the merge. 

Letters, Envelopes, Labels and Fax Options 
Using any of these options will give you all the options a manual 
merge does except when CRM opens Microsoft Word the merge 
will already be done. If you have a pre-written template that 
you don’t need to change OR if you are only sending the merge 
to a single contact these are the options for you. 

Email 
The Email option offers one major advantage over the Manual 
email method. Using the Email option allows you to attach as 
many files to an email as you wish. The disadvantage is you will 
not have a chance to edit the email. CRM will automatically 
create the email from the template you chose. 
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4. Select Current contact or the contacts in the current 
query. Selecting contacts in the current query will create 
an individual document for every contact record CRM 
can currently see. 

 

5. If this is a mail merge that needs an address you need to 
select which address you want CRM to use. 

a) Mailing address will select the address you have 
marked at the address to use for mailings in CRM. For 
more information on setting that value see the 
chapter on adding contacts to CRM. 

b) Work address will select the primary address or if 
there are two or more addresses it will select the 
address marked as Work. 

c) Home and Other address will select the address 
marked as home or other respectively 
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If you chose Work, Home or Other as the address to use you will 
have access to the third section in this dialog. If for example you 
asked CRM to mail merge to the home address for each record. 
If CRM came to a record that didn’t have a home address you 
can set the merge to use the primary address on the contact or 
skip the contact entirely. 

6. Click Next. 
7. Select the Document Template to use 

8. Click Next. 
9. Step 9 depends on the merge type you have selected. 

We will cover all four types in this section. Please pick 
the section that applies to the merge type you are doing. 

Letter Merge 

 

If this is a letter you can choose to create envelopes or mailing 
labels by checking the “Create envelopes or mailing labels” 
check box and selecting the template to use. (this dialog will be 
skipped for other template types). 
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Envelope/Label Merge 
Step 9 does not apply to this selection. 

Email Merge 

 

Step 9 for an email merge allows you to attach as many files to 
your email as you want. You can also enter the subject for the 
email here but the text in the email will come directly from the 
template you selected you will not be able to edit that before 
you merge the email to your clients. 

The attachment will show up just like any other attachment you 
make in Outlook. 

Using the HTML option will create the email with all the 
formatting and include hyperlinks. Using the Plain text mode for 
your email will create an email that any program can read but it 
will also remove all the formatting. If you are sure all of your 
clients use a standard email program such as Outlook you 
should use HTML as the option. 
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Fax Merge 

 

Step 9 on a Fax Merge you set the options that Microsoft Fax 
can use to distribute your fax.  

10. If you would like to keep a historical record of this merge 
check the “Create history record” option and fill in the 
history. If you don’t want a history created for each 
contact just uncheck the option. 

11. Click Next to perform the merge. 

Quick Email 
Emailing to the Default Email Address 

 
1. Find the contact you want to send an email to. 

2. Make sure the contact has an email address. 
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3. Click the button in front of the email address to send a 
quick email. 

Emailing to Alternate Email Addresses 

  

1. Find the contact you want to send an email to. 
2. Click the Alternate tab above the contacts name. 
3. Find the email address you want to use in the list. 
4. Click the button in front of the email address to send a 

quick email.  

Sending an Email with Attachment 
To add an attachment to a saved email you must have pre-
written the email in CRM and saved it as a template. You will 
not be able to edit the email in this situation. Refer to the Mail 
Merge section above for the steps to complete an email merge 
with attachments. 

Quick Mail Merge 
You can skip some of the mail merge steps if you are creating a 
merge for a single contact by placing the document on the write 
menu. 

To place any document template on the write menu check the 
“Show template on menu” option in the template properties. 

1. Click the Write menu. 

2. Highlight the template you want to add to the write 
menu. 
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3. Click the properties button. 

4. Check the “Show template on menu” option. 

 

5. If you want to arrange multiple template under a 
submenu type in the name of the submenu you want. 

6. Click OK. 

7. Click Close. 

Merging a template from the Write menu. 
1. Look up the contact. 
2. Click the Write menu and (click the Submenu if 

applicable). 

 

3. Select the saved template you want to use from the 
menu. 

4. Create a history if you want to. You can also have CRM 
attach a copy of the document with the history record if 
you check "Attach document".  
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If you do not get the history dialog open the Tools | Options 
menu and click the Events/History tab. Check Offer to create 
history for quick letters and/or email. If you have set up Outlook 
to record emails you probably don’t need to create a second history 
for emails. 

5. Email or Print the merge document from Word. (see the 
steps below for your version of Office). 

Sending an email from Office 2003 

 
6. Click the correct merge button (shown in picture above). 
7. Go to Fill in the Merge to E-mail window section below if 

you are doing an email merge. 

Sending an email from Office 2007 

 
8. Select the Mailings Ribbon. 

9. Click Finish & Merge. 

10. Click the correct option. 
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Fill in the Merge to E-mail window 

 
1. If you are email merging select Contact_Email for the To: 

field. 

2. Type in your subject line for the email. 
3. Click OK and you email will be sent to Outlook. 

Performing an Email Merge 
Realnex CRM works in conjunction with Microsoft Office to 
create an email merge. 

You can send any document through email to one or more 
contacts using this feature. 

For detailed steps read the section on email merge in this 
chapter. 

Microsoft Excel 
You can attach Microsoft Excel spreadsheets to the history 
records for contacts, companies, properties and all the other 
tables in CRM. 

You can also export your information from the CRM list window 
directly to an Excel spreadsheet and you can send reports to 
Microsoft Excel. 

Exporting to Excel 
You can export information from CRM using the List Window 
{F5} from any table. 
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For more information on the list window including the export 
function see the chapter on using the List feature in CRM. 

Attaching a Spreadsheet to CRM 
You can attach your Excel Spreadsheet to the history of a single 
record or any combination of records in CRM. 

Excel 2003 
To connect an Excel Spreadsheet Click the CRM History button 
on the Excel toolbar or from the Excel Tools Menu Click CRM | 
History. 
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Excel 2007 

 

To connect using Excel 2007 Click the Add-Ins Ribbon on the 
Excel toolbar and then Click History. 

Excel will try to automatically connect to the CRM Server if it 
can't you will be prompted to log in. 

Use the "Log In" option if you want to connect to a different 
server or account than your default. 

Use the "Log Out" option if you want to be prompted for a 
server and account the next time you create a history record. 

Excel displays the CRM History Dialog for you to fill in. 
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Click the Linked to section and select the linked record. 

To select a single record Click the down arrow. 

To select multiple records Click the button next to the down 
arrow. 

When you have completed filling in the history record Click 
{OK}. CRM automatically saves a copy of your spreadsheet to 
the Realnex CRM Shared folder. DO NOT change the name of 
the spreadsheet or the location. 

If you make changes to the spreadsheet after you have created 
the history record make sure to Click Save in Excel or your 
changes will be lost. DO NOT change the name of the 
spreadsheet or the location. 

Viewing a Saved Spreadsheet from an CRM History Record 
1. Find the record that has the attached spreadsheet in 

Realnex CRM. 

 
2. Click the History Tab at the bottom of the record. 

3. Right-Click on the correct history record and choose 
Attachment | Open. 

4. You can review the spreadsheet in Excel and when you 
are done just close the window. If you make changes to 
the spreadsheet and save them the changes will be 
permanently saved on the existing history record. 
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Microsoft Word 
CRM allows you to create documents, letters, envelopes and 
labels using Microsoft Word. CRM will send the information 
from your CRM table in order to personalize letters using any of 
the fields, or to create a batch of envelopes or labels for 
mailings. 

CRM uses templates to create all merge documents. You can 
create as many templates as you want and you can select who 
can use those templates. Some examples would be fax cover 
sheets, company letterhead, sales templates, envelopes, labels 
or standard letters. 

The first thing you should do is create some basic templates. 
Once you get the hang of it you can create more complex 
templates such as listing agreements, brochures, or 
questionnaires. 

Exporting to Word 
You can export information from CRM using the List Window 
{F5} from any table. 
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For more information on the list window including the export 
function see the section on the list window in this manual. 

Attaching a Document to CRM  
You can attach your Word Documents to the history for any 
combination of records in CRM. 

Word 2003 
 To connect using Word 2003 Click the 
CRM History button on the Word 

toolbar or from the Word Tools Menu Click CRM | History. 

Word 2007 

  

To connect using Word 2007 Click the Add-Ins Ribbon on the 
Word toolbar and then Click History.  

  

Word will try to automatically connect to the CRM Server if it 
can't you will be prompted to log in. 

Word will load the CRM History Dialog for you to fill in. 
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Click the Linked to section and select the linked record. 

To select a single record Click the down arrow. 

To select multiple records Click the button next to the down 
arrow. 

When you have completed filling in the history record Click 
{OK}. CRM automatically saves a copy of your spreadsheet to 
the Realnex CRM Shared folder. DO NOT change the name of 
the document or the location of the file. 

If you make changes to the document after you have created 
the history record make sure to Click Save in Excel or your 
changes will be lost. DO NOT change the name of the document 
or the location of the file. 

Viewing an Attached Document from an CRM History 
Record 

1. Find the record that has the attached document in 
Realnex CRM. 
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2. Click the History Tab at the bottom of the record. 

3. Right-Click on the correct history record and choose 
Attachment | Open. 

4. You can review the document in Word and when you are 
done just close the window. If you make changes to the 
document and save them the changes will be 
permanently saved on the existing history record. 
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Reports 
Overview 
Reports summarize information from the fields in the CRM 
tables and allow you to display that information in any format 
you choose. You can query and sort the data from your CRM 
tables anyway you want and then display or print that data 
using reports. 

The report engine in CRM is restricted to the data currently 
available to CRM. Before you display or print a report decide 
which information you want to include in your report by using 
the query and sort functions in CRM. 

Reports can be printed to the screen, to a printer, as a PDF file, 
exported to programs such as MS Word and MS Excel, RTF files 
and Crystal Reports format. 

All reports begin with report templates. We have included a 
large number of pre-configured reports. All reports in CRM are 
created using Crystal Reports. Crystal Reports is a product 
created and sold by Crystal Decisions, Inc. If you want to modify 
CRM reports or create your own, you must purchase a copy of 
Crystal Reports.  

Chapter 

15 
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Printing Reports 
Printing a report for a single record 
The first step is to find the record you want to print a report for 
by using the lookup feature (F12). Once you have done this, on 
the menu bar, Click report and select run reports. Select the 
report you wish to print from the dialog window. On the lower 
left, there are 2 options. Select current record. If you are unsure 
which report you need to select, take your best guess and Click 
the Preview button. Otherwise, Click the print button. 

Printing a report for a group of records 
The first step is to find the record you want to print a report for 
by using the lookup feature (F12). Once you have done this, on 
the menu bar, Click report and select run reports. 

 

Select the report you wish to print from the dialog window. On 
the lower left there are 2 options. Select all records in current 
query. If you are unsure which report you need to select take 
your best guess and Click the preview button, otherwise Click 
the print button. 

Creating a new report 
NOTE: It is easier to modify an existing report than to create one. 
Crystal Reports version 10 or greater must be installed to modify 
reports.  

Click report and select report templates on 
the menu bar.  
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In the report templates dialog, Click the button labeled New. 
 In the report properties dialog, give the report a name or 

short description in the first textbox labeled description. Next, 
choose the table you would like to report on in the dropdown 
list box labeled For. (This will also determine what view the 
report will show up for. i.e. when you Click reports and select 
run reports when a contact view is active, it will only show 
reports for contacts.) Next, select which team can view and 
print this report in the dropdown list box labeled team.  

NOTE: If the team selected is private, only you will be able to see 
and print this report 

Also, from this window, you may select to have the report be 
accessible from the reports menu. This allows you to easily 
select the reports that 
you use most frequently.  

 

Once you Click the OK 
button, the Crystal 
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Reports editor will launch. In the Crystal Reports application 
window, select table and then select table expert from the 
menu bar. In the table expert dialog window, Click the + button 
next to create new connection, then scroll down and Click the + 
button next to OLE DB (ADO). In the Provider list box select 
Microsoft OLE DB Provider for SQL Server and Click the Next 
button. In the Server drop down box either type in or select the 
server that hosts the CRM data. (For single user use local host) 
For User ID, enter the initials you use to log on to CRM. In 
Password, enter the password you use to log on to CRM. For 
Table, enter CRM10. Click the Finish button.  

This will bring you back to the table expert dialog. To get a list of 
tables in the Realnex CRM table, Click the + button next to 
CRM10 and then the + button next to views. Select the table or 
tables you wish to access in the report and Click the > button to 
add them to the selected tables list. Be sure to add the selection 
table as it is needed to process the current query when printing 
a report from CRM. When you have selected all the tables you 
wish to access in the report, you may Click the links tab to set 
up linking. It is vital that you link the object_key field in 
selection table to the appropriate key in the main table. (i.e. 
object_key in selection to contact_key in contacts) To create a 
link between 2 fields drag the first field name over the second 
and release the button. When you are finished, Click the OK 
button. Now that your data is “set up” you should see a + 
button next to table fields in the field explorer on the right side 
of the main window. Clicking this + button will expand the table 
fields list to show the tables you selected. Clicking the + button 
next to a table name will expand that table to show you all the 
available fields you can drag and drop on to the report. 
Generally all the fields will be dragged to the details section of 
the report. When you are done adding fields and formatting the 
report to look the way you want, select file and choose save 
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from the menu. For more information on linking, formatting, 
summaries, calculations or other advanced topics consult the 
help menu in Crystal Reports. 

Importing an existing report 

CRM can import existing reports created with Crystal Reports. 
On the CRM menu, Click report and then report templates. This 
will bring up the Report Templates dialog. Click the button 
labeled import.  In the dialog window, locate the report 
file and select it. Click the open button. In the report properties 
dialog, choose the table you would like to report on in the 
dropdown list box labeled for. (This will also determine what 
view the report will show up for; i.e. when you Click reports 
then run reports when a contact view is active, it will only show 
reports for contacts.) Next, select which team can view and 
print this report in the dropdown list box labeled team. 

NOTE: If the team selected is Private, only you will be able to see 
and print this report. 

Click the OK button. The report is now imported. 

Modifying an Existing Report 
NOTE: It is best to copy an existing report and modify the copy. 
This can only be done if Crystal Reports 10 or greater is installed.  

On the menu, select report then report templates. Select the 
report you wish to change and Click the button labeled 
edit.  This will launch the Crystal Reports application and 
load the selected report. You can then add table fields by 
dragging them from the field explorer on the right side of the 
application window. To delete fields and other objects, Click on 
the object and press the delete key on your keyboard. To 
change the placement of objects in the report, drag them to 
where you want them to be placed. When you are finished, 
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Click file and select save from the menu. You may then close the 
Crystal Reports application. For more information on advanced 
reporting topics consult the help menu in the Crystal Reports 
application. 

Using Sub-reports 
Sub-reports allow easy access to related records stored in 
related tables like getting a history sub-report for each contact 
in a group. CRM packages several commonly used sub-reports 
with the software to make it easier to customize existing 
reports and quickly build your own reports. The prepackaged 
reports can be found on your server in the CRM10 Shared Files 
folder. (CRM10 Shared Files\Reports\Sub Reports) 

Inserting an Existing Sub-report 
While modifying or creating a report in the Crystal Reports 
application, Click insert and select sub-report on the menu. In 
the insert sub-report dialog select, choose an existing report 
and either type in the path and filename or Click the browse 
button to locate the report you wish to insert. Next, Click on the 
links tab near the top of the dialog.  In the available fields list 
box, choose the field that will be the criteria for the data to be 
shown on the sub-report and Click the next button. This will 
generally be a key field. In the dropdown box to the right under 
select data in sub-report based on field, select the field in the 
sub-report that corresponds to the field in the main report. (i.e. 
choose property_key in a property report or contact_key in a 
contact report) Click the OK button and place the field in a 
details section of the main report. 

Creating a New Sub-report 
While modifying or creating a report in the Crystal Reports 
application, Click insert and select sub-report from the menu. In 
the insert sub-report dialog, select create a sub-report with the 

Page 304 



Chapter Fifteen  

report wizard. Enter a name for the new report in the new 
report name text box then Click the report wizard button. 
Choose the tables you need the sub-report to access and Click 
the next button. Next, choose the fields you want the sub-
report to display and Click the next button. If you want 
grouping, select the field(s) that you want to group together 
and Click the next button. If you want the sub-report data to be 
restricted to certain criteria, select the field to filter by and then 
select how to filter the field by using the dropdown box below 
the filter fields list. Enter your criteria in the boxes that appear 
below your filtering selection. Click the next button. If you 
would like to apply a formatting template to the sub-report, 
select one and Click the finish button. This will bring you back to 
the insert sub-report dialog. Next, Click on the links tab near the 
top of the dialog.  In the available fields list box choose the field 
that will be the criteria for the data to be shown on the sub-
report and Click the next button. This will generally be a key 
field. In the dropdown box to the right under select data in sub-
report based on field, select the field in the sub-report that 
corresponds to the field in the main report. (i.e. choose 
property_key in a property report or contact_key in a contact 
report) Click the OK button and place the field in a details 
section of the main report. You may now edit the sub-report 
layout and fields. 

Saving Sub-reports for Use in Other Reports 
Select the sub-report object on the main menu by clicking on it. 
Choose file and select save sub-report as from the menu. In the 
save as dialog, choose a location and name for the file and Click 
the save button. The report will now be able to be inserted into 
other reports. 
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Marketing Report 

 

The marketing report looks through all history records entered 
into the system and gives you a listing of those records. This is 
one of the most useful tools in the CRM system. Using the 
project and status fields in a history record you can create 
extremely useful reports through the marketing report. This can 
be used to show all activity in the office in a date range, all 
activity dealing with one property, or all records that are at a 
certain point in the pipeline. 

To create a marketing report, Click on Report and select 
Marketing Report. This will bring up the Marketing Report 
window. Select the options you wish to use and then Click OK. 

Report Dates: Enter the date range for the history records you 
want to view in the report. 
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Event Type: Select the event type(s) you want included in 
your report. 

Status: Select the Status(s) you want included in your report. 

Project: Select the project(s) you want included in your report. 

My history records only: Only history records created by you 
will be included in the report. 

Output 
Report: This option will create a report view that you can print 
or save in a PDF, Excel or Word file format. 

Report Title: Type in the title you want at the top of 
your marketing report. 

Include activity summary: If you would like a summary 
table of activities in your report check this box. 

 

Query: This option will query your database for the records that 
match the report. This is useful to find contacts or properties 
that match those from a previous listing. 

Saved Settings 
Load settings: Pull down this list to quickly reset saved 
marketing report settings. 

Load other: Use this option to see a complete list of saved 
marketing report formats. 

Save settings: Pressing this button will open a dialog that lets 
you save the current status of your marketing report. The 
results will show in the drop down list next to load settings. This 
makes it easy to quickly recall saved marketing reports. 
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Import/Export 
Overview 
Many times it is useful to bring outside data into your system as 
well as provide others with data files for their systems. CRM 
allows you to export data in many formats. Importing data is a 
quick way to populate your database but exercise caution. Most 
outside data is not very well scrubbed and importing it can 
cause more problems and require more time to fix than 
entering it correctly by hand. Before you import data into your 
system review the data and make sure it’s clean. 

Importing from flat files 
Realnex CRM can import from the two most common flat file 
formats available. Most programs can export to one of these 
two formats and most vendors sell their data in one of these 
formats. 

 Comma delimited also known as “csv” files.  

 dBase / Foxpro also known as “dbf” files. 

Chapter 

16 
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Importing Excel files 
Microsoft Excel is a very popular program for database lists. It is 
also an excellent program for viewing your import files before 
you actually import the data into your tables. 

Although Realnex CRM cannot read the Excel files in their native 
format Excel can create both “csv” and “dbf” files which Realnex 
CRM can read. We suggest that you view all the data you intend 
on importing in Microsoft Excel before you actually import it 
into CRM. Check your data for consistency and completeness. 
Make sure the address fields are standardized and pay 
particular attention to fields you need to query in CRM.  

Change the headings of your columns so they describe the data 
making it much easier for you to import the data. You can also 
add columns to your spreadsheet and fill the columns with 
information that you want attached to this set of import 
information. 

Once your data is confirmed use the Save As function in 
Microsoft Excel to convert the format to a “csv” file. 

1. Open the file in Excel.  

2. Make any changes you want to the file. 

3. Click the {File} menu and select {Save As}. 

4. Select the folder to save the file in. 

5. Enter the name of the file you want to create. 

6. Change the Save as type to CSV (Comma delimited) 
(*.csv). 

7. Click the {Save} button. 

8. Follow the instructions in Importing a Flat File. 

Importing a Flat File 
1. Open Realnex CRM.  
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2. Click the {File} menu and select {Import} and then 
{File}. 

3. Fill in the Import File page. 

4. Click Next. 

5. If you are creating a new map you must match the fields 
in the Edit Import Map dialog. 

6. Click OK when you are done creating the map. 

7. View the results on the Import Map dialog to confirm 
the data is correctly mapped. 

8. Click Next. 

9. Set the options for Owner, Team and Group. 

10. Click Next. 

11. If you want the import to pause on errors check the 
Pause on errors check box. 

12. Click Next. 

13. When the import is finished close the window. 

14. Close the CRM tables and reopen them to see your 
imported data. 

Page 310 



Chapter Sixteen 

Import file/database dialog 

 

Figure 13: File/Database Import Dialog 

It is a good idea to look at the data you are importing before 
you actually import it. Get a good sense of what the data looks 
like; remove any columns or records from the file that contain 
unwanted information or bad information. The best tool for 
looking at a data file is Microsoft Excel. If you have MS Excel we 
highly recommend you at least view the file you are importing 
in it and make any changes to the file before you import it. You 
can also add columns to the file in Excel if you would like to 
populate fields in CRM with a value to help you categorize the 
records you are importing or find them by some common value. 
What kind of data do you want to import? 
Select the CRM table that you want to import your data into. 
Remember that importing contacts will automatically create 
company records so choosing Contacts will also allow you to 
map companies. 
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You can choose from several different formats which are broken 
down into the database type you want to import. Many of the 
formats include the ability to import into multiple tables. 

Contacts 
If your import data consists of only contact information use this 
format. Importing using the contact format will automatically create 
and link company information that is contained in the file you are 
importing. 

Companies 
If your import file only contains company information use this 
format. You cannot create contacts in CRM using this format. 

Properties 
If the data you are importing has property information but does not 
have space or unit information use this format. The property import 
format can also import owner and agent information for each 
record. 

Spaces / Tenants 
If your data contains individual space information or tenant lease 
information use this format. There must be an individual record for 
each space/tenant and each record must have a link to a property 
record already in Realnex CRM or contain the property information. 
You can create property records including the owner and agent 
information as well as the tenant contact and company information 
using this format. 

Units 
If your data contains unit information use this format. There must 
be an individual record for each unit type and each record must 
have a link to a property record already in Realnex CRM or contain 
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the property information. You can create property records including 
the owner and agent information using this format. 

Sales Comps 
If your data contains sales comparables use this format. You can 
create all the property and contact information using this format as 
well as the sale comp information. 

Use an existing import map? 
Choosing this option will let you search for pre-defined maps 
from CRM as well as maps you have created and saved. After 
clicking on the radio button for Use an existing import map Click 
the button to the right of the field underneath to select the map 
to use. 

Create a new import map? 
If this is data from a source that has no pre-defined map Click 
this radio button and select from the support import formats 
defined below: 

DBase file: These files usually end with the extension ".DBF" and 
contain a structure defined internally. The big advantage of this 
file structure is that your individual records can contain an 
extended character set and individual fields can contain 
multiple lined text such as comments where you have separated 
lines with in the field into two or more lines. 

Comma-delimited file (with header): These files usually end in 
".CSV" and contain one row for each record with the fields 
delimited by a comma. The first row of the file contains field 
names or titles such as First Name, Company, and City. If you 
have a csv file that does not have heading on each column it is a 
good idea to load that file in Excel and put heading on each 
column. It is much easier to match the fields in CRM against 
field titles than it is to figure out what the data means. 
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Comma-delimited file (without header): Same as format above 
but there are no heading on the columns. 

Access file: These files usually end with the extension ".MDB". 
Access databases contain multiple tables that are linked 
internally. CRM will give you access to the individual tables in 
the file. You can only import from one of the tables at a time. 

Select the file to import: 
Use the browse button on the far right edge of this field to 
select the file you want to import from your hard drive. 

Continue to the Edit Import Map Dialog. 

Edit Import Map Dialog 

 

Table tabs 
In situations where a source file might contain information 
stored in separate tables CRM splits the data into table tabs. For 
example if your source file contained contacts it would usually 
also contain the contacts address and company information. 
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Since CRM stores the company/address information in one 
table and the specific contact information in a separate table 
the import wizard would show two tabs (shown in the example). 

To match the company/address information contained in your 
source file to the company table in Realnex CRM Click the 
Company tab and match the fields. To match the contact 
information such as the contacts name, title, email etc. Click the 
Contact tab and match those fields. 

When you import your data CRM will automatically add a record 
to the company table and link the contact to that company. If 
your source file contains multiple contacts at the same company 
and you have marked key fields instead of duplicating the 
companies CRM will attach those extra contacts to the existing 
company. For that reason it is important that before you import 
you check your source file for mistakes in the company and 
address fields. If anything is typed differently between records 
CRM will not match them and you will end up with duplicate 
records. 

Destination and Source field grids 
CRM displays the fields from you source file in the grid on the 
right. This grid consists of three columns: 

Source field name column 
This column displays a value for each column in your source. 
This value is taken from the first row in your source file so it is a 
good idea to label the first row of each column in your source 
file with a field name that is unique and easy to understand. 

Source type column 
The type column is always variant for CSV files but for 'DBF' files 
it will display the actual file format for the field. 
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Source value column 
In the third column you will see actual data from the records in 
your source file. You can scroll through those records using the 
navigation buttons near the bottom of the dialog box. 

Destination field name column 
Click in this column to select the CRM field that will receive the 
information from the source field. 

Destination expression column 
Drag the source field and drop it in this column to map the field. 
You must first select an Realnex CRM field in the destination 
field name column. There are a number of expressions you can 
use in this column in combination with the source fields or in 
lieu of. 

Destination key column 
The key column is used to define which fields in your import 
denote a duplicate record. This field should only be checked if 
you are sure it denotes a duplicate record. Please read the 
section on duplicate checking for specific information on using 
this feature. 

Mapping fields 
CRM displays two windows side by side in the Edit Import Map 
dialog. On the left side are the Destination fields. These are the 
CRM fields that will receive the information from your import 
file. On the right side are the Source fields. These are the fields 
and information contained in the file you are importing. 

To map a field do the following: 
1. In the Destination fields window Click in the Field Name 

column and select the CRM field to receive the data. 
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2. Drag the field from the Source field’s window and drop it 
in the Expression column next to the field name you 
want to match it to. 

3. Check the key field if you want to use this field for 
duplicate checking. For detailed information on keys see 
the section below on Import Duplicate Rules. 

4. Repeat this step until all the fields are matched up. 

Hiding fields that are already mapped 
Check the 'Show only unmapped source fields' if you want CRM 
to hide the fields you have already mapped. This makes it easy 
to view the remaining source fields that have not been mapped 
yet 

Removing Destination rows: 
1. Highlight the Destination field row you want to remove. 
2. Click the Delete Row button at the bottom of the 

Destination field’s window. 

Adjusting the order of the Destination rows: 
1. Highlight the Destination field row you want to relocate. 
2. Click the Up or Down button at the bottom of the 

Destination field’s window to move the selection up or 
down in the Destination fields list. 

Update field rules: 
When CRM finds a duplicate record based on the key fields you 
have marked it uses the setting in this field to update the 
record. To set the rule Click the combo next to the Update 
existing label below the Source fields list. 

You have three choices: 

 

Never: Choosing never will skip any existing records. Nothing 
will be added or updated for that record in the import file it will 
just be skipped. 

Page 317 



Import/Export 

 

When blank: If a duplicate record is found in your database 
CRM will look at each field in the existing record. If the field in 
the existing CRM record is blank CRM will replace that field with 
the value in the import file. If the field in the existing CRM 
record has a value the import routine will leave that value in the 
existing record. 

Always: Any fields in the import record will replace those 
corresponding fields in the CRM record. 

Key: Using this option will not make any changes at all to the 
table but it will use this to find a parent record for other tables 
contained in this import. For example if you have a source file of 
spaces and one of the columns contains a pointer to existing 
property records in CRM you could match that column in your 
source file to the destination field in the property table and 
check it as a key, then set the update existing to Key. If the 
value in that column matches a property record the space 
would be imported and linked to the property. If no matching 
value was found in the property database CRM would not 
import the space. 

Viewing the import source records: 
You can scroll through the import source records using the 
navigation arrows at the bottom right side of the Edit Import 
Map dialog. 

Setting a condition for the import: 
You can set a condition on your source file and CRM will 
evaluate the condition for each record before importing it. If the 
source record passes the condition the record is imported, if it 
does not pass the record is skipped. For example if you had a 
field in your source file that contained expiration dates and you 
only wanted to import records that had not expired yet you 
could set a condition that said '[Expiration Date] >= Today'. CRM 
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would evaluate the [Expiration Date] field in your source file 
and compare it to the date in your computer. If it was greater 
than or equal to today's date the record would be imported 
otherwise it would be skipped. 

Saving and Loading maps 
It is a very good idea to save your maps so you can re-use them. 
You'll find that it is easy to make a mistake in your map but in 
most cases you don't figure it out until after you have imported 
your data. If you save the map you can re-do the import by 
loading your saved map, making the changes you need and then 
re-importing the data. 

Import Duplicate Rules 
When CRM imports data it first looks at the import map to 
decide if you want duplicate records updated. CRM defines a 
duplicate by looking at all the field you have marked as Key 
fields and then looking in your existing database for records that 
match those keys exactly. This feature is mainly for records that 
are being imported from recurring import files that have unique 
id fields. 

Be careful how you use this function, key fields that are blank 
will match key fields in CRM that are blank. So if you set First 
Name, Last Name, Company and Phone as key fields in your 
import file and you had a record in CRM with the last name 
SMITH no first name, no company and no phone number and 
you had records in your import file with a last name of SMITH 
and the others blank those would all match and be considered 
duplicates. It's best if you are going to have CRM update 
duplicate records if you check your import file first to make sure 
you have valid data in all the key fields. 
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Special Duplicate Import Fields: 
CRM has two hidden fields that are useful for identifying imported 
records. You will see them in the list of CRM fields labeled as Import 
Source and Import Record. 

Import Source: 
In this field type a value that identifies the file you are importing. 
Using the combination of the import source and the import record 
will make it possible to differentiate between multiple imports. This 
field is mainly useful in imports that use a record number as a 
unique id making it possible to have two sources with the same set 
of unique record id values. 

Import Record Field: 
Map this field to the field in your source file that contains the 
unique id. If your source does not have a unique id you can create 
one using a sequence of numbers. For example is excel you could 
create a new column and number each record. Make sure each 
record has a unique number and then map that field to the Import 
Record field. When you come back to re-import the list CRM will 
match the number you gave each record to the number in your 
CRM database and update the record. When using the numbering 
method make sure you also include a unique Import Source for 
each file or you run the risk of updating the wrong record in CRM. 

Import Expressions 
CRM contains a detailed Expression Editor for each field in your 
import. This has many uses for example you can have CRM add 
a value for you automatically in any field, you can format a 
phone number automatically or you could join to fields 
together. Here are some examples of how you might use the 
import expressions. 
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Basic Expression Rules 
 Fields are always enclosed in Brackets [field name] 

 Literal strings can be enclosed in double or single 
quotes  "this is valid" 'this is also valid' 

 When combining values use the ampersand & "Date: " 
& [SALEDATE] 

 When adding values use the plus + sign  20000 + [PRICE] 

Operator Arithmetic (Add) 
Purpose 

Useful for performing addition between numeric fields in 
your source database or from combinations of fields and 
numbers. 

 

General Syntax 

value1 + value2 

 

Example Syntax 

[Office SqFt] + [Industrial SqFt] 

3 + 5 

[Acres] + 7 

Operator Arithmetic (Subtract) 
Purpose 

Useful for performing subtraction between numeric fields in 
your source database or from combinations of fields and 
numbers. 
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General Syntax 

value1 - value2 

 

Example Syntax 

[Bldg SqFt] - [Office SqFt] 

35000 - 2500 

[Acres] - 1.23 

 

Operator Arithmetic (Multiply) 

Purpose 

Useful for performing multiplication between numeric 
fields in your source database or from combinations of 
fields and numbers. 

 

General Syntax 

value1 * value2 

 

Example Syntax 

[Square Feet] * [Rent] 

43560 * 2.5 

[Acres] * 43560 

Operator Arithmetic (Divide) 
Purpose 
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Useful for performing division between numeric fields in your 
source database or from combinations of fields and 
numbers. 

 

General Syntax 

value1 / value2 

 

Example Syntax 

[Price] / [Square Feet] 

3000000 / 35000 

[Lot Size] / 43560 

Operator Arithmetic (Remainder) 
Purpose 

The remainder function returns the left over portion in a 
division operation. For example two goes into seven, three 
times with a remainder of one. 

 

General Syntax 

value1 % value2 

 

Example Syntax 

[Square Feet] % [Rent] 

70000 % 43560 

[Lot Size] % 43560 
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Operator String (Concatenate) 
Purpose 

The concatenate operator (&) joins two or more strings 
together. You can join fields or combinations of fields and 
strings. All strings must be enclosed in single or double 
quotes. This operator is not used to add numeric fields 
together, for that purpose use the plus (+) operator. 

 

General Syntax 

string1 & string2 

 

Example Syntax 

[First Name] & [Last Name] = JohnJones 

[First Name] & ' ' & [Last Name] = John Jones 

'Mrs. ' & [Last Name] = Mrs. Jones 

Operator String (At) 
Purpose 

The at operator ($) returns the starting position of string2 in 
string1. 

 

General Syntax 

string1 $ string2 

 

Example Syntax 
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"Fred Smith Inc." $ "Inc" = 12 

"Fred Smith OBE" $ "Inc" = 0 

 

Combination Example Syntax 

Because 0 is converted to Boolean false and non-zero is 
converted to Boolean true, you can use this operator as a 
"contains" test. 

 

Iff( [Company Name] $ "Inc", "Incorporated", "Not 
so much" ) 

Operator Comparison 
Purpose 

The comparison operators are used to return a logical result 
usually useful in iff() statements. 

 

General Syntax 

string1 = string2 

[Price] > 0 

 

Example Syntax 

iif( [Price] > 0, [Price], 'Not for sale') 

if the price field contains an amount > 0 return the price 
otherwise return the words 'Not for sale' 

Function Arithmetic (Int) 
Purpose 
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The Int() function returns a whole number from the value 
passed. This function does not round the number up or down 
it just drops the numbers to the right of the decimal point 

 

General Syntax 

Int( Number ) 

 

Example Syntax 

Int( 100.45 ) = 100 

Int( 100.9999 ) = 100 

Int( [Price] ) = The value in the price field with no cents. 

Function Arithmetic (Round) 
Purpose 

The Round() function returns a numeric rounded to the 
number of decimals passed to it. The function will adjust the 
value up if the remaining decimals are greater than .5 and 
adust it down if the remaining decimals are less than or 
equal too .5. 

 

General Syntax 

Round( Number, Decimal places ) 

 

Example Syntax 

Round( 100.45, 1 ) = 100.4 
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Round( 100.451 1 ) = 100.5 

Round( [Price], 0 ) = The value in the price field with no 
cents. 

Function Conversion (IsBoolean) 
Purpose 

The IsBoolean() function returns true or false indicating if the 
parameter passed is recognized as a valid logical value. 

 

General Syntax 

IsBoolean( Logical Value ) 

 

Example Syntax 

IsBoolean( [Building Color] ) = False 

 

Since the field [Building Color] returns a color the example 
above will return False.  Valid values for a true value are 'T', 
'Y', 'N', 'F', 'False', True', 'Yes', 'No', any number. 

Function Conversion (IsDate) 
Purpose 

The IsDate() function returns true or false indicating if the 
parameter passed is recognized as a valid date. 

 

General Syntax 

IsDate( Date Value ) 
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Example Syntax 

IsDate( '12/1/2004' ) = True 

IsDate( '2/31/2004' ) = False (There are never 31 days 
in February) 

IsDate( 'Dec 10, 2003' ) = True 

Function Conversion (IsDecimal) 
Purpose 

The IsDecimal() function returns true or false indicating if the 
parameter passed is recognized as a number. This function 
will also recognize string values as decimals if they are 
numbers and do not contain invalid characters such as dollar 
signs. 

 

General Syntax 

IsDecimal( Number ) 

IsDecimal( 'String' ) 

 

Example Syntax 

IsDecimal( 12 ) = True 

IsDecimal( '100,000' ) = True 

IsDecimal( '$1000.00' ) = False 

Function Conversion (IsNull) 
Purpose 

The IsNull() function returns true if the source field is empty 
or 0. 
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General Syntax 

IsNull( [Field] ) 

 

Example Syntax 

IsNull( '' ) = False 

IsNull( 'Any value' ) = False 

IsNull( 0 ) = False 

IsNull( Null ) = True 

 

Exception: 

When reading data from a DBF file, an empty string is 
converted to null. 

Function Conversion (ToBoolean) 
Purpose 

The ToBoolean() function converts a character or numeric to 
a logical True or False. This is useful if you have values in your 
source file that you want to use in a check box in Realnex 
CRM. 

 

General Syntax 

ToBoolean( Value ) 

 

Example Syntax 

ToBoolean( 'Yes' ) = True 
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ToBoolean( 'No' ) = False 

 

Valid values for a true value are 'T', 'Y', True', 'Yes' or any 
number except 0. 

Function Conversion (ToDate) 
Purpose 

The ToDate() function converts a string to a valid date field. 
The return value can be used to populate a date field in 
Realnex CRM. If the century is missing from the year CRM 
will convert anything below 30 to 20## and anything greater 
than or equal to 30 to 19##. For example 2/1/30 would 
become 2/1/1930 while 2/1/29 would become 2/1/2029. 

 

General Syntax 

ToDate( Date String ) 

 

Example Syntax 

ToDate( 'Dec 20, 2001' ) = 12/20/2001 

ToDate( 'Dec 2001' ) = 12/1/2001 

ToDate( '1/2001' ) = 1/1/2001 

ToDate( '10/4/02' ) = 10/4/2002 

ToDate( '11/15/98' ) = 11/15/1998 

Function Conversion (ToDecimal) 
Purpose 
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The ToDecimal() function converts a valid string to a decimal. 
This is useful when you are trying to fill a numeric field in 
Realnex CRM with a string from the source file. The function 
does not recognize characters or dollar signs and will return a 
0 if the string passed contains an invalid character. 

 

General Syntax 

ToDecimal( 'String' ) 

 

Example Syntax 

ToDecimal( '12' ) = 12 

ToDecimal( '100,000' ) = 100000 

ToDecimal( '$100,000' ) = 0 

ToDecimal( 'Three' ) = 0 

Function Conversion (ToString) 
Purpose 

The ToString() function converts a value to a string. This is 
useful when you are trying to fill a character field in Realnex 
CRM with a number, date or logical value from the source 
file. 

 

General Syntax 

ToString( Value ) 

 

Example Syntax 

ToString( 12 ) = '12' 
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ToString( 'Any words' ) = 'Any words' 

ToString( '12/1/2004' ) = '12/1/2004 

ToString( 12/4 ) = 3 

Function Date (Day) 
Purpose 

The Day() function converts a date or a valid string into the 
numeric value of the day of the month. 

 

General Syntax 

Day( Date ) 

 

Example Syntax 

Day( '12/1/2005' ) = 1 

Day( '2/14/01' ) = 14 

Day( 'May 5, 2001' ) = 5 

Function Date (MakeDate) 
Purpose 

The MakeDate() function converts three separate values into 
a valid date. The values can contain either numbers or strings 
as long as the strings are legitimate values. This function 
does not convert missing centuries so a year of 40 will 
equate to 0040. 

 

General Syntax 
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MakeDate( Year, Month, Day ) 

 

Example Syntax 

MakeDate( 2001, 12, 13 ) = 12/13/2001 

MakeDate( 2001, 41, 10 ) = Nothing (invalid month) 

MakeDate( 40, 5, 3 ) = 5/3/0004 

Function Date (Month) 
Purpose 

The Month() function converts a date or a valid string into 
the numeric value of the month. 

 

General Syntax 

Month( Date ) 

 

Example Syntax 

Month( '12/1/2005' ) = 12 

Month( '2/14/01' ) = 2 

Month( 'May 8, 2001' ) = 5 

Function Date (Year) 
Purpose 

The Year() function converts a date or a valid string into the 
numeric value of the month. If the century is missing from 
the year CRM will convert anything below 30 to 20## and 
anything greater than or equal to 30 to 19##. For example 
2/1/30 would become 2/1/1930 while 2/1/29 would become 
2/1/2029. 

Page 333 



Import/Export 

 

 

General Syntax 

Year( Date ) 

 

Example Syntax 

Year( '12/1/2005' ) = 2005 

Year( '2/14/01' ) = 2001 

Year( 'May 8, 2001' ) = 2001 

Year( '2/14/98' ) = 1998 

Function String (Parsing) 
Purpose 

The Parsing() functions take a full string such as an address 
or a name and return parts of that string. The CRM 
expression editor contains eight intelligent parsing routines. 
These routines use general rules to extract the portion of the 
string and may not always be correct in their attempt to 
return a result. 

 

General Syntax 

Parsing Function( String to Parse ) 

 

Example Syntax 

AddressNumber1( '450-470 N Johnson Street, Suite 
204' )= 450 
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AddressNumber2( '450-470 N Johnson Street, Suite 
204' )= 470 

AddressDirection( '450-470 N Johnson Street, Suite 
204' )= N 

AddressStreet( '450-470 N Johnson Street, Suite 204' ) 
= Johnson Street 

FirstName( 'Mr. Robert T. Jones, CCIM' )= Robert 

LastName( 'Mr. Robert T. Jones, CCIM' ) = Jones 

Salutation( 'Mr. Robert T. Jones, CCIM' ) = Mr. 

 

Combination Example Syntax 

TitleCase(FirstName( 'MR. ROBERT T. JONES, CCIM' 
)) = Robert 

 

This is an example of using two Realnex CRM built in 
functions to obtain a desired result. In this case we wanted 
just the first name but we also wanted it in mixed case. First 
we parse the full name into just the first name and then 
convert that to title case. 

Function String (Compress) 
Purpose 

The Compress() function removes duplicate spaces from a 
string. This is most useful when you are creating a single 
string from multiple fields. You can also pass a second 
parameter to the function and instead of removing multiple 
spaces the function will remove multiple occurrences of the 
second parameter passed. 
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General Syntax 

Compress( String ) 

Compress( String, Value ) 

  

Example Syntax 

Compress( 'Joe   Chesnut' ) = 'Joe Chesnut' 

Compress( 'A     Company    with    Extra space' ) = 'A 
Company with Extra space' 

Compress( 'TTom, Kettle, TTTTerrific', 'T' ) = 'Tom, 
Ketle, Terrific' 

  

Combination Example Syntax 

Concat( [FIRST],' ',[INITIAL],' ',[LAST] ) = Tom   
Williams 

Compress(Concat(( [FIRST],' ',[INITIAL],' ',[LAST] )) = 
Tom Williams 

  

In the example above we used the Concat function to join 
the fields First, Initial and Last. In the example above the 
Initial field was empty so the result was an extra space 
between the first name and last name. Using the compress 
function CRM automatically removed the extra spaces and 
returned the full name corrected.  

Function String (Compress) 
Purpose 
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The Compress() function removes duplicate spaces from a 
string. This is most useful when you are creating a single 
string from multiple fields. You can also pass a second 
parameter to the function and instead of removing multiple 
spaces the function will remove multiple occurrences of the 
second parameter passed. 

 

General Syntax 

Compress( String ) 

Compress( String, Value ) 

 

Example Syntax 

Compress( 'Joe   Chesnut' ) = 'Joe Chesnut' 

Compress( 'A     Company    with    Extra space' ) = 'A 
Company with Extra space' 

Compress( 'TTom, Kettle, TTTTerrific', 'T' ) = 'Tom, 
Ketle, Terrific' 

 

Combination Example Syntax 

Concat( [FIRST],' ',[INITIAL],' ',[LAST] ) = Tom   
Williams 

Compress(Concat(( [FIRST],' ',[INITIAL],' ',[LAST] )) = 
Tom Williams 

 

In the example above we used the Concat function to join 
the fields First, Initial and Last. In the example above the 
Initial field was empty so the result was an extra space 
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between the first name and last name. Using the compress 
function CRM automatically removed the extra spaces and 
returned the full name corrected. 

Function String (Concat) 
Purpose 

The Concat() function creates a single string from two or 
more values. 

 

General Syntax 

Concat( String1, String2, String3, ... ) 

 

Example Syntax 

Concat( 'Joe','Tom','Sue','Monique' ) = 
'JoeTomSueMonique' 

Concat( 'Joe', ' ', 'Tom', ' ', 'Sue', ' ', 'Monique' ) = 'Joe 
Tom Sue Monique' 

Concat( [FIRST], ' ', [INITIAL], ' ', [LAST] ) = 'Joe L. 
Smith' 

 

Combination Example Syntax 

Concat( [FIRST],' ',[INITIAL],' ',[LAST] ) = Tom   
Williams 

Compress(Concat(( [FIRST],' ',[INITIAL],' ',[LAST] )) = 
Tom Williams 
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In the example above we used the Concat function to join 
the fields First, Initial and Last. In the example above the 
Initial field was empty so the result was an extra space 
between the first name and last name. Using the compress 
function CRM automatically removed the extra spaces and 
returned the full name corrected. 

Function String (FormatPhone) 
Purpose 

The FormatPhone() function formats a phone number to a 
standard phone format. If the phone number is missing the 
area code Realnex CRM will automatically add your local area 
code to the number. 

 

General Syntax 

FormatPhone( Phone Number ) 

 

Example Syntax 

FormatPhone( '6195551212' ) = '(619) 555-1212' 

FormatPhone( '619/555-1212' ) = '(619) 555-1212' 

FormatPhone( '5551212' ) = '(619) 555-1212' 

FormatPhone( '6195551212 x213' ) = '(619) 555-1212 
x213' 

FormatPhone( '6195551212213' ) = '(619) 555-1212 
213' 

FormatPhone( '6195551212x213' ) = '(619) 555-1212 
x213' 

Function String (Join) 
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Purpose 

The Join() function creates a single value from multiple 
values and separates them with a value you define. This is 
useful if you have two or more fields in your import file that 
you want to put together as one value but separate each 
value with a character. 

  

General Syntax 

Join( Separator, Value, Value, Value, .... ) 

  

Example Syntax 

Join( '-', 'Blue', 'Yellow', 'Green' ) = 'Blue-Yellow-Green' 

Join( ';', 'Ind, 'Off', Ret' ) = 'Ind;Off;Ret' 

 
Function String (Left) 
Purpose 

The Left() function returns the specified number of 
characters in the string or field passed to the function 
starting from the left side of the string. 

 

General Syntax 

Left( String, # Characters ) 

 

Example Syntax 

Left( 'I was home before dawn', 10 ) = 'I was home' 
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Left( '[Location], 2 ) = First two letters in the Location 
field 

Function String (Len) 
Purpose 

The Len() function returns the length of a specified string or 
value from a source field. 

 

General Syntax 

Len( String ) 

Len( [Field] ) 

 

Example Syntax 

Len( 'I was home before dawn' ) = 22 

Len( [First Name] ) = 3 (assuming First Name field 
contained 'Tim') 

Function String (LowerCase) 
Purpose 

The LowerCase() function converts a string or the value in a 
source field to all lower case. 

 

General Syntax 

LowerCase( String ) 

LowerCase( [Field] ) 

 

Example Syntax 
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LowerCase( 'BIG COMPANY INC.' ) = 'big company 
inc.' 

LowerCase( [Company] ) = 'big company inc.' 

Function String (Replace) 
Purpose 

The Replace() function replaces all occurrences of the first 
value passed with the second value passed in the field or 
string passed. This function is NOT case sensitive. 

 

General Syntax 

Replace( String, Existing Value, New Value ) 

 

Example Syntax 

Replace( 'John is the top agent', 'john', 'sue' ) = 'Sue is 
the top agent' 

Replace( '[Address], 'blvd', 'Boulevard' ) = Replaces all 
occurrences of 'blvd' in the address field with 
'Boulevard'. 

Function String (Right) 
Purpose 

The Right() function returns the specified number of 
characters in the string or field passed to the function 
starting from the right side of the string. Fields passed to the 
function are trimmed of all trailing spaces before they are 
evaluated. 
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General Syntax 

Right( [Field], # Characters ) 

 

Example Syntax 

Right( 'I was home before dawn', 4 ) = 'dawn' 

Right( '[Last Name], 5 ) = 'oshaw' (assuming last name 
was Croshaw) 

Function String (Substring) 
Purpose 

The Substring() function returns a section of the string or 
field passed. 

 

General Syntax 

Substring( String, Starting Position, Length ) 

Substring( [Field], Starting Position, Length ) 

 

Example Syntax 

Substring( 'I like chocolate shakes', 8, 9 ) = 'chocolate' 

Substring( [Company], 1, 5 ) = 'CRM I'  (Assuming the 
company field contained 'CRM Inc.' 

Function String (TitleCase) 
Purpose 

The TitleCase() function converts a string or the value in a 
source field to mixed case. The first letter in each new word 
will be capitalized while the following letters in each word 
will be converted to lower case. In most cases this rule works 
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but in cases where the company name is a set of letters such 
as 'CRM' it has the negative side effect of converting that to 
'Rea'. 

 

General Syntax 

TitleCase( String ) 

TitleCase( [Field] ) 

 

Example Syntax 

TitleCase( 'JOHN JACOBS' ) = 'John Jacobs' 

TitleCase( 'CRM INCORPORATED' ) = 'Rea 
Incorporated' 

Function String (Trim) 
Purpose 

The Trim() function removes all trailing and preceding spaces 
from a string or field. This function does not remove spaces 
between characters in the string. 

 

General Syntax 

Trim( String ) 

Trim( [Field] ) 

 

Example Syntax 

Trim( '   Ms. Sue Long    ' ) = 'Ms. Sue Long' 
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Trim( '   Ms.     Sue    Long    ' ) = 'Ms.     Sue    Long' 

Function String (TrimEnd) 
Purpose 

The TrimEnd() function removes all trailing spaces from a 
string or field. This function does not remove spaces 
between characters in the string. 

 

General Syntax 

TrimEnd( String ) 

TrimEnd( [Field] ) 

 

Example Syntax 

TrimEnd( '   Ms. Sue Long    ' ) = '   Ms. Sue Long' 

TrimEnd( '   Ms.   Sue   Long    ' ) = '   Ms.   Sue   Long' 

Function String (TrimStart) 
Purpose 

The TrimStart() function removes all preceding spaces from a 
string or field. This function does not remove spaces 
between characters in the string. 

 

General Syntax 

TrimStart( String ) 

TrimStart( [Field] ) 

 

Example Syntax 
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TrimStart( '   Ms. Sue Long    ' ) = 'Ms. Sue Long    ' 

TrimStart( '   Ms.   Sue   Long    ' ) = 'Ms.   Sue   Long    
' 

Function String (UpperCase) 
Purpose 

The UpperCase() function converts a string or the value in a 
source field to all upper case. 

 

General Syntax 

UpperCase( String ) 

UpperCase( [Field] ) 

 

Example Syntax 

UpperCase( 'Big Company INC.' ) = 'BIG COMPANY 
INC.' 

UpperCase( [Company] ) = 'BIG COMPANY INC.' 

Function Miscellaneous (Coalesce) 
Purpose 

The Coalesce() function takes a group of fields and returns 
the first field that contains information. 

 

General Syntax 

Coalesce( [Field1], [Field2], [Field3], ... ) 
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Example Syntax 

Coalesce( [Comment1], [Comment2], [Comment3] ) = 
Value of Comment2 since Comment1 was empty. 

Function Miscellaneous (Field) 
Purpose 

The Field() function takes a field number from the source file 
and returns the value in that field. 

 

General Syntax 

Field( Number ) 

 

Example Syntax 

Field( 10 ) = Value of what ever is in the 10th field in 
your source file. 

Function String (IIf) 
Purpose 

The IIf() function allows you to return an answer based on 
the value of a field or expression. This is an extremely 
powerful function. 

 

General Syntax 

IIf( Logical Expression, Value if True, Value if False ) 

 

Example Syntax 

IIf( [Sale Price] > 0, 'For Sale', 'Off Market' ) Returns 'For 
Sale if Price > 0 otherwise returns 'Off Market'  
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You can next the IIf statements to return complex values. For 
example if you were importing a property table and the 
property type field was abbreviated you could use this 
function to write out the correct expression. Say your file 
contained 'OF', 'RT', 'IND' for the property types but CRM 
uses 'Office', 'Retail' and 'Industrial'. You could write the 
following IIf statement to convert the values from your 
source file. 

 

IIf( [Prop Type] = 'OF', 'Office', IIf( [Prop Type] = 'RT', 'Retail', 
'Industrial ')) 

 

If the [Prop Type] was 'OF' this would return 'Office' 

If the [Prop Type] was 'RT' this would return 'Retail' 

Otherwise this would return 'Industrial'. 
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Import File Options 

 

Owner 
This will set the owner of all records imported, for more 
information on owners see Record Owners. 

Team 
This will set the team that each of the records belongs to, for 
more information on teams see Teams. 

Group 
Putting the records into a group allows you to manage the 
records at any time. This is also useful in case you need to 
remove the group so you can re-import it. Only records added 
to your system will be a part of the group. Any records that 
were already in your database will not be added to the group. 
This enables you to use the group to remove the import without 
worrying about deleting records in your database that may have 
history. 
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If you want to put all the records including the existing ones in 
your database into a group it is a good idea to add some specific 
information to a field in your database using the import field 
mapping. For example you could select the user1 field and type 
in some text in the expression field that would identify the 
records imported. Then just add all the records containing that 
value to a group. 

When a record is marked for deleting….. 
If you set the delete option on your import edit map you can 
check this box and instead of actually deleting the missing 
records CRM will move them into the specific group. The New 
and Clear buttons work as specified above under the Group 
definition. 

Creating history records 
These three options if checked will create a historical record for 
the options checked. 

Associating a contact with a property 
If you are importing into spaces or one of the property types 
you can associate a contact such as an owner, agent or property 
manager with each record. When you map the contact CRM will 
give you the option of associating the record as a company or a 
contact. If you want to associate the company with the property 
or space select the company radio button. If you want to 
associate the contact select that radio button. If you import file 
has mixed records you will need to split it into two separate 
import files. Select the correct associate for each of the two 
imports in that case. 

Importing from CRM 8 
Realnex CRM has the ability to import all of your data from CRM 
8. To do this, Click on the File menu, highlight Import and select 
CRM 8.  
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This will bring up the import wizard. Select import all or part of 
a complete CRM 8 table and Click Next. 

From the Locate CRM 8 Table screen select the CRM 8 DATA 
folder which is located as a sub folder off the folder you 
installed CRM 8 into. This folder contains the passw.dbf file that 
CRM10 will use to find all your existing CRM 8 users and their 
tables. It is very important that you select the correct folder. If 
you are not sure where the folder is located Right-Click on the 
icon that loads CRM 8, choose properties and look at where 
CRM 8 is loading from where it says Target. That will be the 
main folder (the folder CRM 8 is installed in). The {DATA} folder 
is a sub folder located off that main folder. By default CRM 8 is 
installed off the C:\Program Files folder in a sub folder named 
CRMWIN. So the folder to choose if you used the default 
installation would be C:\Program Files\CRMWIN\DATA. Once 
you have selected the data folder Click Next. 

Realnex CRM will now read the file passw.dbf to check the 
locations of all of your table files in CRM 8. If data is located on 
drives or folders that are not visible to you CRM will simple 
ignore those folders. If this happens, simply import that user’s 
data from their machine in a second import. Once Realnex CRM 
has interpreted all the CRM 8 folders it will present you with the 
“Select Data” window. In this window you can select which 
folders you want to import. Remember you can re-run the 
import at any time and bring in other folders if you want to so if 
you have a complicated table with a large number of users you 
might want to start by bringing in the main data and then come 
back and work through the auxiliary tables. The window  
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displays a list of all tables found in your CRM 8 folders. The 
“directory” column is an indicator of what folder the data is 
stored in. The “users” column indicates which users in your CRM 
8 use the data in that folder and the “type” column tells you 
what tables are in the folder. The following is a complete 
description of the types of data listed in this “Select Data” 
program window. 

Data 
Agents, Investor, Vendors, Personal, Property, 
Tenants, Sale Comps, Lease Comps, Affiliates, 
Projects, History and Links 

To Dos The To Do list at the bottom of the Dashboard 
screen 

Shared 
Groups 

Public Global Groups 

Private 
Groups 

Private Global Groups 
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Projects 
List of Project Names used to create History / 
Events 

Events Event table showing appointments calls etc. in 
Dashboard and Calendars. 

Use the checkboxes to select which data you wish to import. If 
you want to import all of the data, Click the button labeled 
Select All and if you want to unselect all Click the button labeled 
Deselect All.  

The next screen, titled User Mapping, is used to map the 
records to a specific user in Realnex CRM. The USER ID column 
is the initials of the user in CRM 8. The User Name column is the 
user name used in CRM 8. The Map To column is where you 
select which user in Realnex CRM to map the data to. The Map 
To column is in the import for those who have already set up 
Realnex CRM with the users in their system. It is possible that 
old CRM 8 systems will have user owned records from people 
who have since left your company. You can go through this list 
of USER ID’s for CRM 8 and map those old users to existing 
people in Realnex CRM. If you choose to have Realnex CRM 
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create the users it will create them based on the information 
that comes from CRM 8. 

You can also use the New User button to create a new user in 
Realnex CRM. This gives you control over all the users 
information and takes the guessing out of the import. You can 
select the teams the user is a member of as well as the user’s 
permissions. If you have not created teams yet you can come 
back to this screen or you can set up teams in Realnex CRM. Of 
course you can set all this information in Realnex CRM if you 
would rather not do it now. CRM will make a best guess when 
importing users that you let it create for you.  For more 
information, see the section on users in this manual. 

If you chose to have CRM create a new user account, a window 
will pop-up saying The Import Wizard will now create new user 
accounts. If you select OK, the accounts will be created. If you 
do not wish to have it create new user accounts, select Cancel.  

Only users with administrative rights are able to create new 
users and map user id’s.  

 
Page 354 



Chapter Sixteen 

The next screen, titled Team Mapping, allows you to set the 
imported data so it is visible to whoever you want. You may 
map all records to a team, an individual or everyone. If this is a 
single user Realnex CRM you should set the mapping to All 
imported records belong to everyone. 

If this is a multi-user 
system and you 
prefer to make data 
visible to only certain 
users you can select 
to have CRM map 
the data by using the 
radio button titled 
Map directories to 
teams. When you 
use this option, you 
must choose where 
each of the 
directory’s data gets 
mapped to. The 
directories column 
will show you where 
the data is held. Generally, the public tables in CRM 8 will be in 
the CRMDATA folder within the DATA folder. The private file 
directories will generally be within the USERS folder, in the 
folder with the initials of a given user. The type column shows 
what type of data is in each directory. The users’ column shows 
who the data is owned by in CRM 8. If it shows <everyone> that 
means it is a part of the public tables. Otherwise, it will show 
the user ID of a certain user in CRM 8 or if the import wizard has 
determined more than one person is looking at that folder it will 
create a team and make those users part of that team so that 
they can see the data privately.  You can use the map to column 
to change who the data is visible to. 
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You can also create teams using the “New Team” button on this 
form. Under team name on the [Team Properties] form put in 
the name of the team you want to create. The owner of the 
team has complete control over who can be a member of the 
team and what permissions those users have in the team. For 
each user you make a member of the group you can set 
permissions as well. So you could have someone who is allowed 
to view the records for a team but not edit, add or make 
deletions. All of the settings for these teams are accessible from 
within Realnex CRM as well but if you know up front who will be 
a member of each team it is easier to set it up now and then 
correctly map the data to the correct team. For in depth 
information on teams please see the section in this manual on 
teams. 

Finally you need to set 
the Country Mapping. 
Since Realnex CRM is 
aware of time zones you 
must correctly set the 
country for each record. 
CRM 8 had the capability 
to track a country but it 
was not aware of the 

time differences and did not handle that information. Because 
of that we know most users did not track country information in 
CRM 8. Using this part of the wizard you can tell CRM how to 
make educated updates for you. In the first section CRM gives 
you the ability to replace blank country fields with a default 
country or leave it blank for you to fix later.  

The second section deals with information in the country field 
that is not recognized. Here you can have CRM ask you what to 
do, skip the record or just blank out the country information. 
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Since CRM allows you to come back and re-import data without 
duplicating existing imports it might be a good idea to select 
“Do not import the record”. This way you can let the bulk of 
your table go into Realnex CRM unattended and then come 
back for a second pass and flag all those records that Realnex 
CRM does not understand. If you have used the Country field 
for something else in CRM 8 it is suggested you move it to 
another field in CRM 8 before you do the import. 

The final screen simply tells you that the import wizard is ready 
to import the data from CRM 8. When you are ready to begin 
the import, Click Next. This will bring up the importing status 
window.  

Exporting 
Overview 
CRM allows you to export a group of records either into 
Microsoft Excel or Microsoft Word. You are able to select which 
fields are exported and in what order they are exported as well. 

To export contacts, either Click on View and select Contact List, 
or simply use the {F5} key. This will bring up a contact list. From 
here, you are able to select what fields are showing by using the 
drop down box labeled Fields. You may either select a pre-
existing field list or create a new list of fields. To create a new 
list of fields, select Fields from the drop down list. This will bring 
up the fields dialog box. To add a field to the list, select the field 
name on the left side list named fields. Either Click on the right 
arrow button or simply Double-Click on the field. This will add 
the field to the list on the right titled selected.  

You may also change the order of the fields from this window by 
clicking on a field in the selected list and clicking on either the 
up or down arrow buttons on the right hand side of the box to 
move the field up or down. Once you have the fields you wish, 
Click OK.  To sort the fields, Click on the sort drop down box and 
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either select one of the pre-existing sort-orders or create a new 
order by clicking on Sort. This will bring up the sort dialog box. 
Select the order of the fields and Click OK. Now the sort list will 
appear in the sort drop down box and will allow you to select it 
in the future.  

From this window, you are also able to perform queries. If you 
use the query drop down box, you can either select a pre-
existing query or create a new query. If you select query, this 
will bring up the query dialog box. For more information on 
queries, see the chapter titled Lookups and Queries.  

Once you have the contact list you want to export and the 
correct fields and order of fields, either Click on the Microsoft 
Excel button or the Microsoft Word button. This will bring up 
either Word or Excel with the list of contacts you had selected 
in a new document.  

Synchronizing with Microsoft Outlook 
CRM has the ability to synchronize both contacts and events 
with Microsoft Outlook. This will allow you to send vcards of 
your contacts to others and allow you to synchronize a 
handheld device with Outlook to be able to have access to your 
CRM contacts and appointments while you’re out of the office. 
In addition, your contacts in Outlook can also be synchronized 
into CRM. 

To access the Outlook synchronization, first you will have to 
create a group with all of the contacts you wish to synchronize 
to Outlook. Once you have all the contacts in the group, Click on 
File and highlight Synchronize and select Microsoft Outlook. 
This will bring up a window titled Synchronize with Microsoft 
Outlook. In the first window, you will need to select the group 
to synchronize. Beneath that, select which folder in Outlook you 
wish to synchronize your contacts with. Next, either check or 
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uncheck the box titled Export CRM contacts to Outlook. This 
option will add the contacts in the group to the selected 
Outlook folder. The next checkbox titled Delete contacts from 
Outlook when removed from CRM will check if a contact has 
been removed from the group in CRM. If the contact has been 
removed, it will also remove that contact from your Outlook 
folder. The next checkbox is used to import contacts from 
Outlook into CRM and allows you to select which team the 
contacts will be able to be accessed by. Once you have selected 
all of the options you want, Click Next. 

The next window is used for synchronizing events between CRM 
and Outlook. If you wish to use this option, select the folder in 
Outlook that contains your events. Next, if you wish to Export 
contacts from CRM or Import them into CRM, Click on the 
appropriate checkboxes. You also have the option of only 
exporting your personal events or all of the events on your 
schedule. Once you are finished selecting the options here, Click 
Next.  

The next window will show you which options you have 
selected. If everything looks satisfactory, Click Next, this will 
begin the synchronization.  
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Options and Tools 
Overview 
Items in this menu are used to maintain your system, set up 
users, create default values and store your personal 
information. 

Open Options by clicking Tools Menu | Options. 

General Tab 

 

Chapter 

17 
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Show Dashboard on startup 
Checking this box will always bring up the Dashboard screen 
when you start CRM. This is a good practice as it forces you to 
view and deal with events you have scheduled and makes it 
much tougher for you to accidentally miss things you wanted to 
follow through on 

Edit records without pressing the Edit button 
By default when you edit a record, CRM will prompt you every 
time to confirm that you are actually trying to edit a record. This 
is a built in safe guard to the system so you don't accidentally 
change a value in a field. You can change the system to prompt 
or not prompt you for changes. If you turn the prompt off, CRM 
will stay in Edit mode and anything you type into a field will 
automatically overwrite the existing values. 

Save changes without pressing Save 
By default when you make changes and attempt to do another 
function in CRM you will be prompted to save the changes you 
just made. This is a safe guard allowing you to ignore any 
changes you made to a record. You can change the system to 
prompt or not prompt you to save a record. If you turn this 
feature off, CRM will automatically save any changes you make 
overwriting any previous values in the record. 

Default country 
Each time you create a new record CRM will set the country to 
this setting. 

Default team 
When you create records in CRM it will automatically make the 
records visible to the team selected here... 
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Stamp notes 
If you press Ctrl+M or click the Edit notes link at the bottom of 
the notes text box from a record CRM will add a time stamp 
using this format to the notes field. 

Notes font 
This is a global setting for all notes text boxes. You can set the 
font type and size for all the notes windows using this button. 
You can also set the font from the link at the bottom of each 
notes window. 

Default greeting 
When you add a contact to your database you can also create a 
greeting, (nick name) for that contact. Setting the default here will 
automatically creating a greeting for each contact you add. You can 
make changes to the greeting at any time for each contact. 

Map symbol 
This sets the default map symbol when using Microsoft 
MapPoint to plot records from CRM to MapPoint. You must 
purchase MapPoint separately and it must be installed to work. 

Reset 
This will turn off all the suppression switches for warning boxes in 
CRM. You will have the option to turn them off in the dialogs. 
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Events/History 

 

Day starts at 
This setting affects the daily calendar. Set this value to the 
general time you start your day and CRM will grey out the times 
previous to this setting. You can still create events that occur 
before this time but by default your calendar will start the view 
at this hour. 

Day ends at 
This setting only affects the daily calendar. Set this value to the 
general time you end your day and CRM will grey out the times 
beyond this setting. Events that occur after this time can still be 
scheduled, but by default, your calendar will end the view at 
this hour. 
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Time slot size 
This setting only affects the daily calendar. This is for display 
purposes and printing only. The increment in this box will 
change the increment between hours. This setting does not 
affect your ability to schedule events for any time needed. 

Pop up alarm window on top of other windows 
Checking this box will force CRM to put the alarm window on 
top of anything else you are doing. If you don't check this you 
may not see your alarms as they can be hidden by other 
windows on your screen. 

Color 
Checking the color box and choosing a color will default any 
new Events or History you create to this color. In multi-user 
systems it is popular to assign a unique color to each individual 
on a team. When you view a calendar with multiple users this 
setting can make it much easier to see who has scheduled 
items. 

Event participants 
When you create an event you can set the participants for the 
event. The participants' setting decides who in your office can 
see the event on their calendar. The default setting is <just me> 
which means the event will only display on your calendar. You 
can change the default participants and every time you create 
an Event CRM will use this setting for whose calendar the event 
shows on. You have control on each event you create or edit to 
change the participants this setting is just the starting value. 

History type 
This sets the default history type. When you create a history 
record the initial type will set to this default. Each user can set 
their default history type from this menu. You can of course 
change the type while you are in a history record. 
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Update project/lead from new history records 
If you create a new history that is associated with either a lead 
or a project CRM will update the project or lead record. You can 
set this check box so that CRM always defaults to updating an 
associated lead or project. Regardless of the setting here you 
can set the value every time you create a history record. 

History for quick letters / emails 
When CRM creates a quick letter or email from the Write menu 
it can also create a history detailing what you sent. Checking 
these boxes will tell CRM to prompt you to create a history 
record before you create the document. You have the option to 
skip the history dialog if you want to. If you do not check the 
box CRM will automatically skip the history and go directly to 
creating your letter or email. You still have the option from 
Word to attach the document if you want and if you have 
Outlook set to track emails you will get a history of quick emails 
through Outlook. 

Phone 

 
Realnex CRM supports a standard modem that shares a line 
with your telephone or a telephone equipped with the 
Telephone Application Programming Interface (TAPI) and the 
appropriate telephone driver software installed on your 
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computer. ·The Dialer uses TAPI technology included with 
Microsoft Windows. TAPI functions as a link between your 
computer and your modem or telephone. 

Select the correct modem from the list of widows’ modems by 
clicking on the drop down arrow located to the left of the Phone 
device combo box. 

To set up your modem open the windows control panel and 
select Phone and modem options. CRM will default to all the 
rules set up by windows in that dialog. 

User Information 

 

The information you enter in this window will be used for 
letters, faxes, emails and other function inside CRM. Please fill 
in this information carefully and accurately. 
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Advanced 

 

Splash screen 
When CRM loads it displays an initial screen called a splash 
screen. In most cases this screen loads and unloads in a split 
second and is a nice indicator that CRM is loading. On some 
older computers this screen can be slow to close. You can 
change the setting so it doesn’t do animation or just turn it off 
completely if you feel it is slowing down the loading of the 
program.  

Always Use Advance Query Dialog 
When this box is checked, any time you do a query, it will       
automatically bring up the Advance Query dialog box instead of 
the normal query. 

Set a Query When Following a Link 
When this box is checked and you either follow a link or pop-up 
a specific record, CRM will automatically create a query for only 
that record. 

Page 368 



Chapter Seventeen 

Retain cached data 
Number of minutes CRM waits to refresh the data on your 
screen. This is helpful for multi-user systems where changes are 
constant being made by other users on the system. CRM will 
update any table you open immediately upon opening it but if 
you are "sitting" on a screen CRM will only update the database 
based on the setting in this field. Setting the frequency to low 
will slow your machine down as CRM would be constantly 
updating the data. Suggested update is 10 minutes. 

User Management 
Depending on the number of licenses purchased the CRM 
system can coordinate and maintain many users in a single 
installation. The User Management module allows the system 
administrator to create and set rights for all users in the CRM 
system. To access the user management module, Click on tools 
and highlight administration and select user management. 

To open the User Management dialog click the Tools menu in 
CRM then Administration | User Management. You must have 
administrative rights to access this dialog. 
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Adding Users 
To add a new user to the system you must have administrative 
rights. Click the New button to add a user to the system. 

User ID 

This field will be displayed by CRM in areas on the screen where 
it is helpful to their identity such as last edited by. 

User Name 

The full name of the user should be entered here. CRM will use 
this information to display information about who owns a 
record, an appointment, a record lock and other basic functions. 

Login 

The user must enter this name to login to the system. This 
should also be a unique entry for the users installed in CRM. 

Default team 

When a user creates a record in CRM there must always be a 
team associated with that record. You can set the default team 
that is used in this dropdown combo box. The user can change 
the team at any time this will just be the default team that is 
used on any new records the user adds. 

CRMLive Login 

CRMLive is a separate product that allows you to view your data 
on the web. Using the CRMLive Sync tool all your CRM data is 
automatically uploaded to the cloud. You can then access that 
information through any standard browser. Before someone 
can see the data from your system they must be registered here 
with the email they use to access CRMLive. 

Enter the login email this person uses to access the CRMLive 
website. 
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Account is Enabled 

Check this box if this user is currently using the system. If a user 
is removed from the system uncheck this box. Unchecking the 
box will keep the users records in the system but reference 
them on the record. 

Password 

Once you establish a user in the system you must enter a 
password for the user. Any password is acceptable.  

Teams 
Teams are only useful in multi-user systems. If you are a single 
user this does not apply to you and you can skip this section. If 
you are in a multi-user CRM system, teams are an important 
concept and you should read all the sections below to fully 
understand them. 

The concept of a team is simple. Everything created in CRM can 
be assigned to an individual making that record visible only to 
that individual; to everyone making it visible to anyone who logs 
into the system, or to a team making that record visible only to 
members of that team. You can create as many teams as you 
want and you can make CRM users a member of as many teams 
as you want. This allows you to make records visible to any 
individuals you choose. If an individual is not a member of the 
assigned group that individual will not be able to see the record 
no matter what they do. This effectively allows users to hide 
records from individuals they don't want to see the information. 
Teams apply to every record type so you could, for example, 
make a contact record visible to everyone but make a history 
record visible only to yourself or to a specific team.  

Adding Users to a Team 
First you have to create the team. If you have not created teams 
you must go to Teams and create them. To add a user to an 
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existing Team just check the box next to the team. To remove 
them uncheck the box. 

Permissions 
To edit permissions, open the Options Dialog by clicking on the 
Tools Menu and then selecting Administration and then User 
Management. Next select the permissions tab. 

Teams and Record Owners 
Most records in Realnex CRM have two special properties--an 
owner (record owner) and a team. These properties serve two 
purposes: 

 - They form the basis for the privacy and security functions that 
control which users are allowed to view and modify each 
record. 

- They provide a way to filter the huge amounts of data 
produced by a large organization, so that users are not forced to 
wade through masses of information that are not relevant or 
interesting to them. 

Record Owners 
The owner of a record is normally the user who initially created 
it, though users with special privileges ("super users") are 
allowed to reassign records to different owners. The owner of a 
record can always view and edit it, regardless of any other 
permission settings. 

Teams 
The team is the basis for sharing information in Realnex CRM.  A 
team is a group of users. Users can create teams, add other 
users to them, and control the privileges that other users have 
within their teams. 

Page 372 



Chapter Seventeen 

Each record belongs to exactly one team. The record is visible 
only to members of that team (and to its owner, in the rare case 
that he or she is not a member of the team). 

Adding a Team 
To add a new team, Click the New tool button. Enter a unique 
Team name and select the owner of the group. Depending on 
rights, the owner may be the only user who can edit or add 
members to the team. 

Select the members of your system that are part of the group by 
checking the box in front of their name. 

Editing a Team 
Highlight the Team you want to edit and Click the Properties 
Tool button.  

Deleting a Team 
Highlight the Team you want to delete and Click the Delete Tool 
button. You cannot recover a team once you remove it.  

Besides user-created teams, there are some special teams that 
always exist: 

 The global team: (called "<everyone>"), which contains every 
user in the system. A record assigned to the global team can be 
seen by anyone. 

Private teams: Each user is automatically given a team called 
"Private", of which he or she is the only member. By assigning a 
record to his or her private team, a user can make it invisible to 
everyone else. 

Neither the global team nor the private teams can be deleted or 
modified. 
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User and Team Permissions 
Record owners and teams control which users are allowed to 
see each record. The permission mechanism controls the ways 
in which users are allowed to create, modify, and delete them. 

A user has two sets of permissions. One set, called the user 
permissions, control the ability to perform operations related to 
the program as a whole. The others, the team permissions, 
control the ability to operate on records which belong to a 
team. Each user can have a different set of permissions in each 
team he or she belongs to. This makes it possible for groups of 
people working together on shared data to define their own 
working policies. 

User Permissions 
User administrator: An administrator can control access to 
Realnex CRM by creating accounts for other users and 
controlling their user permissions. An administrator is also the 
only person who can change users' team permissions for the 
global team. 

Backup database: this person will have rights to use the File | 
Backup menu in CRM to make backups of the database.  

Super user: A super user can edit any record in the system, 
regardless of its owner or team permissions. A super user 
automatically has all other user and team permissions, except 
for the administrator permission. 

Change Record Owners: A user with this permission can 
reassign ownership of any record to a different user. 

Edit Field Definitions: This permission allows a user to change 
the labels, edit masks, and various other properties of table 
fields. 
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Edit Pop-up Tables: This permission allows a user to edit the 
pop-up tables associated with text fields. 

Edit System Tables: Allows a user to modify various system 
tables, such as:  the list of event types for event and history 
records; the list of status codes for history records; the country 
definition table. 

Import Data: Allows a user to import data from an external data 
source. Restricting access to this feature lets an administrator 
protect the system against careless additions of useless or 
poorly-structured data. 

Export Data: Allows a user to export data to external programs 
or data files. Restricting access to this feature lets an 
administrator safeguard an organization's proprietary data. 

Synchronize with Microsoft Outlook: This person will be able to 
sync information between Outlook and CRM. 

Create teams: This permission allows a user to create and 
administer his or her own teams. 

Global replace: This permission gives the user access to the 
global replace menu. This gives them the ability to mass update 
fields in CRM. Once you replace a field in CRM there is no way 
to undo that change. This permission should be restricted for 
most users of your system. 

Delete Contacts/Companies; Delete Properties; Delete Events; 
etc.: Allows a user to delete records from the system. These 
permissions are intended to protect against accidental data loss 
through careless use of the "delete" feature. Note that even if a 
user has delete permission, he/she must also have the 
appropriate team permission for editing a record in order to 
delete it. 
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Team Permissions 
A team owner or administrator can set these permissions for 
other users on records that belong to that team. Only a system 
administrator can set these permissions for users in the global 
team. Team permissions are under the Team tab. 

Administrator: Not to be confused with the "administrator" 
user permission, a team administrator can control which users 
are members of the team and set their permissions. The owner 
of a team can always act as an administrator. 

Add Contacts/Companies: Add Properties; Add Events; etc.: 
Allow a user to add records of the corresponding type to the 
team's data set. Adding a record can mean either creating a 
new record or reassigning one from a different team. To 
reassign a record, the user must also have permission to edit it 
(either by being the record owner or by having edit permission 
in its old team). 

Edit Other Users' Contacts/Companies: Edit Other User's 
Properties; etc.  

Controls whether a user can edit records that belong to the 
team but which he or she does not own. 
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Database Manager 

 

The Realnex CRM Database Manager allows you to perform 
several useful functions. The following is a list and brief 
description of those functions. For more details on each 
function follow the link to the actual function. 

To use the Database Manager you must have access to and 
know the login and password information for the SQL Server. 
This is different from you standard Realnex CRM login 
information. See you network administrator if you do not have 
this information. 
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Backup 
You can back up CRM from the File menu in CRM or you can use 
the Database Manager. Both options perform a backup of the 
CRM database and place the backup in a compressed file on 
your hard drive. Once this file is created you can copy it to a CD-
ROM or other device for safe storage. 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the Backup button. 

4. Check the boxes that apply (see description of each 
below). 

SQL Server database. 

This is the actual Realnex CRM database such as 
contacts, properties, history and events. 

Truncate the transaction log. 

SQL keeps a log of every change that is made. This 
log can get very large and slow down performance. 
Checking this box will clear the log on your machine 
and put the changes in the backup file. If you are 
using other SQL programs you should not check this 
box or if you are using the purchased SQL system 
with enterprise manager you should not check this 
box.  

User accounts and passwords 

This backs up all the users in your system and their 
passwords.  

Shared files 
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These are the files outside of the CRM database such as 
letters, pictures and report files. These files can be quite 
large and slow down the backup process. 

5. Options 

You can choose to password protect any backup. 
However if you choose to password protect the file and 
you forget your password there is no way to recover it. 

6. Click the Backup button to begin your backup. 

7. Choose a location for the file (and a name if you don't 
like the one CRM creates). Remember where you put 
the file so you can copy it to a CD or other medium 
later. If you have a zip drive or some other drive that is 
accessible you can write directly to that drive by 
selecting it. 

8. If you get any errors during the backup read the 
message and correct the problem then Click the backup 
button again. CRM will tell you 

Restore 
You can use this function to restore a backup you made in the 
backup function. This also allows you to take a database from 
one system and put it on another one. The restore function will 
delete any existing data on the machine you restore to it cannot 
merge data from a backup into an existing CRM. 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the Restore button. 

4. Read the warning message, CRM will replace any Realnex 
CRM database already on this server. If you don't want to 
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replace the database on this server answer NO and quit 
out of the restore option. 

5. Find the backup file you want to restore, select it and Click 
Open. 

6. Check the boxes that apply (see description of each 
below). 

SQL Server database 
Realnex CRM database such as contacts, properties, 
history and events. 

User accounts and passwords 
Restores the users and their passwords to the server. 

Shared files 

This will restore the outside files from your backup such 
as letters, pictures and report files. These files can be 
quite large and slow down the restore process. 

5. Click the Restore button to begin restoring your data. 

6. If you get any errors during the restore read the message 
and correct the problem then Click the restore button 
again. CRM will tell you when the restore is done and was 
successful. 

7. In some cases CRM will have a problem restoring all the 
user accounts. If this happens CRM will warn you of the 
problem and you can answer yes to go in and fix the 
accounts. 

Upgrade Tables 
When you update CRM it usually requires also updating the 
database. Updating your machine does not automatically 
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update the Realnex CRM SQL database. Using this utility will 
allow you to update the database. 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. STOP! MAKE SURE NO ONE IS USING Realnex CRM. Click 
the Upgrade Database button. 

4. In the "Select Upgrade Version" dialog select the highest 
upgrade version available and Click Next. 

5. In the "Ready to Upgrade" dialog Click Next. 

6. The Database Manager will prompt you to back up your 
database before upgrading. If you have your own SQL 
licenses and are using the Enterprise Manager to backup 
you do not need to backup. If you are using the Desktop 
SQL engine that shipped with CRM you should answer yes 
to this prompt and back up now. If you are not backing up 
CRM skip to step 10 now. 

7. In the Backup dialog check the items you want to back up. 

8. Click the Backup button. 

9. In the "Save As" dialog choose the location and name of 
the file you want created. 

10. Click Next and CRM will update your database. 

Registration 
Using the registration function you can register Realnex CRM. 
To get a license key will need to send your Database ID to the 
CRM technicians. They in turn can send you a registration code 
based on when you purchased Realnex CRM and how many 
users you purchased. 
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1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the Registration button. 

4. Call CRM support and give them your contact information 
and Database ID and they can help you get your software 
registered. CRM support can be reached at (858) 792-
0154. 

User Accounts 
Sometimes when you restore a backup (especially from a 
different machine) you will need to make changes to the user 
accounts. This function gives you access to those accounts. 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the User Accounts button. 

4. CRM will list the Status of the account for each user. You 
can Add, Edit and Delete users from this dialog. 

If you had a problem after restoring with a user try 
highlighting them, clicking Edit and clicking OK. If you are 
still having problems you may have to call CRM technical 
support at (858) 792-0154. 

User Logins 
Before you do functions in the CRM Database Manager you 
should clear everyone from the system. Click the user Logins 
button to see if anyone is currently logged into CRM. From the 
Login dialog you can disconnect those users before you perform 
an operation. 
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Postal Codes 
Postal codes are updated every quarter. Current users can 
update their postal codes using this routine. You can get the 
new postal codes from CRM or on the CRM CD.  

Both US and Canadian zip codes are currently support by CRM. 
To update your postal codes do the following: 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the Postal Codes button. 

4. Locate the zip code file on your CD or hard drive. 

5. Highlight the file and Click Open. 

6. Check the boxes for the zip codes you want to install. 

7. Click OK. 

8. CRM will remove the old zip codes for the selected 
country and install the updated ones automatically. 

Distribute Updates 
The other users in your system have not been updated. CRM 
can automatically update them when they log in if you add the 
update file to the Distribution manager. To add the updates 
follow the steps below. 

1. Click the Distribute Updates button on the Database 
Manager. 

2. Click the Add Update button. 

3. Select compressed package (single EXE file) in the Update 
Type dialog. 

4. Locate the CRM10-####.exe file that you used to update 
your machine. Select it and Click the Open button. 
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5. In the Update Properties dialog Click OK. 

6. As your users log in to Realnex CRM they will be 
prompted to update their computers.  

 

Shared Folder 
Realnex CRM stores all the auxiliary files such as letters, 
pictures, report files and linked files in a shared folder. If you 
change machines or change the location of that shared folder 
you can tell CRM the new location using this function.  

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 
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3. Click the Shared Folder button. 

4. Type in the new location of your shared folder or Click the 
ellipses to locate the folder. 

5. Click OK. 

Optimizing Reports 
There is a bug in Crystal Reports that causes it to look for the 
server each report was created on before looking for your 
server. Since most of the reports were created by CRM Crystal 
takes about 30 seconds trying to find the CRM server and then 
gives up and looks for your server. CRM created a program that 
will automatically change all the Crystal Reports to look for your 
server instead of the server listed in each report. You need to 
run this feature once for your server and if you change servers 
you need to run it again. 

1. Click Start | Program Files | Realnex CRM | 
Administrative Tools | Database Manager.  

2. Click the Connect button and login to your server. 

3. Click the Optimize Reports button. 

4. Click OK. 
5. Have a cup of coffee while CRM changed each of the 

report files to look for your server. 

Organize Files 
All your attachments are stored in a single folder. Attachments 
are things such as emails, photos, documents, spreadsheets and 
the like. Depending on your use of CRM this fold can contain 
thousands of files. You can speed up the searching of this folder 
if you let CRM organize it for you. Your choices are none, 
monthly, weekly or daily. Depending on the choice you make 
CRM creates subfolders and moves the files into the correct 
subfolder by the data the file was created. 
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Monthly will create a folder for each year and under those 
folders it will create the twelve months and put the files in the 
correct folders for you. 

Weekly and Daily do the same thing but create subfolders under 
the monthly folder and weekly folder if you selected daily. 

Admin Password 
Using this feature you can change your SA password to access 
your SQL Server using SQL Authentication. You should only use 
this feature if CRM Technical Support directs you to. 

SQL Console 
This is an advanced feature that should only be used at the 
direction of CRM Technical Support. This feature gives you 
command access to the Realnex CRM SQL Database and should 
be used with great caution. 
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Mapping 
Mapping 
You can map any address from CRM using the Internet and the 
mapping function in Realnex CRM. While looking at any address 
in CRM, Right-Click and choose the map address option on the 
menu. 

CRM supports four internet mapping systems as well as 
Microsoft MapPoint. 

NOTE: To use Microsoft MapPoint you must own a licensed copy 
of the product. You can purchase MapPoint at most retail stores or 
on-line, once MapPoint is installed CRM will automatically work 
with the program. 
 
To use the internet mapping systems you must have a connection 
to the internet. 

Mapping Using the Internet 
1. Click the Map Tool button on the toolbar. 
2. From the Map Address Dialog select the Service to use. 
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3. Click OK 

 
Map links 
When you see an address listed in CRM you will usually see a 
[map] prompt right after the address. That is a hyper-link you 
can click it to map the address listed. 

Microsoft MapPoint 
Microsoft MapPoint is an add-on product that works with 
Realnex CRM and must be purchased separately. You can 
purchase Microsoft MapPoint through most retail stores or on-
line. 

Using Microsoft MapPoint with Realnex CRM gives you the 
ability to map multiple records, create routes and get 
directions. You can also use the map to find properties or 
contacts within a specific area by drawing shapes on the map 
and searching for records inside that shape. 

Map symbol 
You can set the default mapping system for Microsoft MapPoint 
from the CRM Options Dialog under the General Tab. For more 
information see Map symbol. 
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Mapping a Single Record 
1. Click the Map Tool button on the toolbar. 
2. Select MapPoint/CRM as the Service. 

 

3. Click OK 

Mapping Multiple Records 
1. Open the Realnex CRM table you 

want to map such as Properties, 
Spaces, Sale Comps, Contacts or 
Companies. 

2. Query CRM for the set of records 
you want to map. 

3. From the Realnex CRM Look up Menu select Map 
Addressees. 

4. If an address cannot be located CRM will prompt you 
with the Address Resolution Dialog. 
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Address Resolution 

 

This dialog is displayed when MapPoint cannot find an address. 
The dialog will suggest similar addresses for you to choose from 
or you can type in address(es). 

 To type in another address and try to find it 
1. Type in the address information. 
2. Click the Find button. 
3. Click OK to map the address this will not change the 

underlying CRM record. 
 To change the address of the CRM record 

1. Click the Edit Record button. 
2. Change the address and save the record in CRM. 
3. Click OK to map the address. 
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Don't map an address 
Click the Never Map this Address button while it is listed in the 
Find dialog. Checking this box will force CRM to bypass the 
record. Turn map this address back on in the CRM Address 
Detail dialog. 

To change the setting, open the CRM Edit Details dialog for 
that record and Click the Geo code button. Uncheck the 
Address is not mappable checkbox to reset the record and allow 
MapPoint to plot it. You can also type in the Latitude and 
Longitude for a property from this dialog. 

Save Geo code 
If MapPoint cannot find the address but you can locate it using 
the address finder, check this box and CRM will update the geo 
codes on the record. You can also physically enter a geo code 
for a property such as raw land from the address details dialog 
in CRM. You can use programs such as Google Earth to get the 
correct geo codes for a location. CRM uses the decimal values 
for Latitude and Longitude. 

Skip a record 
If the record CRM can't find isn't important for this mapping you 
can Click the Skip button and CRM will just discard that record 
from the plot. 

Skip all bad addresses 
If you want CRM to skip every bad address it finds during a plot 
Click the Skip All button and CRM will continue to skip any 
records with addresses that cannot be resolved. The next time 
you plot CRM will again stop and ask you to resolve the 
addresses again. Use the Never Map this Address button to 
always ignore the record. 

Plotting Records from a Shape 
1. Click the View Menu and then MapPoint/CRM. 
2. Click the Map Menu and then Search. 
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3. Select the table you want to search. 

 

4. Click on the Map and Select the Drawing Tool to use. 
 NOTE: If you do not see the drawing toolbar at the bottom of 
the map Click the link in step two to display the drawing toolbar (1) 
and then Click on the map. 

 

5. Select one of the following drawing tools (2) and draw 
your shape. 
Freeform: Draw any shape on the map. 

Rectangle: Any size box or rectangle. 

Oval: Any size circle. 

Radius: Start at the point of origin, hold the mouse 
and move away from the point of origin. The 
map will show you the distance from the 
origination point next to your cursor. 

6. From the CRM Map Search Dialog select the Symbol 
you want to plot (you can set the default symbol CRM 
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uses to plot points from the CRM | Tools | Options 
menu. You have the capability to change the symbol 
from this dialog every time you plot a record. 

7. If you want to see the records mapped in CRM check the 
box that says Tag records found by search. If you have 
previously tagged records in CRM make sure you check 
the Clear tags before starting checkbox to remove any 
existing tags in your table. 

8. To view the records plotted in CRM Click the Tag Tool 
button on the table and choose Show Tagged. 

 

Creating a Route 
1. Click the View Menu in CRM and select MapPoint/CRM 

to open the mapping software. 
2. Click the View Menu in CRM and check Route Planner. 
You can either type in the starting point in the Route Planner 
or use CRM to plot it. 
3. To plot the record using CRM 

a. Select the correct table in CRM and locate the record 
to plot. 

b. Click the Map Tool button and select MapPoint/CRM 
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c. Once the point is plotted on the map Right-Click the 
point and select Route | Add as Start. 

Plot the second point using the same method but this time 
select Route | Add as End. 

4. Click Get Directions to display the route information 
between the two points. 

 Creating a Tour 
1. Map all the points you want to tour using CRM and 

MapPoint. 
2. Click the View Menu in CRM and Check Route Planner. 
3. Right-Click the starting point for your trip and select 

Route | Add as Start or type it into the route planner, 
Right-Click it and select Add as Start. 

4. Right-Click the ending point and select Route | Add as 
End or type it into the route planner then Right-Click it 
and select Add as End. 

5. Right-Click on the other stops in the order you want to 
visit them selecting Route | Add As Stop. 

6. You can Click on the stops and choose More Options to 
set the length of the stop and other options. 

7. You can also Right-Click on a stop on the map and select 
Nearby Places to plot a spot such as a restaurant and 
add that to your tour. 

8. Once you have all the points set you can Right-Click on 
any point and choose Optimize Stops which will let the 
map choose the best route to take. 

9. Click Get Directions to get the full turn by turn route for 
your tour.  
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Get Directions 
To get Directions you must first map at least two points on your 
map. Use the directions for plotting records and then Right-Click 
on the records, select Route | Add as Start or Add as End. 

To plot multiple locations follow the directions in the Creating a 
Route section of this help file. 

Clear Pushpins 
If you want to clear the map of all pushpins Click the Map Menu 
in CRM and Click Clear Pushpins. 
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19 
Other Features 
Instant CRM 

nstant CRM is an add-on program that is included with CRM. 
The program runs in your windows system tray even when 
CRM isn't loaded. It checks your calendar 24/7 and lets you 
know if you have a reminder. You can also set up Instant 

CRM to sync your contacts and events to Outlook. 

Loading Instant CRM 
You'll find Instant CRM in your program list. 

1. Click START | All Programs and find the Realnex CRM 
group of programs. 

2. Open the group and click Instant CRM. 
You'll see the program loaded in your system tray 

 

Right click the icon to see the menu 

I 
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To have Instant CRM load when you start your computer check 
the box that says "Run Instant CRM automatically when I log in 
to Windows" check box. 

You'll need to set up your server options to see your calendar in 
Instant CRM. 

1. Click the Server Options button. 

2. Enter the same settings you have in CRM.  

3. Load Realnex CRM 
4. Click the File menu and click Log In... 

5. Copy the settings into Instant CRM and click OK. 
If you would like Instant CRM to automatically sync your 
Outlook contacts / events check the box. 

Set the interval and make sure your Outlook Setting are correct. 

These settings will be pulled from your current Outlook Sync 
settings in CRM. 

Today View 
The Today View in Instant CRM is the same as the Dashboard 
View of events. Basically you can do everything on the Today 
screen you can do on the Event tab for Dashboard. Rather than 
retype everything that is already in this help file on using the 
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functions on the Today View please look at the section in this 
help file on Dashboard. 

You do not have to load CRM to use the Today Screen in Instant 
CRM. This program will also check for any alarms you have set 
in CRM regardless of if CRM is running or not. 

Calendar View 
The Calendar View in Instant CRM is the same as the Calendar in 
CRM. 

For more information please see the Calendar section in this 
help file. 

You do not have to load CRM to use the Calendar View in 
Instant CRM. This program will also check for any alarms you 
have set in CRM regardless of if CRM is running or not. 

Working with Events 
You can add, edit, delete and view all your events from both the 
Today and Calendar View in Instant CRM. Any events or alarms 
you create in Instant CRM are automatically a part of CRM. The 
vice versa is true as well, any event you add, edit or delete in 
CRM will automatically become part of CRM. 

This also applies to events you add, or modify in Outlook or your 
phone assuming you are syncing your events with Outlook. 

Using Auto Sync 
Using Auto Sync is simple. 

Load Instant CRM... Really that's it. 

You do have to configure it one time but from then on just 
make sure it is loaded. If you've turned on "Run Instant CRM 
automatically" you don't even have to load it. 
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Attachments 
Attachments allow the users to attach files and pictures to your 
properties and contacts. Attaching pictures is not only useful 
when viewing a property but also for reports. You can also 
attach documents, PDF files, Excel and Word documents or any 
other file on your hard drive. Attaching files to your records puts 
them at your fingertips. 

All attachments will be copied from the location you specify to 
the Realnex CRM Shared Folder. CRM will not interact with the 
original file on your hard drive it will only see the copy it creates 
in the Shared Folder.  

Attaching Photos 
You can attach as many photos to a record as you want but only 
the default photo will be displayed in the picture window on the 
status bar. CRM will copy the photo or file you specify to its 
Shared Folder and will not see future changes you make to the 
original file. If you want to make changes to the photo you 
should use CRM to open the photo. 

 

Attaching a picture (drag & drop) 
1. Open the picture frame on the status bar if it is not 

visible. 

2. Click on the picture you want to add and drag it onto the 
picture frame in CRM. 

3. Release the Mouse button and drop the picture in the 
frame. 
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4. Give the picture a description and set the parameters. 

5. Click OK. 
 

 

Attaching a picture (using the clipboard)  
1. Open the picture frame on the status bar if it is not 

visible. 
2. Right-Click on the picture you want to add and choose 

copy. 

3. Right-Click in the CRM picture frame and choose Add 
from Clipboard... 

4. Give the picture a description and set the parameters. 
5. Click OK. 
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Attaching a picture (from your hard drive)  
1. Click the Attachments tab in the List panel. 

2. Right-Click in the Attachments window and choose Add. 

3. Find the picture you want to attach on your hard drive 
and open it. 

4. Give the picture a description and set the parameters. 

5. Click OK. 

Attaching a picture (from and email)  
6. Click the Attachments tab in the List panel. 

7. Click & Drag the Attachment from your email and drop it 
in the CRM attachment window. 

8. Give the picture a description and set the parameters. 

9. Click OK. 

Setting the Default Photo 
CRM displays one of your attached photos as the default in the 
picture panel. You can select which photo is the default. 

The default photo will also be used on reports you print. 

Setting the default photo 
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1. Click the Attachments tab in the List panel. 

2. Right-Click on the picture you want to set as the default. 

3. On the menu Click Default. 
If you had another picture set as the default CRM will 
automatically change that photo to a regular attachment and 
replace it in the picture frame with the new default photo. 

Adding an Attachment 
You can attach as many computer files to a record as you want. 
CRM will automatically remember what program to use when 
you want to open the attachments later. CRM will copy the file 
you specify to its Shared Folder and will not see future changes 
you make to the original file. If you want to make changes to 
the file you should use CRM to open the photo. 

Attaching a file (drag & drop) 
1. Click on the Attachments tab in the list panel. 

2. Click on the file you want to attach and drag it into the 
CRM attachments panel. 

3. Release the Mouse button and drop the attachment in 
the panel. 

4. Give the attachment a description and set the 
parameters. 

5. Click OK. 

Attaching a file (using the clipboard) 
1. Click on the Attachments tab in the list panel. 
2. Right-Click on the file you want to attach and choose 

copy. 

3. Right-Click in the CRM attachments panel and choose 
Add from Clipboard... 

4. Give the attachment a description and set the 
parameters. 

5. Click OK. 

Page 403 



Other Features 

Attaching a file (from your hard drive) 
1. Click the Attachments tab in the List panel. 
2. Right-Click in the Attachments window and choose Add. 

3. Find the file you want to attach on your hard drive and 
open it. 

4. Give the file a description and set the parameters. 
5. Click OK. 

Viewing / Editing Attachments 
NOTE: CRM stores photos and attachments in its Shared Folder. 
If you want to change the contents of an attachment you should 
use CRM to open the file. Making changes to a file you copied 
from your hard drive will not be reflected in CRM. CRM will only 
see the copy of the file it created in its Shared Folder. 

Opening an attachment or Picture 
1. Click the Attachments tab in the List panel. 

2. Right-Click on the attachment or picture you want to 
open. 

3. On the menu Click Open. 

Making Changes to a Photo or Attachment 
1. Open the Attachment / Photo as described above. 

2. Make changes to the file and save it. 
3. Do not change the location or name of the file. 

 

Remember CRM stores a copy of your attachments in its own 
Shared Folder so you must either use CRM to open the file or 
make sure you are editing the attachment located in the CRM 
Shared Folder. 

Deleting an Attachment or Photo 
1. Click the Attachments tab in the List panel. 
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2. Right-Click on the attachment or picture you want to 
delete. 

3. On the menu Click Delete. 

4. Click Yes. 
 

Smart Meetings 
CRM connects to LogMeIn’s join me program. This lets you 
share your desktop with other computers. 

1. Click the Share button on the main CRM toolbar. 

 

The first time you run the application you’ll need to sign up. 

 
2. Click the share button  

3. Follow the prompts 
4. Click the ‘x’ in the top right corner to quit the application 

5. Check the box to save the program 

6. Then click Yes to quit. 
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The next time you click the Share icon in CRM the program will 
load and give you a link. 

To begin a meeting with other people you need to give them 
the link that appears in the join me window. 

 

The link above is an example you will generate your own link 
each time you begin a session.  

Tell your client to load their browser and in the address line 
type in exactly what you see in your join me window or tell 
them to load their browser and type in join.me in the address 
bar. 

Then in the join box type in the 9 digit number displayed in your 
join me toolbar. 

You can also click in the space where the link is displayed and 
choose email. This will create an email with the link in it so you 
can just send it and your client can click the link to see your 
screen. 

This program also includes a free conference call phone number 
you can give if you have multiple people joining you on the 
session. Just click the phone icon to get the private conference 
call number. 

You can use the chat button if you want to chat with one or 
more of the people viewing your screen instead of talking to 
them. 
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The join me program will only display your main monitor. If you 
have multiple monitors your clients will not be able to see the 
other monitors. 

You can pause the screen viewing by clicking the pause button 
in the middle of the join me toolbar. To start sharing your 
screen again click the forward arrow in the middle of the join 
me toolbar. 

To end the meeting click the ‘X’ in the top right corner of the 
join me toolbar. 

Smart Web Links 
Web Links give you quick access to the power of the internet. In 
their simplest form Web Links can just take you to any web 
page. The real power behind CRM Web Links comes in their 
ability to pass any web page information from the record you 
are on. 

 

To use a web link you click the Web Link tab in the Lists Panel on 
any record. Then double click the link you want to use. 

Adding a Web Link 
1. Open the table you want to add a link to 

2. Right click in the window and click New 
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3. In the web link editor type in the description of your web 
link 

4. The Type field will already be set to the table you started 
the link from. 

5. In the link box paste the link for the web page you want 
to go to. 

 

If the web page link contains specific information such as an 
address, parcel number, contacts name replace that 
information with the fields from the database. 

For example I loaded my browser and Googled for San Diego 
Weather my browser returned a web site and in the address bar 
of my browser it showed 

http://www.weather.com/weather/today/San+Diego+CA+9212
2 

I copied that link by highlighting it and right clicking and 
choosing Copy. Then I right clicked in the CRM web link editor 
and pasted that address into the Link field. 
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Next I highlighted San+Diego+CA+92122 and deleted it. 

Then replaced that with the City + State + Zip fields from the 
CRM field list. 

First I double clicked on City then I typed a + then I double 
clicked on State and typed in a + and then Zip Code. 

 

I saved my link  

 

When I click that link from any contact record CRM will pass the 
records City + State + Zip Code to the weather link and show me 
the current weather for that contact. 

Deleting a Web Link 
1. Open the table you want to delete a web link from 

2. Right click the web link and chose delete. 
Page 409 



Other Features 

3. Confirm you want to delete the link 

Editing a Web Link 
1. Open the table that contains the link you want to edit 
2. Right click the web link and chose edit. 

 

In the web link editor make any changes you want 

Click OK to save your changes. 

Web Link Manager 
You can manage all your web links using the web link editor. 

To access the program click the Tools Menu in CRM and click 
Web Links 

 
From this screen you can manager all your web links. 

Since this is not table specific if you add a new link make sure to 
select the correct table or if the link is generic set the type to 
Unknown. 

Generic Web Links 
You can create a single web link that is visible from any table by 
setting the Type to Unknown. 
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When you create a web link with a type of Unknown you cannot 
pass any field information to the web site but this is useful if 
you have a favorite web site you like to use and you just want it 
available from any record you are in. 

For example I like to check www.espn.com for sports news. So I 

1. Click Tools | Web Links 

2. Click New 

 
3. Enter ESPN in the Description Field 

4. Set the Type to Unknown 
5. In the Link windows I type in http://espn.go.com 

6. Click OK. 
Now ESPN will show up in the link window on all my tables. 

Web Link Groups 
You can create Web Links and group them making it easier to 
find links if you have a lot of them. 

For example I like several different football sites but it would be 
nice to have them all listed under one group. 

I create my link like usual 
1. Click Tools | Web Links 

2. Click New 
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3. Description: NFL ESPN 

4. Type: Unknown 
5. Link: http://espn.go.com/nfl 

6. File under: NFL Football 

7. Click OK. 

I add a second link 
1. Description: NFL Network 

2. Type: Unknown 
3. Link: http://www.nfl.com/ 

4. File under: NFL Football 

I add a third link 
1. Description: NFL Yahoo 

2. Type: Unknown 
3. Link: http://sports.yahoo.com/nfl 

4. File under: NFL Yahoo 
Now my NFL sites are grouped under the heading NFL Football. 

 

Page 412 



Chapter Nineteen 

You could do this with your Stocks or any site you like to check 
frequently during your day. 

Now ESPN will show up in the link window on all my tables. 

CRM accepts ftp, http, and https as “safe” schemes and will not 
warn you if you use one of those for a link. You can define your 
own schemes as well. To define your schemes click the Tools 
menu and select Administration | Global Settings 

Click the General Tab 

 

You can add more schemes to the set, separate each scheme 
with a comma. For example some people use “file:” URL’s.  You 
could add file to the list of schemes and then use a field to take 
you to a folder on your hard drive where you store files for a 
specific property. 

We have added a set of parameters you can use when creating 
your Smart Web Links in CRM. For the most part you won’t 
need them but in some cases a web site will require specific 
formatting for a value so they can be handy to have. 

These values follow the SQL RegexReplace expressions 
documented in the import section of this manual. 

The format is {user_1:s/tim/tom/} 
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This says take the value in the field user_1 from my CRM record. 
Find “tim” and replace every occurrence with “tom” 

You can substitute any field for the user_1 example above. 

The first part of the parameter is the “:s”. You follow the CRM 
field immediately with a “:s” to tell CRM you are substituting 
values. The character that follows the “:s” is the separator. You 
can use any non blank separator you want. For my examples I 
will use the forward slash so for these examples I’ll be using 
“:s/” after the CRM field. 

After the “:s/” you put the value you want to replace. In my 
example above I wanted to replace “tim” with “tom” so I put in 
“:s/tim/”. You follow the value you want to replace with 
another separator. Since I defined my separator as a forward 
slash I follow tim with another forward slash. 

The last value is the replacement string. I want to replace “tim” 
with “tom” so my parameter is “:s/tim/tom/”. You end your 
parameter with the separator you defined. 

There are also some special case characters you can use in your 
parameter list. 

. means any character 

* means any number of the preceding 

$ means the end of the source string 

\s+ means spaces in the text 

Here is an example using these special characters. Let’s say I 
have a web site that looks up a city / state when you pass it a 
zip code. The website only works on 5 digit zip codes so if you 
pass it a zip plus 4 it will fail.  

That means this expression would fail if your CRM record had a 
zip + four.  

{primary_address.zip_code} 
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But if you included the parameters like the example below CRM 
would always strip off the “-“ and anything that followed it. 

{primary_address.zip_code:s/-.$//:s/\s+//} 

Here is a breakdown of what this example says 

First I declared my separator as a forward slash. 

Next I passed a dash with the parameter .$ which says also 
include any character after the dash to the end of the zip code.  

Lastly I passed a completely empty replacement string and then 
ended my parameter with my separator the forward slash. 

Let’s say I wanted to include Canadian Postal Codes but the web 
site doesn’t like spaces. I could use the \s+ parameter to find 
any spaces in my zip code and remove them. 

{primary_address.zip_code:s/\s+//} 

This says find any spaces in the zip code field and remove them. 

You can also put in multiple parameters so I could remove the 
spaces from a zip code and delete the “-“ and everything after it 
just by putting these two parameters together as in: 

{primary_address.zip_code:s/-.$//:s/\s+//} 

Another very useful modifier is the “quote” modifier which 
looks like 

{contact_info.user_1:q} 

Normally when CRM inserts a field into a URL is URL-encodes it, 
which prevents special characters in the field from becoming 
part of the URL. For example, if user_1 contains "sale/lease" it 
would be changed to "sale%2flease" so that the web browser 
doesn't get confused and think the slash separates parts of the 
URL. However, you might sometimes *want* confusion. For 
example, if you store a file path in user_1, your web link might 
look like 
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file:{contact_info.user_1:s.\\./.:q} 

If user_1 contains "\\TIMSPC\Public\Downloads" then without 
the ":q" the link would produce 

file:%2f%2fTIMSPC%2fPublic%2fDownloads 

which won't work. With ":q" it produces 

file://TIMSPC/Public/Downloads 

Note also that this example web link fails validation when you 
try to save it in the web link editor, but you can override by 
selecting the "save it anyway" option. 

This option for web links is extremely advanced and we included 
it to make just about anything possible for Smart Web Links. For 
the most part you won’t use them but in special cases these 
could come in very handy so we’ve included them. 

CRM Help Menu 
CRM contains an internal system that is available to help you 
any time you need it. You can access the help system by 
pressing {F1} from anywhere in CRM. Pressing {F1} will pass the 
current screen you are on to the help system and display useful 
information about that screen. In most cases you can answer 
your questions just by using the help screens. 

Contents Menu 
The Contents Menu works like the table of contents in a book. 
Each chapter and section in that chapter is listed. Click and item 
listed in the Contents and CRM will jump to that section. 

Index 
The Index Menu works like an index in the back of a book. 
When the help file is created the author flags certain words in 
the file and those show up here to help you find common 
features. Click the Help Menu and then choose Index. 
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Context-Sensitive Help {F1} 
From any screen in CRM you can press the F1 key on your 
keyboard to get related help for the function or screen you are 
on. You can also Click the Help Menu and then choose Context-
Sensitive Help. 

Global Replace 
Global replace will allow you to replace field values for multiple 
records in one single action. You can use this function in the 
Company, Contact, Property, Space, Sale Comp, Lease Comp 
and Dashboard Tables.  

You can replace a field with a literal value or with a complex 
expression as well as calculations for both numeric and date 
fields. 

Some common uses for this function are: 

 Clear a field so it can be used for some other reason  

 Hook multiple contacts to the same address/company 
record  

 Change upper case entries to mixed case  

 Replace a field with a calculation  

 Move the information from one field to another 

  

There is no undo option for Global Replace so you should 
always make a backup of your database before you use 
this function 

Selecting Records for Global Replace 
You can use the global replace function from a complete record 
and from the list view {F5}. 

1. Open the table that contains the records you want to 
replace 

Page 417 



Other Features 

From the Record View: 
1. Query your table to select the records you want to replace. 
2. Click the Lookup Menu and choose Global Replace. 

 From List View: 
1. From the View menu select List or press {F5}. 
2. Highlight the records you want to replace using your 

mouse. 
 
To highlight consecutive records Click the first record and 
while holding down the [Shift] key Click the last record in 
the list. 
 
To highlight random records hold down the [Ctrl] key 
while clicking the records. 

3. Click the List Menu and choose Global Replace. 

Events / History 
You can use the global replace function from the Dashboard 
screen {F2}. 

1. Open the Dashboard Screen {F2}. 
2. Query your table to select the records you want to replace. 

1. Highlight the records you want to replace using your mouse. 
• To highlight consecutive records Click the first record and while 

holding down the [Shift] key Click the last record in the list. 
• To highlight random records hold down the [Ctrl] key while clicking 

the records. 
3. Click the Lookup Menu and choose Global Replace. 

Clear a Field 
THERE IS NO UNDO OPTION FOR GLOBAL REPLACE. 

MAKE SURE YOU HAVE A VALID BACKUP BEFORE YOU USE THIS 
FUNCTION. 

Remove information in a field and replace it with a blank: 
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1. Query your table to find the records you want to update. 
2. From the Lookup menu select Global Replace. 

 
3. From the drop down list select the field you want to 

replace. 
4. Click the radio button in the replace with section in front of 

[Clear field]. 
5. Click {OK}. 

All the available records will be updated with the new value, 
there is no undo function for this operation so be careful you 
have a current backup before you use it. 

 

CRM will change the internal fields that display who last 
modified the record and the date of the last modification during 
a global replace. If you do not want CRM to updates those fields 
check the 'Do not update "last modified" fields' check box. 
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Value Replace 
THERE IS NO UNDO OPTION FOR GLOBAL REPLACE. 

MAKE SURE YOU HAVE A VALID BACKUP BEFORE YOU USE THIS 
FUNCTION. 

Update a field with a literal value: 
1. Query your table to find the records you want to update. 
2. From the Lookup menu select Global Replace. 

 
3. From the drop down list select the field you want to 

replace. 
4. Click the radio button in the replace with section in front of 

[Value]. 
5. Type in the value you want to update the records with. You 

can leave the value blank if you want to clear the field. 
6. Click {OK}. 

All the available records will be updated with the new value, 
there is no undo function for this operation so be careful you 
have a current backup before you use it. 
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CRM will change the internal fields that display who last 
modified the record and the date of the last modification during 
a global replace. If you do not want CRM to updates those fields 
check the 'Do not update "last modified" fields' check box. 

 

 

 

Attach Multiple Contacts to a Single Address/Company 
 

THERE IS NO UNDO OPTION FOR GLOBAL REPLACE. 

MAKE SURE YOU HAVE A VALID BACKUP BEFORE YOU USE THIS 
FUNCTION. 

To attach a group of contacts to a new address or company 
record: 

1. Query your table to find the records you want to update. 
2. From the Lookup menu select Global Replace. 
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3. Set the [Field] to replace too With (#1) (with is a special 

field that links a contact to a company). 
4. Click the radio button in front of [Value] (#2), and then 

Click the button to the left of the text box. (#3) 
5. Type in the search criteria then Click the [Search] button. 

If there is more than one match select it and Click {OK}. If 
there is only one match the window will automatically close. 

 
6. Check the [Global Replace] dialog window to confirm you 

have selected the correct address/company to attach the 
queried contacts too and then Click {OK}. 

All the available records will be updated with the new value, 
there is no undo function for this operation so be careful you 
have a current backup before you use it. 

CRM will change the internal fields that display who last 
modified the record and the date of the last modification 
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during a global replace. If you do not want CRM to updates 
those fields check the 'Do not update "last modified" fields' 
check box. 

 
Advanced Replace 
 

THERE IS NO UNDO OPTION FOR GLOBAL REPLACE. 

MAKE SURE YOU HAVE A VALID BACKUP BEFORE YOU TRY 
THESE. 

 

1. Query your table to find the records you want to update. 
2. From the Lookup menu select Global Replace. 
3. From the drop down list select the field you want to 

replace. 
4. Click the radio button in the Replace With section in front 

of Expression. 
5. Click the button to the left of the expression field to create 

your expression. 
6. For examples of using the Expression Editor see the CRM 

Help File. 
7. Click {OK} to begin updating the records 
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Calculator 
You can access CRM's calculator in two ways, you can Click on 
the Calculator icon or press [ALT][T] for the Tool menu and then 
press [L] for the Calculator option. The Calculator allows you to 
calculate a loan amortization schedule; investment analysis of 
NPV and IRR; Lease vs. Buy comparison and a Proforma Income 
Analysis. A regular calculator is also offered. 

Amortize 
The amortization calculator will break out the total cost of a 
loan. 

 
 
Parameters 
Loan amount: Total borrowed. 
 
Annual rate: Interest rate of the loan. 
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# Periods: Number of years you have to pay back the loan. 
 
# Payments: Number of payments you make each year. 
 
Term: Length of loan you want calculated. CRM will use the 

number of periods and payments to make the calculations 
but will only show the results for the term specified. 

 
Origination: The date your loan started (can be in the past). 
 
Payment due: Is your payment due at the beginning or end of 

each period. 
 
Start at: The loan will be calculated from its origination date but 

the number you enter here will be the first payment you 
see in the table. 

 
Display by: Period or payment. If you choose period CRM will 

show the total payments by the period you selected. If you 
chose payment CRM will show a row for every payment 
made. 

 
Annual totals: Selecting a month here will break out your totals 

in the grid. 
 
Calculated Fields 
 
Scheduled Payment: This is the total amount paid each period. 
 
Number of payments: Total number of payments made over 

the life of the loan. 
 
Total interest: Total amount paid in fees over the life of the loan. 
 
Total principal: Total amount of principal that will be paid over 

the life of the loan. 
 
Total paid: Interest plus principal paid back or the total cost of 

the loan. 
 
Excel 
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You can send the amortization schedule to Excel by clicking the 
Excel button at the top of the calculator. 

 
Grid 
The grid is broken up in to multiple columns. 
 
Pmt #: The number of the payments in the schedule. 
 
Payment Date: Date the payment is due. 
 
Beginning Balance: Balance of the loan at the start of this 

period. 
 
Scheduled Payment: Total payment amount for that period. 
 
Principal: Amount of principal that applies to your loan for that 

payment period. 
 
Total Principal: Cumulative total of principal paid so far. 
 
Interest: Amount of interest that applies to your loan for that 

payment period. 
 
Total Interest: Cumulative total of interest you have paid to that 

point. 
 
Balance: Remaining loan balance at the end of the period. 
 

Net Present Value 
Net Present Value (NPV) is a formula used to determine the 
present value of an investment by the discounted sum of all 
cash flows received from the project. When a company or 
investor takes on a project or investment, it is important to 
calculate an estimate of how profitable the project or 
investment will be. 
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Parameters: 
Annual discount rate: This is the percentage used to calculate 
the net present value. Enter the value as a whole number; CRM 
will convert it to a percentage. 

Initial investment: Initial cost, entered as a positive number. 

Cash Flows: Enter a number for each cash flow received. Divide 
the numbers up into equal lengths. So for example if you 
receive a payment every month for two years there should be 
24 cash flow numbers in the list. If you received 5 annual 
payments there would be 5 numbers in the list. 

Multiple Cash Flows: You can use the 'X' feature to quickly add 
multiple cash flows at once. For example if you had 5 payments 
in a row of $5,000 you would put 5k in the field in front of the X. 
Then in the next field after the X put in 5 and press the Add 
button. This will add 5 cash flows in all reflecting $5,000. 
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Deleting a Cash Flow: Highlight the cash flow you want to 
delete by clicking it, then click the Delete cash flow button. 

Calculating the NPV: Click the Calculate button to see the NPV 
and IRR.  

Returns the net present value of an investment based on a 
series of periodic cash flows (payments and receipts) and a 
discount rate. The net present value of an investment is the 
current value of a future series of payments and receipts. The 
net present value calculation is based on future cash flows.  

For example, you purchase a building for $1,000,000 (Initial 
investment). Your cash flows for the first four years are; 
$300,000, $310,000, $320,000 and $330,000. With no discount 
rate the Net Present Value is $260,000 with an internal rate of 
return of 9.76%. The formula is the total cash flows minus your 
initial investment which nets $260,000. Adding a discount rate 
compares the investment against a guaranteed rate. If the NPV 
is positive that means you’ll make more money on the 
investment than you would at the discount rate. 

 The IRR is the interest rate at which the net present value of 
the cash flows equals 0. IRR returns the internal rate of return 
for a series of periodic cash flows (payments and receipts). The 
internal rate of return is the interest rate received for an 
investment consisting of payments and receipts that occur at 
regular intervals. 

Present Value Calculator 
The present value calculation is a time value of money 
calculation that takes into account what many economists call 
the "Time Preference". Time Preference is simply that 
everything else being equal, a rational individual would rather 
have X amount of money today rather than X amount of money 
at some point in the future. Inflation and its effect on 
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decreasing the purchasing power of money over time are key 
considerations underlying any present value calculation. 

 
Start date: Required: Specifies the date you started making 
payments. 

End date: Required: Specifies the maturity date. 

Compounding period: Required: Specifies how often you'll be 
making the payment. This is used to calculate the interest rate 
for each payment. 

Annual interest rate: Required: Specifies the interest rate as an 
annual amount. For example if you had an interest rate of 1% / 
month the annual rate would be 12 percent. 

Payment: Required: Specifies the payment to be made each 
period. Payments usually contain principal and interest that 
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does not change during the life of the annuity. Payments are 
entered as negative amounts. 

Future value: Optional: Specifies the future value or cash 
balance you want after you make the final payment. For 
example, the future value of a loan is $0 because that is its 
value after the final payment. However, if you want to save 
$50,000 over 18 years for your child's education, then $50,000 
is the future value. 

Payment due: Required: Specifies when payments are due at 
the end of each period or at the beginning. 

Future Value Calculator 
Future Value determines the value of an asset or cash at a 
specified date in the future that is equivalent in value to a 
specified sum today. This can also include contributions made 
over the period. 

 

Examples: 
Calculate the value of $100 over a two year period with an 
annual interest rate of 7% compounding monthly. 
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Start date: 1/1/2014 

End date: 1/1/2015 

Compounding Period: Monthly 

Annual interest rate: 7 

Payment: 0 

Present value: 100 

Future value: 107.23 

Now let's say that we started the account as above with 
$100.00 but we also added $10 each month. How much would 
that be worth at the end of a year? 

For this example we'll assume we are starting with $100 balance 
and making a $10.00 payment at the beginning of each month. 

So you would change the Payment field to $10.00 and change 
the Payment due to Beginning. 

At the end of the year you would have $231.88 in the account. 
$220 of that was money you added ($110 initial investment and 
another 11 months of $10.00). So the net result was an increase 
of $11.88 over the year. 

Lease Analysis Calculator 
The lease analysis calculator is broken down into two sections. 

Page 431 



Other Features 

 

Parameters 
The Parameter section lets you enter global values to help you 

quickly create your initial grid.  
 
Term (yrs) [mandatory]: Enter the length of the analysis in years 

in this field. 
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Size (sqft) [optional]: The total size of the property or space use 
for calculations. This value is used to calculate the 
Expenses/SqFt, Tenant TIA/SqFt, Landlord TIA/SqFt, 
Building Expense/SqFt and CAP Value/SqFt row,  

 
Ann Exp Stop (optional): If the tenant pays for expenses up to a 

certain dollar amount enter the stop amount in this field. 
Once the reimbursement amount reaches the stop, CRM 
will not let the expense reimbursement amount go above 
that amount. 

 
Tenant [optional]: Name of the tenant 
 
Location [optional]: Location of the property or space 
 

Grid 
Gray cells: Cells shown in gray are calculated cells and cannot 

be changed. 
 
Yellow cells: Cells shown in yellow are auto increase cells. 

These are based on another number in the grid. See the 
documentation below on which cells each calculation 
depends. 

 
Scheduled rent, tenant expenses, building expenses: 

Increase column (yellow). The increase column has 3 
options. 

 
 Off, nothing for this row will be calculated. You must enter 

everything manually. 
 
 %, each year will be increased by the percent you enter 

from the previous year. You MUST enter the first year 
amount for this to work. 

 
 $, each year will be increased by a specific dollar amount 

from the previous year. You MUST enter the first year 
amount for this to work. 

 
Tenant leasing commissions, leasing commissions: You can 

enter a percentage in the 2nd column (yellow) and CRM 
will calculate the commission based on that percentage 
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times the total rent or leave the 2nd column set to Off and 
you can enter the commissions manually for any year. 

 
Value at CAP of: Enter the CAP rate in the 2nd column (yellow) 

and CRM will calculate the value at that cap for each year. 
 
 Tenant Panel 
 
Rent/SqFt: Calculated using (scheduled rent / size). Size is in 

the parameters panel. 
 
Monthly rent: Calculated using (scheduled rent / 12). 
 
Scheduled rent: You must manually enter the first year rent. 

The following years can be entered manually or calculated 
from the increase column following the rules above. 

 
Free months: You can enter the number of free rent months and 

CRM will calculate the free rent total automatically for any 
year in the analysis. 

 
Free rent: You can enter the total free rent for any year and 

CRM will calculate the number of months. 
 
Total rent: Total rent is calculated using (scheduled rent - free 

rent). 
 
Expense/SqFt: Calculated using (total expenses / size). Size is 

in the parameters panel. 
 
Tenant expenses: You must manually enter the first year 

expenses. The following years can be entered manually or 
calculated from the increase column following the rules 
above. 

 
Rent w expenses: Calculated using (total rent + tenant 

expenses) 
 
Tenant Effective: Calculated using (rent w expenses / size). 
 
Tenant TIA/SqFt: Calculated using (tenant tia / size). 
 

Page 434 



Chapter Nineteen 

Tenant TIA: Enter the tenant improvement allowance paid by 
the tenant for each year. 

 
Tenant moving expenses: Enter the total moving expenses 

paid by the tenant for each year. 
 
Landlord TIA/SqFt: Calculated using (landlord tia / size) 
 
Landlord TIA: Enter the tenant improvement allowance paid by 

the landlord for each year. 
 
Landlord moving allowance: Enter the total moving expenses 

paid by the landlord for each year. 
 
Tenant leasing commissions: Total amount of leasing 

commissions paid by tenant. This row follows the rules 
above for entering amounts using the increase column. 

 
Net total: Calculated using (rent + tenant expenses + tenant tia 

+ tenant moving - landlord tia - landlord moving + tenant 
commissions) 

 
Net effective rent: Calculated using (net total / size). The 

calculation adds the previous years and divides by the total 
number of years as well as size for years 2 through infinity. 

 
Owner Panel 
Annual rent: Total rent from tenant panel. 
 
Building expenses/SqFt: Calculated using (building expenses / 

size). Size is in the parameters panel. 
 
Building expenses: You must manually enter the first year 

expenses. The following years can be entered manually or 
calculated from the increase column following the rules 
above. 

 
Expenses reimbursed: Tenant expenses from the tenant panel. 
 
Expenses after recap: Calculated using (building expenses - 

expenses reimbursed). 
 
TIA's: Landlord TIA from tenant panel. 
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Moving allowance: Landlord moving allowance from tenant 

panel. 
 
Leasing commissions: Total amount of leasing commissions 

paid by landlord. This row follows the rules above for 
entering amounts using the increase column 

 
Net rent: Calculated using (annual rent - expenses after 

recapture - landlord TIA's - landlord moving allowance - 
landlord leasing commissions) 

 
Net effective rent: Calculated using (net rent / size). The 

calculation adds the previous years and divides by the total 
number of years as well as size for years 2 through infinity. 

 
Sale Value of Lease Panel 
Base rent: Total rent from tenant panel 
 
Reimbursements: Tenant expenses from tenant panel 
 
Gross scheduled income: Calculated using (base rent + 

reimbursements). 
 
Expenses: Building expenses from landlord panel. 
 
Net operating income: Calculated using (gross scheduled 

income - expenses). 
 
Value at CAP of: Calculated using (net operating income / cap 

percentage) 
 
CAP Value/SqFt: Calculated using (value at cap / size) 
 
Excel 
Clicking the Excel button will send your Lease Analysis to Excel. 
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Proforma Income Analysis 
 

  

Calculate the financial details of a potential transaction to figure 
out the best outcome and investment potential of a property. 
Fields with a white background allow you to enter information, 
such as the Purchase Price, Down Payment, and Base Rent. You 
are able to set these values by typing directly in the cells or you 
can let CRM calculate the values for you, based on parameters 
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you enter. Fields with a grey background are calculated fields 
and will only be filled in after the corresponding values are 
entered, such as entering the Purchase Price, Down Payment, 
and Developer Costs to calculate the Total Equity Invested field. 

  

Basics 
Cells in white are cells you can enter information into. 

Cells in gray are calculated cells depending on the setting in the 
green columns. 

Cell in yellow and blue are locked and always calculated for you. 

 

Depending on the row, you will see a green cell in the second 
column (Variable). In most cases that cell will begin with the 
word "Off". 

When the variable is "Off" you are telling the calculator that you 
want to enter the values for each year manually. 

If you change the cell to an amount or a percent you are telling 
the calculator that you will enter the first year amount and you 
want CRM to calculate all the other years for you. 

 

Depending on the row there are up to three different variable 
types you can use in this column. 

Off: Off means don't calculate any of the columns in this row, 
you will enter everything manually. 

% (Percentages): Percent means take the number you enter in 
the first year (column 3) and increase it by that percent each 
year. You can choose a percent from the drop-down list or you 
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can enter your own percent. The format if you enter your own 
percent is #.##%. For example 3%, 4.52%, 25%. 

$ (Dollar amounts) 

Dollar amounts are fixed increases based on the amount you 
enter in the first year (column 3). Each year after the first year 
will be increased by the exact dollar amount entered in column 
two (Variable column). The format for dollar amounts is $#. For 
example $1,000, $4500, $100,000. 

Creating a proforma 
 

#1. Enter the number of years to calculate (mandatory) 

#2. Enter the starting year for the proforma (optional) 

#3. Enter the name of the property you are charting (optional) 

#4. Enter the location of the property (optional) 

Purchase price: Enter the purchase price for the property in 
column three 

Down payment: Change the green Off to a percent by typing in 
25% or 50% for example, or enter an amount in the third 
column such as 500000. 

Loan amount: The loan amount is automatically calculated by 
subtracting the down payment amount from the purchase price. 

+Loan Costs: You can calculate the loan cost by picking a value 
from the dropdown list in column two, entering a percent 
manually in column 2 (green column) or by leaving column two 
set to Off and entering a value in column three. If you choose to 
enter a percent in column two CRM will calculate the loan costs 
by multiplying the amount of the loan * the percentage. 

+Acq Costs 
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You can calculate the acquisition costs by entering a percent in 
the 2nd column (green column) or leave the 2nd column set to 
Off and entering an amount in the 3rd column. If you use a 
percentage CRM will multiple the purchase price * the 
percentage you enter. 

Initial Investment: Initial investment is a calculated number. 
The calculation is (Down Payment + Loan Costs + Acq Costs). 
This number is used to calculate the Adj Cash/Cash Before Tax 
value in the proforma. 

The grid 
Description column: (1st column) gives an explanation of what 

each row tracks in the proforma. The first row of the grid 
displays the year. The starting year is based on the value 
you enter at the top of the calculator (First Year) and the 
last year is based on the number of years you entered at 
the top of the calculator (Years). 

 
First year numbers are a must: You must enter a number for 

the first year in most of the rows in the grid, the 2nd 
column (green column) will generate values based on the 
first year. For example if you changed the green column 
for Expenses to 35% and there was no value for the first 
year nothing would happen. As soon as you enter a value 
for the expenses in the first year each of the following 
years will increase by 35%. 

 
A few exceptions to the first year rule:  
 
 Vacancy variable (green column) is always a percentage 

or Off. If it's Off you can manually enter the amount for 
vacancy. 

 
  Loan Amount (years). Number of years to repay the loan 

ie: 10, 15, 20, 30 
 
 Less: Debt Service (rate). Interest rate for the loan i.e.: 

6.52%, 7% 

Page 440 



Chapter Nineteen 

Excel Button 
You can send your proforma to Excel so you can deliver it to 
your clients. CRM will create formulas in Excel so your clients 
can make assumptions and see the results. If you have checked 
the auto calculate checkboxes CRM will also include those 
parameters in the spreadsheet and create formulas to use the 
values when they are changed in Excel.  

Phone Dialer 
 
Dialer Setup 
Before you can use the Auto Dialer in CRM you have to set it up. 

The dialer is TAPI compliant and uses your dialer setting from 
windows. If your phone system is TAPI compliant and you have the 
driver installed on your machine you can select that from the CRM 
set-up window. 

To make settings in the actual dialing properties use the windows 
control panel and select the Modem Properties dialog. From that 
dialog set the Dialing Properties for each of the modems you have 
installed and want to use. 

 

Setting up your Dialer in CRM 
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1. Click the Tools menu and then choose Options. 
2. Click the Phone/Fax Tab. 
3. Next to the Phone device prompt Click the down 

arrow and choose your modem. 
4. Click OK. 

Phone Dialer 

 

The phone dialer will automatically dial the phone number clicked. 
This window also allows you to time the call and record a history 
record. 

To dial a phone number Click the phone icon to the left of the 
number. 
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The Phone Dialer Window 
Creating a History of the Call 
Click the Finish button to create a history of your phone call. On 
some modems clicking the finish button will also hang up your 
phone. In those systems you must leave the window open until the 
call is done. 

Ending a Call 
If you do not want to record a history Click the Close button. 
Clicking this button will also hang up some modems ending your 
call.  

Busy Signals or Redials 
If you get a busy signal or want to re-dial, Click the Hang Up button. 
This will hang up the dialer so you can re-dial. 

For a complete list of fields in the Phone Dialer window see the 
section in this help file on the Call Timer. 

Constant Contact Integration 
Constant Contact is an add-on service you can subscribe to that will 
market properties, newsletters and information to your clients. The 
system also tracks the results of your marketing campaign letting 
you know who received your email, who opened it and who 
deleted it. 

The interface between CRM and Constant Contact allows you to 
query your records in CRM and then upload those records to 
Constant Contact to create a list of clients to market too.  

Setup 
First open one of your contact tables and query it for the records 
you want to upload. As a test it is a good idea to query for just 
yourself in CRM and use that as a test case. 
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Next click the Write Menu in CRM and click “Export to Constant 
Contact”. 

 

Enter your Constant Contact User name and password in the boxes 
and check the “Remember my user name and password” if you 
don’t want to see that dialog again. 

If you don’t have a Constant Contact account click the “Sign up 
now” link to create an account. 

Click Next 
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Uploading to Constant Contact 
Constant Contact allows you to have multiple lists of contacts. The 
first step in uploading contacts is to query your CRM database. You 
can use a query in CRM or a query. 

Once you have queried for the contacts you want to upload, click 
the Write menu and click “Export to Constant Contact”. 

If you are asked to sign in, do that as outlined in the setup section 
above then click Next. 

 

CRM will display all the contact lists you have defined in Constant 
Contact on the next screen. You can select an existing group from 
Constant Contact, create a new list, or just upload these contacts to 
your general database. 

If you select an existing list the contacts you have queried in CRM 
will be added to any contacts that are already in the list you chose. 
If you want to limit the campaign to just the contacts in your 
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current query chose “Create a new list” and enter a unique name 
for the list. 

Click Next 

CRM will upload the contacts and take you to the Constant Contact 
page where you can finish sending your campaign. 

Field Properties 
To access the properties for a field, Right-Click on a field and 
select properties. This will bring up the field properties dialog 
box. Field properties are used to change how a field is used or 
to change the caption (the name of the field that you view) of 
the field. 

Field 
This is the True Field name, this is the name of the Field in the 
Table. You will see that the Field name is 
'contact_info.business', this information cannot be changed. 
Remember the Caption\Title is not the same as the Field name, 
the Caption is only what you see in CRM's interface.  

Data Type 
This section tells you what sort of Data the field holds and what 
the character limit for the field is. This information cannot be 
changed. 

Caption 
This section displays the current Title or Caption of the Field 
name; this is the name which you see under normal view of a 
record. To change the name which shows under the view, 
simply type in your desired Title\Caption. Upon clicking OK your 
changes will go into effect immediately. 

*Please remember that this does not change the field name 
itself. Any changes made should be kept noted in case of Future 
Querys. 
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Color 
This section allows you to change the default color of the Fields 
Title area. This can be used for organization, ease of finding, or 
level of importance. To change the color of a Captions Title Area 
simply put a `check` in the Color Sections check box then choose 
your desired color from the Drop-Down Menu. Upon clicking OK 
your changes will go into effect immediately. 

Tab Stop 
Checking this box will cause CRM to stop on this field when the 
user presses the tab key. The field will follow in the tab stop 
order of the fields on the dialog box. 

Value Required 
Checking this box will require that the field be filled in before 
anyone can add a record. If the user does not fill in the required 
field and they attempt to save the record, a window will pop up 
telling them that the field requires a value and they can choose 
to save the record, delete the changes, or continue editing the 
record. 

Comma-Separated Values 
This pertains to the pop-up tables in CRM. Pop-up tables make 
data entry in a field consistent and can also make entering data 
much easier. If you would like to enter more than one value in a 
pop-up table you should check this box. For example in the field 
that tracks types of properties an investor buys you may want 
to put multiple types. Checking this box would allow you to do 
that. The changes will go into effect immediately. 

Must use Pop-up Table 
Checking this box will block the user from entering information 
by hand. The Pop-up tables are the only way to enter 
information into a field with this checked. This is especially 
useful in network environments where multiple users are 
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entering data into fields that require consistent entries for 
querying. 

Use Same Pop-up Table as 
This allows you to share pop-up tables between multiple fields. 
For example if you have a field in the property table that 
specifies the area the property is in and you have a field in the 
investor table that specifies areas that investor purchased in, 
you might want to use the same values between the two tables. 
You can check this box and share the field from the other table 
so they are the same. Couple this with the "Must use pop-up 
table" check box and you force yourself or other users to make 
the correct entry for searches later on. The changes made will 
go into effect immediately. 

 *Remember when you share a Pop-up Table from another field 
any changes made in that Pop-up will also affect the Pop-up in 
its original field. 

Edit Mask 
This section allows you to customize the format in which 
information is stored in the Field. Please see Edit Mask for more 
information regarding the customization. The changes made will 
go into effect immediately and will affect the views of all data in 
this Field Globally.  

Field Masks 
Field masks are used to change the format of the text within a 
given field. These allow you to automatically enter symbols such 
as $ for monetary values. Masks are currently only supported in 
numeric fields. 

Numeric Formats 
#,##0 Displays a number with digit grouping and no 

decimal point. 

#,##0.00 Displays a number with digit grouping and two 
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digits after the decimal point. 

'$'#,##0 Displays as #,##0 but with a leading dollar sign. 

#,##0;(#,##0) Displays as #,##0 except negative numbers are 
displayed with parentheses instead of a sign. 

#,##0;;'' Displays as #,##0 except a blank is shown for 
zero.  

Special Keys 
CRM has special keys you can use to help speed the entry of 
data into your system. Although the mouse has become a very 
popular means of accessing lists, it is a much slower way of 
communicating with your computer. While memorizing the 
special keys to access functions does require some time and 
effort up front, it will save you many hours in the long run.  The 
list below is a complete list of all the accelerator keys in CRM 
starting with the most common and most available, down to the 
least used. 

Hot Keys (Shortcut Keys): 
File: 
 Print {Ctrl+P} 
 Print Preview {Ctrl+Alt+P} 
 
Edit: 
 Cut {Ctrl+X} 
 Copy {Ctrl+C} 
 Paste {Ctrl+V} 
 
Record: 
 First {Alt+Home} 
 Previous {Alt+PgUp} 
 Next {Alt+PgDn} 
 Last {Alt+End} 
 Edit {Ctrl+E} 
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 New {Ctrl+N} 
 Delete {Ctrl+D} 
 Save {Ctrl+S} 
 Cancel {Ctrl+Z} 
 Tag {Alt+Shift+G} 
 Copy Details {Ctrl+B} 
 Edit Details {Ctrl+Alt+E} 
 Edit Notes {Ctrl+M} 
 Link {Ctrl+K} 
 Attach {Ctrl+Alt+T} 
 
New: 
 Contact {Shift+F1} 
 Company {Shift+F2} 
 Property {Shift+F3} 
 Sale Comp {Shift+F4} 
 Space {Shift+F5} 
 Lease Comp {Shift+F6} 
 Project {Shift+F7} 
 Save {Ctrl+S} 
  
Lookup: 
 Sort  {Ctrl+O} 
 Query {Ctrl+Q} 
 Edit Query {Ctrl+Alt+Q} 
 Load Query {Ctrl+Shift+Q} 
 All Records {Ctrl+R} 
 Find {Ctrl+Shift+F} 
 Last Name {Ctrl+L} 
 First Name {Ctrl+F} 
 Company {Ctrl+Y} 
 Work Phone {Ctrl+T} 
 
View: 
Contacts 
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 All {Ctrl+Shift+C} 
 Investors {Ctrl+Shift+I} 
 Tenants {Ctrl+Shift+T} 
 Agents {Ctrl+Shift+A} 
 Vendors {Ctrl+Shift+V} 
 Personal {Ctrl+Shift+E} 
 Prospects {Ctrl+Shift+R} 
 Companies {Ctrl+Shift+Y} 
Properties 
 Properties {Ctrl+Shift+P} 
 Sale Comps {Ctrl+Shift+K} 
 Spaces {Ctrl+Shift+S} 
 Lease Comps {Ctrl+Shift+L} 
Projects {Ctrl+F2} 
Calendar {F6} 
Dashboard {F2} 
Timelines {F7} 
Contact List {F5} 
 
View from Calendar Window: 
Today {Ctrl+T} 
Daily Calendar {Ctrl+Y} 
Weekly Calendar {Ctrl+W} 
Monthly Calendar {Ctrl+M} 
 
Schedule: 
Phone Call {Ctrl+F5} 
Meeting {Ctrl+F7} 
Follow-Up {Ctrl+F8} 
To-Do {Ctrl+F9} 
Annual {Ctrl+F11} 
Timeline {Ctrl+Shift+F9} 
Add History {Ctrl+H} 
 
Write: 
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Mail Merge {F3} 
Quick Letter {Ctrl+U} 
 
Tools: 
Search 
 Contact {F12} 
 Company {Alt+F12} 
 Property  {Shift+F12} 
 Sale Comp {Ctrl+Alt+F12} 
 Space  {Alt+Shift+F12} 
 Lease Comp {Ctrl+Shift+F12} 
 Project {Alt+F2} 
Call Timer {Shift+F8} 
 
Help {F1} 
 

Field Keys 
These keys are specific to fields in the CRM tables and are 
available in every table for the specific field type listed. 

Numeric Fields 
CRM allows you to enter numbers and will automatically mask 
them for you. Because of this you never enter currency signs or 
thousands separators. To make entering large numbers easier 
you can just follow the number with the first letter of the 
amount. For example, if you wanted to enter one million in a 
field you could just put 1M (capitalization makes no difference). 
If you wanted one million, five thousand you could just put 
1M5T. 

Date Fields 
There are a few special keys for date fields you can use to help 
quickly enter data.  
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Key Result 

+ Increments current date in field by one day 

- Decrements current date in field by one day 

T Today 

W Beginning of Week for date currently entered in field 

K End of weeK for date currently entered in field 

M Beginning of Month for data currently entered in field 

H End of montH for date currently entered in field 

Y Beginning of Year for date currently entered in field 

R End of yeaR for date currently entered in field 

 

An easy way to remember the date keys is to use the word that 
describes what you want. The first letter of the word takes you 
to the beginning and the last letter of the word takes you to the 
end. For example, last day of the current month would be “H” 
because month ends with “h”. First day of week would be “W” 
because week starts with “w”. 
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